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Preface

Welcome to the Oracle Depot Repair User Guide, Release 11i.

This guide assumes you have a working knowledge of the following:

� The principles and customary practices of your business area.

� Oracle Depot Repair

If you have never used Oracle Depot Repair, Oracle suggests you attend one or 
more of the Oracle Depot Repair training classes available through Oracle 
University.

� The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

� Oracle Self-Service Web Applications. 

To learn more about Oracle Self-Service Web Applications, read the Oracle 
Self-Service Web Applications Implementation Manual.

See Other Information Sources for more information about Oracle Applications 
product information.
ix



How To Use This Guide
This document contains the information you need to understand and use Oracle 
Depot Repair.

� Chapter 1, "Introduction to Oracle Depot Repair" provides overviews of the 
application and its components, explanations of key concepts, features, and 
functions.

� Chapter 2, "Overview of Using Oracle Depot Repair" provides instructions on 
how to access the application, and introduces the tabs.

� Chapter 3, "Depot Repair Business Scenarios and Process Flows" provides flow 
based procedures for managing different depot repair business scenarios using 
Oracle Depot Repair.

� Chapter 4, "Managing Depot Repair Processes" provides process-oriented, task 
based procedures for using Oracle Depot Repair to manage repair depot 
business activities.
x



Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor 
makes any representations regarding the accessibility of these Web sites. 
xi



Other Information Sources
You can choose from many sources of information, including documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Depot Repair.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

� PDF Documentation - See the Online Documentation CD for current PDF 
documentation for your product with each release. This Documentation CD is 
also available on OracleMetaLink and is updated frequently.

� Online Help - You can refer to Oracle Applications Help for current HTML 
online help for your product. Oracle provides patchable online help, which you 
can apply to your system for updated implementation and end user 
documentation. No system downtime is required to apply online help.

� Release Content Document - See the Release Content Document for 
descriptions of new features available by release. The Release Content 
Document is available on OracleMetaLink.

� About document - Refer to the About document for information about your 
release, including feature updates, installation information, and new 
documentation or documentation patches that you can download. The About 
document is available on OracleMetaLink.

Related Guides
Oracle Depot Repair shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other guides when you 
set up and use Oracle Depot Repair.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.
xii



Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI). This guide also includes information on setting user 
profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Guides Related to This Product

Oracle Depot Repair Implementation Guide
This implementation guide explains the tasks and considerations required to set up 
Oracle Depot Repair.

Oracle Knowledge Management User Guide
Use this guide to learn more about using the Knowledge Management functionality 
in Oracle Depot Repair.

Oracle Receivables User Guide
Refer to this user guide for detailed instructions on creating customer invoices.

Oracle Common Application Components User Guide 
Oracle Field Service uses many modules from among the Common Application 
Components, including Resource and Task Manager, among others. Refer to this 
guide for details on the usage of each module.

Oracle Advanced Scheduler Concepts and Procedures
When Advanced Scheduler is installed, the usage is tightly integrated with the Field 
Service application. This guide explains the Advanced Scheduler processes and 
how it is integrated with Field Service.
xiii



Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications 
and the Oracle technology stack by automating many of the required steps. This 
guide contains instructions for using Oracle Rapid Install and lists the tasks you 
need to perform to finish your installation. You should use this guide in conjunction 
with individual product user guides and implementation guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

“About” Document
For information about implementation and user documentation, instructions for 
applying patches, new and changed setup steps, and descriptions of software 
updates, refer to the ”About” document for your product. ”About” documents are 
available on OracleMetaLink for most products starting with Release 11.5.8.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.
xiv



Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff and describes the Oracle Application Object Library components 
that are needed to implement the Oracle Applications user interface described in 
the Oracle Applications User Interface Standards for Forms-Based Products. This manual 
also provides information to help you build your custom Oracle Forms Developer 
forms so that the forms integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this guide before implementing Oracle Depot Repair. This 
manual details additional steps and setup considerations for implementing Oracle 
Depot Repair with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle Depot Repair with Oracle 
Applications' Multiple Organization support feature, so you can define and support 
different organization structures when running a single installation of Oracle Depot 
Repair.
xv



Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how 
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Depot Repair implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This guide also provides 
information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetalink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.
xvi



Oracle Applications Message Manual
This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.
xvii



Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle Depot Repair and reach full productivity quickly. These courses are 
organized into functional learning paths, so you take only those courses appropriate 
to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Depot Repair working 
for you. This team includes your technical representative, account manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle server, and your hardware and software 
environment.
xviii



Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
xix



Your Feedback
Thank you for using Oracle Depot Repair and this user guide.

Oracle values your comments and feedback. In this guide is a reader’s comment 
form that you can use to explain what you like or dislike about Oracle Depot Repair 
or this user guide. Mail your comments to the following address or call us directly 
at (650) 506-7000. 

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Or, send electronic mail to appsdoc_us@oracle.com.
xx
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1
Introduction to Oracle Depot Repair

This chapter discusses the key concepts, features, and process flows of Oracle Depot 
Repair. 

Sections in this chapter include:

� Section 1.1, "What is Oracle Depot Repair?" on page 1-1

� Section 1.2, "Oracle Depot Repair Key Features" on page 1-2

� Section 1.3, "Business Process Flows" on page 1-7

� Section 1.4, "Integration with Other Oracle Modules" on page 1-8

1.1 What is Oracle Depot Repair?
Oracle Depot Repair is part of the Oracle E-Business Suite and offers an 
enterprise-wide solution for managing depot repair processing. It targets the repair 
business market from simple, quick repairs to routine maintenance. Oracle Depot 
Repair integrates with other Oracle E-Business Suite modules to provide an 
integrated comprehensive solution for the repair business sector.

The depot repair process includes the return of broken and serviceable items, their 
diagnoses and repair job estimates, customer approvals and repairs management, 
and subsequent return of items to customers. You use the collection of charges for 
materials, labor, and expenses for the repairs to invoice the customer.

The depot repair process also includes the processing of item refurbishments, where 
the items either belong to an internal party, or the items are received from a field 
service warehouse and then returned to the warehouse after repair.

Customers expect quick and seamless repair processing. Oracle Depot Repair 
provides end-to-end repair management functionality for service organizations that 
are committed to delivering a total service solution. 
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Oracle Depot Repair enables service organizations to meet customer expectations, 
and draw maximum benefit by improving service readiness.

1.2 Oracle Depot Repair Key Features
The major features of Oracle Depot Repair include:

� Section 1.2.1, "Customer Management" on page 1-2

� Section 1.2.2, "Service Request Management" on page 1-3

� Section 1.2.3, "Repair Type Processing" on page 1-4

� Section 1.2.4, "Repair Job Management" on page 1-6

� Section 1.2.5, "Repair Resolution Management" on page 1-6

1.2.1 Customer Management
Oracle Depot Repair can use a call center environment to improve customer 
interaction with service depots. Customers can use an access number to contact the 
relevant service depot where they can log Service Requests. The primary focus of 
the service representatives in the call center is to understand the customer’s issue 
and resolve it on the first call, if possible, thereby avoiding escalations or call 
transfers. This lets service agency experts focus on their areas of expertise without 
the constant distraction of explaining well-documented issues and solutions.

Oracle Depot Repair also supports scenarios in which customers walk in at service 
depots for repair needs. 

Oracle Depot Repair provides service organizations with the right tools and 
knowledge for responding effectively to the repair issues that customers have.

Key customer management features include:

Oracle Depot Repair Workbench
The Repair Orders window in Oracle Depot Repair provides the service agent 
instant access to information about the customer and enables the agent to effectively 
address the needs of the customer. The customer Profile menu option enables 
service agents to view the number of open Repair Orders, open Service Requests, 
active contracts, and other details for a selected customer. In the Find Repair Orders 
window, service agents can query for Repair Orders, to see the Repair Order 
statuses, repair jobs, and repair tasks. 
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Relationship Management
Oracle Depot Repair lets service agents capture the contact’s relationship with 
others in the concerned organization, or other organizations, enabling service 
agents to engage knowledgeably with customers and other service agencies.

Customer Data Store
Oracle Depot Repair enables service agencies to maintain a comprehensive database 
of all customer interactions with the agency. Oracle Depot Repair maintains detailed 
service history to trace the origin of a repair issue and the follow up actions that 
solved it.

1.2.2 Service Request Management
Oracle Depot Repair enables service agencies to offer customers the convenience of 
accessing service through telephone or over the counter. Key Service Request 
management processes include:

� Entering Service Requests

� Searching the Oracle Knowledge Management Database

Service Request Builder
Oracle Depot Repair lets you enter new Service Requests to gather appropriate data. 
It lets service agents record customer information and attempt problem resolution 
to solve issues in the very first interaction.

Searchable Oracle Knowledge Management Database
Oracle Depot Repair makes available a database of solutions, which the service 
agents can search with a view to solving the problem while the customer interaction 
is in progress. The Oracle Knowledge Management database can also provide 
information, such as guides, policies, procedures, and FAQs. 

Where the problem affecting the current Repair Order item is matched up with the 
solution in the Oracle Knowledge Management database of a similar problem, 
Oracle Knowledge Management can assist in the Repair Order processing, by 
providing charge lines for WIP and Task estimates, and Bills and Routings for WIP 
Repair Jobs.
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1.2.3 Repair Type Processing
Oracle Depot Repair provides Repair Types that enable service providers to be more 
efficient in managing the repair through process automation. Repair Types help to 
classify the Repair Order and determine the repair management processes and 
logistics to fulfill the repair process. 

Oracle Depot Repair supports the following Repair Types:

� Repair and Return

� Loaner, Repair and Return

� Exchange

� Advance Exchange

� Loaner

� Replacement

� Standard

� Refurbishment

Repair and Return
Use this Repair Type when a customer returns the broken or damaged item to the 
service depot for repair. After completion of the repair, you return the repaired item 
to the customer. This Repair Type requires:

� A return materials authorization (RMA), or Return line, to receive the 
customer's broken or damaged item.

� A Sales Order, or Ship line, to ship the repaired item and invoice the customer.

Loaner, Repair and Return 
This Repair Type combines two Repair Types, the Repair and Return, with the 
Loaner. The loaner concept indicates that service depot sends the customer the 
loaner before the receipt of the customer’s broken or damaged item. To track the 
shipping and return of both the loaner and the broken or damaged item, the system 
creates four charge lines. This Repair Type requires two RMA Orders and two Sales 
Orders. Use this Repair Type when a customer uptime is critical.

Exchange
This Repair Type represents a scenario when the service depot sends an exchange 
item to the customer after receiving the customer's broken or damaged item. The 
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Exchange Repair Type assumes that the repaired item does not return to the 
customer. The system can generate an internal Repair Order for the returned item, 
but there is not necessarily an association between the repaired item and the 
original exchange item.

Advance Exchange
This Repair Type is the same as the Exchange Repair Type except that the service 
depot can send the item to the customer before the service organization receives the 
customer's broken item.

Loaner
Use this Repair Type when the service depot sends an item to the customer solely 
for the purpose of renting. This Repair Type requires a Sales Order to ship the 
loaner item to the customer and to create an invoice, and an RMA order to track the 
return of the loaner item. A deposit and return due date may be a requirement. The 
customer has no expectation of repairs.

Replacement
A Replacement Repair Type refers to a scenario when the service depot sends an 
item to the customer without expecting a return. In this scenario, the service 
provider sends the customer an item to replace the customer's item. The service 
organization can:

� Link the replacement item to the original item in the Install Base.

� Change the status of the replaced item to indicate that it is out of service and 
that the new item has replaced it.

Standard
Use this Repair Type when the service agent is uncertain about the customer’s 
needs. This Repair Type is flexible however, and requires the manual creation of 
RMAs and Sales Orders.

Refurbishment
A Repair Order and its associated Service Request can be created in the Spares 
Management of Oracle Field Service as a result of a demand for refurbishment or 
replenishment. The Repair Order has a Repair Type of Refurbishment, and has two 
transaction lines, Move In and Move Out.
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The Move In line tracks the shipment of the defective item from Spares 
Management, and its reception into the depot. The Move Out line processes the 
shipment of the repaired item back to Spares Management.

The processing of Move In and Move Out lines leverages existing Internal Order 
and Internal Requisition functionality. From the depot’s perspective, defective items 
are received via the Internal Requisition, and usable/repaired items are shipped via 
the Internal Order.

1.2.4 Repair Job Management
Use either of the following repair modes to manage repair jobs:

� WIP (Work In Process): Recommended for use when the repair jobs require a 
series of sequential steps and materials management. The WIP mode leverages 
the costing of items through Oracle Costing.

� Task: Recommended for use when the repairs require minimal steps that do not 
necessarily require a series of sequential steps. In contrast to WIP mode, Task 
mode does not integrate with Oracle Costing.

You implement and manage either of these repair modes on separate tabs in the 
Oracle Depot Repair area.

During implementation, you associate the WIP or Task mode with Repair Types. 
Though a service organization can have different Repair Types associated with 
different repair modes, it is recommended that a service organization select only 
one repair mode for all Repair Types to enhance usability.

1.2.5 Repair Resolution Management
Oracle Depot Repair improves operational efficiency by providing the following 
key repair resolution management features:

� Repair job search functionality.

� Process automation based on Repair Type, such as automatic creation of charge 
lines.

� Estimate creation and approval.

� Leveraging of the service depot knowledge base throughout repair processing.

� Repair job creation and release to shop floor.

� Flexible options for receiving items and shipping items.
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� Invoicing of final charges.

1.3 Business Process Flows
Oracle Depot Repair supports the following business process flows:

� Section 1.3.1, "Logistics and Maintenance with Call Center Facility" on page 1-7

� Section 1.3.2, "Logistics and Maintenance without Call Center Facility" on 
page 1-7

� Section 1.3.3, "Internal Party Repairs" on page 1-8

You can use either Oracle Work In Process (WIP) or the Task Manager (in Oracle 
Common Application Components) to manage the repair process. Based on your 
choice, the Repair Type for a given Repair Order determines which repair 
management process to use.

1.3.1 Logistics and Maintenance with Call Center Facility
This business flow starts with a Service Request, where the call center service agent 
records a problem. If the service agent cannot resolve the problem using 
information in Oracle Knowledge Management, the service agent refers the Service 
Request to a service depot repair agent. The service depot agent can then create a 
Repair Order and an estimate (if required) and seek approval from the customer for 
further processing.

Depending on the Repair Type, the service depot repair agent completes the 
different RMA and Sales Order lines to assist the completion of the repair process. 
The repair mode (associated to the Repair Type) determines whether to use Oracle 
WIP or the Task Manager in Oracle Common Application Components to manage 
the repair job. After the repair completion, the service depot returns the repaired 
item to the customer. The system captures the material, labor, and expenses that the 
repair needed as charges and transfers that information to Oracle Order 
Management for invoicing.

1.3.2 Logistics and Maintenance without Call Center Facility
This process is similar to the Call Center, Logistics, and Maintenance business 
process except that there is no call center. 

Businesses that do not incorporate a call center facility, or those that integrate their 
call center into the depot, can use this process, but it requires that their customers to 
send serviceable items directly to a service depot.
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1.3.3 Internal Party Repairs
You can refurbish items that your organization already owns or repair an item that 
your organization took possession of through a field service agent instead of against 
an RMA. Oracle Depot Repair lets you process internal repairs in such cases. The 
customer is an internal party in the corresponding Service Request. RMAs and Sales 
Orders are not required to process internal repairs. This is under the assumption 
that items already exist in a subinventory within the organization letting you create 
repair jobs.          

1.4 Integration with Other Oracle Modules
Oracle Depot Repair integrates with the following Oracle modules:

Advanced Scheduler
Oracle Advanced Scheduler enables optimal scheduling of tasks and trips for field 
service business needs. While the Assignment Manager (in Oracle Common 
Application Components) searches for qualified resources to complete a field 
service task (based upon selection criteria set within the Assignment Manager), 
these qualified resources transfer to Oracle Advanced Scheduler to make the actual 
assignments based upon previously defined constraints. Oracle Advanced 
Scheduler uses the Assignment Manager to schedule Field Service tasks.

Assignment Manager
Oracle Depot Repair uses Assignment Manager to schedule technicians to all open 
and planned repair tasks. This module permits the planner to use the Assignment 
Manager in an assisted or unassisted mode. For more information, see the Oracle 
Common Application Components User’s Guide. 

Bills of Material
Oracle Bills of Material store lists of items that are associated with a parent item, 
and information about how each item relates to its parent. Oracle Depot Repair uses 
Oracle Bills of Material to create repair routers that the system uses for a submitted 
WIP repair job, and to create a bill of materials for an item that is linked to a repair 
router.

Contracts (Contracts Core and Service Contracts)
Oracle Depot Repair integrates with Oracle Service Contracts to manage service 
contracts associated with a customer’s Install Base item. Oracle Service Contracts 
holds all service contracts centrally--including warranties, extended warranties or 
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complex service agreements--and provides the service provider visibility to all 
service entitlement information. It leverages functionality that Oracle Contracts 
Core provides to support common contract management activities, such as contract 
renewal, versioning, article management, and change management.

Counters
Counter events and alerts provide a valuable tool to track critical service events that 
can affect a customer or items in the Install Base. Oracle Depot Repair uses the 
Counters module to update item counters periodically, whenever a service depot 
technician performs work on the item, and saves it in the Install Base record. The 
Oracle Counters module also permits a service provider to set up logical or derived 
counters that use formulas that incorporate calendar dates, time, and cycle counts to 
trigger an event, such as a warranty or service contract expiration, or to alert the 
service provider when to schedule preventive maintenance on a customer’s Install 
Base item. The system can send alerts by the e-mail notification system to inform 
service personnel about warranty or service contract expiration, or about a 
preventive maintenance requirement that is due.

Field Service
When an organization sells an item to a customer, service contracts or warranties 
are often offered to the customer. Most companies offer on-site support for failures 
of the item. This is where field service is significant. After the customer reports the 
problem, the field service organization determines:

� Who and when a field service agent should visit the customer.

� What parts are needed to solve the problem. 

If a field service agent cannot completed the repair on-site, the repair may need to 
be transferred to the service depot for completion. Furthermore, internal order 
refurbishments can be initiated in the Spares Management module within Oracle 
Field Service.

General Ledger
Oracle Depot Repair integrates with Oracle General Ledger to provide the 
functionality of recording and tracking all costs associated with every Oracle Depot 
Repair WIP mode repair, and of creating general ledger accounts.

HRMS (Human Resource Management System)
Oracle Depot Repair uses the Oracle HRMS module to define employees and 
locations where you ship, deliver internally, or bill the ordered goods and services.
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Install Base
Oracle Install Base is a repository that tracks all installed customer items. Oracle 
Install Base maintains and updates each item record to reflect the most current 
configuration. Service organizations must rely heavily on their Install Base to 
provide accurate customer and item information. The Install Base permits quick 
access to all item records and information. Oracle Depot Repair leverages this 
information to expedite the repair process when repairs involve incompatibility, 
configuration, revision, or counter history issues. Oracle Depot Repair integrates 
with Oracle Install Base to assist accurate recording of all part and serial numbers 
that change during an item’s life. It retrieves all service contracts and warranties 
associated with an Oracle Install Base serialized item or component. Depending on 
the definition of Oracle Install Base transaction sub-types, the TeleService Charges 
APIs update the location and instance ownership information.

Inventory
Oracle Depot Repair uses the Oracle Inventory module to manage item and spare 
parts inventory.

iSupport
Self-Service Repair Order reporting is now supported in Oracle iSupport. Oracle 
Depot Repair customers can now search for their Repair Orders through an Oracle 
iSupport self-service user interface. Oracle iSupport will properly authenticate the 
user and display only Repair Orders for accounts which the user is authorized to 
view.

Knowledge Management
Oracle Knowledge Management is an Oracle Service Core module that provides an 
open architecture repository to store technical information or solution sets. Service 
agents and technicians can retrieve this information to find a quick resolution to 
service issues that customers are reporting, or provide assistance in an inspection or 
item diagnosis. Oracle Knowledge Management provides a security feature that 
permits only users with specific responsibility to contribute new information to the 
constantly enriched active database.

Oracle Depot Repair uses the Oracle Knowledge Management Search Engine to find 
the best possible solutions to resolve service issues. Agents can access the 
knowledge repository from the Service Request or the Repair Order. You can search 
for solutions by entering a Diagnostic Code or keyword string to query on 
statements that have links to a symptom, cause, action, or fact solution set. A 
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solution set can also include a Task Template or set of objects that can automate or 
expedite the repair process.

Notes
A note records descriptive information, which users have created, about business 
transactions to provide referencing. Oracle Depot Repair uses the Notes module to 
access the comment log that relates to a specific transaction. The Notes module 
creates and passes information to all other Oracle applications. Upon transmission 
and receipt of a note, the system automatically sends an alert to the Oracle Depot 
Repair module to signal that a new note is present. Service employees can pass 
valuable information that can influence the repair process. The Notes module 
permits users to post both public or private notes, where public notes can be 
published to a Web site, and private notes are only accessible to employees that 
work inside the service organization. For more information, see the Oracle Common 
Application Components User’s Guide.

Order Management
Oracle Depot Repair uses the Oracle Order Management module to create RMA 
and Sales Orders, validate customer accounts, and invoice customers for repairs.

Oracle Depot Repair integrates with Oracle Order Management Pricing to provide 
an advanced, highly flexible pricing engine that executes pricing and promotional 
calculations. It allows Oracle Depot Repair users to view and select a Price List 
while charging a repair, and while receiving or shipping an item.

Purchasing
For receiving, Oracle WIP uses Oracle Purchasing to perform outside processing of 
a repair from the WIP Router.

Receivables
The Oracle Receivables module integrates with Oracle Depot Repair integrates to 
track and maintain customer information such as customer name, account, 
customer contacts, and location.

Resource Manager 
Oracle Depot Repair uses Resource Manager to manage employees. The Resource 
Manager permits a user to import employees and non-employees from HRMS into 
the resource module. You can set up and manage resources as individual resources, 
or as a team or group, and assign roles and skill sets to distinguish their 
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qualifications. For more information, see the Oracle Common Application Components 
User’s Guide.

TeleService (Charges)
With the Charges module, a service organization can bill customers for provided 
services in response to support Service Requests, field Service Requests, and service 
depot repairs. Charges also creates a return material authorization (RMA) to return 
a defective item for repair, loan, or replacement. Returns from a customer occur for 
a variety of reasons including damage, shipment error, and repair. With the Charges 
capability of processing return material, you can manage customer expectations 
while controlling inventory receipts and processing customer credit. Oracle Depot 
Repair uses TeleService Charges APIs to automatically create the charge lines when 
the service depot has determined the Repair Type.

TeleService (Customer Care)
The Customer Profile summarizes customer information and indicates if a customer 
is critical. It can provide information such as the number of open Service Requests. 
A system administrator sets up the profile entries, which contain a set of defined 
verifications that you can configure. The Customer Profile engine displays these 
verification results. Oracle Depot Repair uses this functionality for customer 
management.

TeleService (Service Requests)
Service agents typically log a Service Request to record a service issue that a 
customer is reporting. Oracle Depot Repair invokes Oracle TeleService APIs to 
automatically create the Service Request after creation of the Repair Order header. 
The TeleService APIs populate the Service Request number into the Repair Order 
Header to permanently link the two source documents with an internal form 
identity. Service depot business flows always start with the creation of a Service 
Request.

Task Manager
Oracle Depot Repair uses the Task Manager to assist repair management. The Tasks 
model leverages the core functionality that Oracle Depot Repair provides by its 
integration with Resource Manager, Assignment Manager, and Oracle Calendar. 
The Task mode provides an alternate repair process that is intended to manage 
simple repair work that does not require extensive tracking or management 
processes. After task completion, the technician uses the Debrief Report in Oracle 
Depot Repair to log the material, labor, and expense transactions. For more 
information, see the Oracle Common Application Components User’s Guide.
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Work in Process
Oracle Depot Repair uses Oracle Work in Process (WIP) to assist the repair of 
broken or damaged items. Oracle WIP permits assignment of resources, material, 
and outside processing. A WIP summary report tracks the associated costs with a 
completed WIP repair job. You can submit WIP mode repair jobs with or without an 
assigned routing.
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2
Overview of Using Oracle Depot Repair

This chapter provides an overview of the user interface and the major tasks that you 
can perform using Oracle Depot Repair. 

Sections in this chapter include:

� Section 2.1, "Accessing Oracle Depot Repair" on page 2-2

� Section 2.2, "The Depot Repair Workbench" on page 2-3

� Section 2.3, "The Service Request Information Area" on page 2-5

� Section 2.4, "The Repair Order Information Area" on page 2-8

� Section 2.5, "Details Tab" on page 2-9

� Section 2.6, "Logistics Tab" on page 2-11

� Section 2.7, "Diagnostics Tab" on page 2-11

� Section 2.8, "Repair Estimate Tab" on page 2-18

� Section 2.9, "Repair Jobs Tab" on page 2-27

� Section 2.10, "Repair Tasks Tab" on page 2-33

� Section 2.11, "Repair Actuals Tab" on page 2-35

� Section 2.12, "Depot Repair Workbench Tools Menu" on page 2-38

� Section 2.13, "Depot Repair Workbench Data Menu" on page 2-40

� Section 2.14, "Find Repair Orders for Job Submission Window" on page 2-42

� Section 2.15, "Submit Repair Jobs for Repair Orders Window" on page 2-45
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2.1 Accessing Oracle Depot Repair
At the core of Oracle Depot Repair is the Depot Repair Workbench that provides 
service agents with instant access to customer and Repair Order information. You 
can access a number of tabs from the Depot Repair Workbench. Some tabs show 
information about the customer, the Service Request, and the service history of the 
item. Other tabs let you process transactions, such as:

� Receipt or shipment.

� Creation and processing of Repair Jobs and tasks. 

The Depot Repair Workbench also provide access to a knowledge base through 
Oracle Knowledge Management.

The following procedures describe how to access the Depot Repair Workbench.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You need the navigation to Oracle Applications, and a registered and approved 
login to Oracle Depot Repair from your system administrator.

Navigation
Depot Repair > Repair Orders

Steps
1. In the Find Repair Orders window, if you click New, the Repair Orders window 

opens and serves as the Depot Repair Workbench.

2. Alternatively, in the Find Repair Orders window, you can retrieve a specific 
Repair Order by entering search criteria, and clicking the Find button.

Note: You can also open the Depot Repair Workbench from the 
Service Request Quick Menu.
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2.2 The Depot Repair Workbench
The title of the main window in Oracle Depot Repair is Repair Orders. As most of 
the Oracle Depot Repair user operations start in this window, it is generally referred 
to as the Depot Repair Workbench.

In the Depot Repair Workbench you can perform all service depot repair functions, 
including Repair Order creation, status monitoring, receiving, and shipping. From 
the Depot Repair Workbench, you can create Repair Orders to track the activities on 
customer or vendor items returned to service depot repair, for repair, upgrade, or 
overhaul.

The Depot Repair Workbench provides integration with Oracle E-Business 
Application Suite modules and components, such as Notes, Charges, Knowledge 
Management, Install Base, Work in Process (WIP), Bills of Material (BOM), General 
Ledger, Inventory, Shipping, and Receiving.

For more information, see Section 1.4, "Integration with Other Oracle Modules" on 
page 1-8.

Service organizations can start their service depot business process from the Depot 
Repair Workbench. When a service agent enters the customer and item information, 
the Depot Repair Workbench automatically validates the customer and item in the 
Install Base. 

From the Depot Repair Workbench, you can:

� Create new customers.

� Review your customer profiles.

� Automatically create Service Request and charge lines based on the selected 
Repair Type selected.

� Access shipping and receiving areas.

� Access WIP or Tasks for repair management.
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For more information on the Depot Repair Workbench, see:

� Section 2.3, "The Service Request Information Area" on page 5

� Section 2.4, "The Repair Order Information Area" on page 2-8

� Section 2.5, "Details Tab" on page 2-9

� Section 2.6, "Logistics Tab" on page 2-11

� Section 2.7, "Diagnostics Tab" on page 2-11

� Section 2.8, "Repair Estimate Tab" on page 2-18

� Section 2.9, "Repair Jobs Tab" on page 2-27

� Section 2.10, "Repair Tasks Tab" on page 2-33

� Section 2.11, "Repair Actuals Tab" on page 2-35

� Section 2.12, "Depot Repair Workbench Tools Menu" on page 2-38

� Section 2.13, "Depot Repair Workbench Data Menu" on page 40

The following features, that in previous versions were available through tabs in the 
Depot Repair Workbench, are now accessible through menu options:
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� Coverage Window on page 2-39

� Activity Window on page 2-41

� Service History Window on page 2-40

For more details about these features, see Section 2.12, "Depot Repair Workbench 
Tools Menu" on page 2-38 and Section 2.13, "Depot Repair Workbench Data Menu"  
on page 2-40.]

2.3 The Service Request Information Area
You can enter and view customer information in the Service Request Information 
area. The fields in the Service Request Information area include:

� Customer Information Fields on page 2-5

� Contact Information Fields on page 2-6

� Item Information Fields on page 2-6

� Request Information Fields on page 2-7

2.3.1 Customer Information Fields
Fields in the Customer Information area include:

� Customer Type: Caller types.

� Customer: Customer names. The customer can also be the internal party. 
Validation of items occurs against the party ID to assist the repair of internally 
owned items.

� Account: Customer Account Number.

� Phone: Customer’s contact telephone number.

� Bill-To: Bill-to address of customer or a related party.

� Ship-To: Ship-to address of customer or a related party.
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2.3.2 Contact Information Fields
Fields in the Contact Information area include:

� Contact Type: Choose this value from the list of values.

� Contact: Contact’s name (customer account validation is required). Select from 
the contacts that your organization defined during Oracle Depot Repair setup.

� Relationship: Specifies the contact’s relationship with the customer, such as 
Associate of, Child of, and Benefactor of. Select from the Relationship list of 
values.

� Contact ID: Contact’s Identification Number.

� Phone: Contact’s telephone number.

Contact Information Area Buttons
The button in the Contact Information area is:

New Contact: To create a new customer contact, click the New Contact button.

2.3.3 Item Information Fields
Fields in the Item Information area include:

� Installed Items Only check box: Validates the item against the Install Base.

Note: The Bill-To and Ship-To addresses always default to the 
primary bill-to and ship-to addresses of the customer party, even if 
you select a primary address for the Install Base instance.

Also, the list of values for the Bill-to and Ship-to fields contains 
only the bill-to and ship-to addresses of the customer party. The 
Bill-to and Ship-to fields do not contain the addresses of the contact 
even if you have selected one.

Note: This field does not automatically default to a null value. If 
you do not want to enter any contact information, then select the 
blank value from the Contact Type list of values; the remaining 
contact information fields that follow are disabled.
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When the Installed Items Only check box is not set, the list of values for the 
Item field displays both the Install Base trackable items and the non-Install Base 
trackable items.

When the Installed Items Only check box is set, the list of values for the Item 
field displays Install Base trackable items only, that is, those that have an 
Instance value.

� Item: Specifies the Item Number for which there is a Service Request.

� Revision: Displays the item revision, if the item is revision controlled.

� Instance: Shows the Instance value of the item, and applies only to items that 
have an Install Base instance. If you choose to enter the Instance field for an 
item first, the Item field becomes automatically populated when you select the 
Instance value from the list of values.

� Serial Num: For serialized items, displays the Serial Number of the item. 

If you have not already entered or selected the Item, and when both of the 
following conditions occur:

– Installed Items Only is not checked

– You choose to select or manually enter an already-existing Serial Number

then the Item field and the other item-related fields are automatically 
populated.

If you have already entered or selected the item:

� For serialized, Install Base trackable items, you must enter or select a valid 
Serial Number.

� For serialized, non-Install Base trackable items, if you select a Serial 
Number from the list of values, then other item-related fields are 
automatically populated.

� For serialized, non-Install Base trackable items, if you manually enter a 
Serial Number, then, whether or not it already exists, no further 
item-related fields are populated.

� Opened: Displays the date when the request was opened.

� Closed: Displays the date when the request was closed.

2.3.4 Request Information Fields
Fields in the Request Information area include:
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� Request Num: Displays the system-generated Service Request Number.

� Summary: Enter or view a brief description for the request in the Summary 
field. The Summary field is a text string field and is classified as a Note.

� Request Type: Choose from the list of values that your organization defined. 
The default value for this field comes from the profile option Service: Default 
Service Request Type.

� Severity: Choose from the list of values to assign a severity to the request. The 
default value for this field comes from the profile option Service: Default 
Service Request Severity.

� Status: This defaults to Open when you create a Service Request, as specified by 
the default value of the profile option Service: Default Service Request Status.

� Owner: Assign a Service Request owner by selecting from the default the Price 
List from the profile option CSD: Default Price List, and derive the currency. 
Definition of the owners occur in Resource Manager. The default value for this 
field comes from the profile option Service: Default Service Request Owner.

2.4 The Repair Order Information Area
The Repair Order Information area displays:

� Repair Num: Read-only field that displays the system-generated Repair Order 
Number.

� Repair Type: A mandatory field that is part of the Repair Order line, that 
contains a list of values of the user-defined Repair Types. A workflow supports 
each Repair Type to automate the service depot business process. For more 
information, see Section 1.2.3, "Repair Type Processing" on page 1-4.

� Item: An automatically populated field that shows the item that you specified 
in the Service Request Information area. This field can be changed.

� Item Description: An automatically populated field that shows the description 
of the item that appears after you specify the item.

� UOM (Unit of Measure): An automatically populated field that shows the unit 
of measure after you specify the item. This field can be changed.

� Qty (Quantity): Automatically defaults to 1, except for internal order 
refurbishment repairs.

� Repair Status: Status of the Repair Order.
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� Estimate Approved: Displays the associated estimate approval status value. 
Values include Approved, Pending, Rejected, and null.

2.5 Details Tab
The Details tab contains:

� Repair Num: A read-only field that displays the system-generated Repair Order 
Number.

� Item: An automatically populated field that shows the item that you specified 
in the Service Request Information area. If multiple Repair Orders have already 
been created that are associated with a single Service Request, this field displays 
the item in the Repair Order line that you selected in the Repair Order 
Information area.

� Revision: Displays the item revision residing in the Install Base record, if the 
item is revision controlled.

� Instance: Shows the Install Base Instance value of the item, if the item is Install 
Base trackable.

� Serial Num: Displays the Serial Number of the item for which repair is 
requested, if the item is serialized.

� Lot Num: Displays the item Lot Number residing in the Install Base record, if 
the item is lot controlled.

� Installed Site: Displays the (current) location identifier for the Install Base item.

� Promise Date: Specifies the date within which completion of the item repair 
should occur. This date is a prediction only, and is derived after the service 
depot owner has reviewed the activities and commitments of the service depot.

� Date Created: A read-only field that displays the system-generated date and the 
creation date the Repair Order.

� Date Closed: A read-only field that displays the system-generated date and 
time stamp when the Repair Order status is set to closed.

Note: This is not the same as the Estimate Status which appears in 
the Repair Estimate tab. For more information, see Section 4.13.3, 
"Obtain Customer Approval for a Repair Estimate" on page 4-59.
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� Repair Owner: Service depot resource that is responsible for execution and 
completion of the repair.

� Currency: Displays the functional currency of the repair organization, for 
example, US dollar.

� Price List: Displays the Price List for the default contract of the Repair Order.

� For more information, see Section 4.4, "Determine Contract and Price List 
Defaults at Repair Order Creation" on page 4-8.

� Repair Mode: Contains the value of either WIP or Task based on the selected 
Repair Type.

� Default PO Num: A free form text field to capture the Purchase Order Number. 
This value, if entered, becomes the default value for the PO Num fields in the 
Estimate Charge Line Details form, and the Logistics and Repair Actuals tabs.

Details Tab Check Boxes
� Estimate Approval Required: Forces an approval step after a repair estimate or 

diagnosis is performed, requiring the customer to approve the Repair Order 
before the service depot can proceed with the repair.

� Automatically Enter and Book RMA: Appears selected or cleared by default 
based on setup of the Repair Type corresponding to the Repair Order. When 
you create a Repair Order with this check box selected, the system 
automatically enters and books an RMA line. You can manually override the 
default selection for individual Repair Orders.

Details Tab Buttons
� View Configuration: Displays item details for items that are Install Base 

trackable. Item details include the most recent item configuration and revision 
status. The service depot can use this information when attempting to 
troubleshoot, upgrade, or repair the item. 

� Update Counters: Displays the Counters Update window. In the Counters 
Update window, repair technicians can update the present counters that are 
associated to a item. 

� Update RO Status: Displays the Update Status window where you can change 
the status of a Repair Order to Open, Hold, or Close.

Note: Each Repair Order can have one currency only.
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� Notes: Displays the Notes window. On the Notes window, you can record and 
share relevant information about customers and repair processes.

The Service Request option provides a filter that only permits a user to view 
notes that someone created in the Service Request window. The Depot Repair 
option provides a filter that only permits the user to view notes that someone 
created in the Repair Order window.

2.6 Logistics Tab
On the Logistics tab, you process receiving or shipping transactions, for all types of 
repair.

For general repairs, that is, repairs that are not internal order refurbishments, the 
main operations that you can perform in the Logistics tab are as follows:

� Create and view RMA/Sales Order charge lines that are linked to a selected 
Depot Repair Order.

� Edit or save an existing charge line.

� Book an RMA or Sales Order.

� Pick release a Sales Order.

� Receive a returned item and move it to a subinventory.

� Ship or issue a repaired, loaner, or exchange item.

For internal order refurbishments, the main operations that you can perform in the 
Logistics tab are as follows:

� Create and view the Move In and Move Out charge lines.

� Pick release the internal Sales Order.

� Receive the item for refurbishment and move it to a subinventory.

� Ship the refurbished item.

The main fields on the Logistics tab appear automatically in one of two different 
multi-record layouts, depending on the Repair Type of the Repair Order:

1.  A general layout, the Logistics Tab General Multi-Record Area on page 2-12, for 
most of the Repair Types

2.  A special layout, the Logistics Tab Multi-Record Area for Internal Order 
Refurbishments on page 2-15, for internal order refurbishment Repair Types, 
that is, where the Repair Type has been set up as follows:
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� The Repair Type has Repair Type Ref = Refurbishment.

� The Repair Type has the Internal Order flag set on.

For details of setting up Repair Types, see the Oracle Depot Repair Implementation 
Guide.

Under the multi-record area of the Logistics tab are the elements common to all 
Repair Types:

� Logistics Tab Check Box and Radio Buttons on page 2-16

� Logistics Tab Buttons on page 2-17

2.6.1 Logistics Tab General Multi-Record Area
The general multi-record area of the Logistics tab contains the following fields:

� Process Trans (check box): Selects the charge line for processing. When you 
select a line, you can select the "Automate order processing steps through" 
check box and one of its associated process stage options to set the parameters 
for processing the charge line (see "Logistics Tab Check Box and Radio Buttons" 
on page 2-16.)

� Action Type: 

In the Action Type field, select one of the following:

� Return option to receive customer or vendor items.

� Ship option to ship items to customers or vendors.

� Action Code: When the Action Code field is enabled, either leave the default 
value or select one of the following:

� Customer Item option if the item belongs to the customer.

� Loaner option if the item is on loan to the customer.

� Exchange option if the item is an exchange.

� Replacement option if the item is a replacement.

� Service Activity: Select the relevant Service Activity in this field, for example: 
Return for Repair.

� Order Num: Displays the RMA/Sales Order Number that Oracle Order 
Management returns.
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� Line Num: Displays the Line Number in the Oracle Order Management order 
that is specified in the Order Num field.

� Status: Displays the status of the active Order Management Order Number. The 
status can be Entered, Submitted, Booked, Released, Received, or Shipped.

� Item: Choose the Item Number from the list of values.

� Price List: Specifies an Order Management Price List to price the Charge line.

� Qty: Specify the item quantity.

If the value of Action Code is Customer Item, then the Qty in the Logistics tab 
must not exceed the Repair Order Qty, that is, the Qty in the Repair Order 
Information area. 

� UOM: An item’s unit of measure.

� Price: Specifies a price from the Price List for the charge line.

� Rev: Displays the item revision, if the item is revision controlled.

� (Source) Serial Num: If the Source Item (the Item that is currently being shipped 
or received) is serialized, this field displays the Serial Number for the Source 
Item.

� (Source) Instance: If the Source Item (the Item that is currently being shipped or 
received) is Install Base trackable, this field displays the Instance value for the 
Source Item. 

� (Non Source) Serial Num: If the Non Source Item (the Item that is currently 
being replaced or exchanged) is serialized, this field displays the Serial Number 
for the Non Source Item. This applies only for Ship lines.

Note: The Source fields that follow are based on item inventory 
attributes. For more information, see the Oracle Inventory User’s 
Guide and the Oracle Depot Repair Implementation Guide 

Note: The Non Source fields that follow are based on attributes set 
up in Install Base transaction subtypes. For more information, see 
the Oracle Depot Repair Implementation Guide.
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� (Non Source) Instance: If the Non Source Item (the Item that is currently being 
replaced or exchanged) is Install Base trackable, this field displays the Instance 
value for the Non Source Item. This applies only for Ship lines.

� Lot Num: Displays the item Lot Number, for lot controlled items.

� Subinv: 

� Displays the subinventory into which the item is received for Return lines.

� Displays the subinventory from which the item is shipped for Ship lines.

� Locator: If the item is Locator controlled, displays the Locator information.

� Return Reason: Specify a reason for returning the item from the list of values.

� Return by Date: Specifies the date within which the item you need to return the 
item.

� Contract: Specifies the default Contract Number that applies to the charge lines.

For more information, see Section 4.4, "Determine Contract and Price List 
Defaults at Repair Order Creation" on page 4-8 and Section 2.12.1, "Coverage 
Window" on page 2-39.

� PO Number: Specifies the Purchase Order Number corresponding to the order 
line in this field. This field value is not mandatory.

� (Addresses) Bill-To: Specifies the customer’s Bill-To address.

� (Addresses) Ship-To: Specifies the customer’s Ship-To address.

� Item Description: The description of the item.

� Add to Order: Displays the Order Management Order Number to which you 
want to add the Return/Ship line.

If set, the two profile options:

� CSD: Add to Order Num Within Repair Order Default 

� CSD: Add to Order Num Within Service Request Default 

provide default values for this field. 

If both are set, the default value comes from CSD: Add to Order Num Within 
Repair Order Default.

� No Charge (check box): You specify the default selection of this check box 
during implementation setup of the Service Activities and Billing Types. 
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Selection of No Charge implies that you are not charging the customer for that 
transaction. 

After the charge line has been interfaced to Oracle Order Management, and an 
Order Number appears in the charge line, you cannot update the No Charge 
check box.

2.6.2 Logistics Tab Multi-Record Area for Internal Order Refurbishments
The multi-record area of the Logistics tab that is specific to internal order (not 
internal party) refurbishments contains the following fields:

� Process Trans (check box): Selects the charge line for processing. When you 
select a line, you can select the "Automate order processing steps through" 
check box and one of its associated process stage options to set the parameters 
for processing the charge line (see "Logistics Tab Check Box and Radio Buttons" 
on page 2-16.)

� Action Type: 

In the Action Type field, select one of the following:

� Move In option to receive items from a source organization, such as a 
Spares Management site, and move them into a depot.

� Move Out option to ship items back to the source organization, such as a 
Spares Management site.

� Action Code: The Action Code field displays one of the following values:

� Defective, for the Move In line.

� Usable, for the Move Out line.

� Order Num: Displays the internal Sales Order Number that Oracle Order 
Management returns.

� Line Num: Displays the Line Number and the Shipment Line Number in the 
Oracle Order Management order that is specified in the Order Num field.

� Status: Displays the status of the active Order Management Order Number. The 
status can be Created, Entered, Booked, Released, Received, Shipped, or Issued.

Important: It is recommended that you do not use the Logistics 
tab to charge items for logistics-related transactions. Instead, enter 
charges on the Repair Estimate tab.
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� Item: Choose the Item Number from the list of values.

� (Allocation Qty) Line: Displays the number of units specified on the internal 
refurbishment Repair Order. For serialized items, the value is always 1.

� (Allocation Qty) Shipped: Displays the number of units shipped 

– From the source organization for Move In lines.

– From the depot for Move Out lines.

� (Allocation Qty) Received: Displays the number of units received

– Into the depot for Move In lines.

– The field is disabled for Move Out lines.

� Requisition Num: Displays the Requisition Number from Oracle Purchasing.

� Item Desc: Displays the description of the item.

� UOM: Displays the unit of measure of the item.

� Serial Num: Displays the Serial Number of the item for which repair is 
requested, if the item is serialized.

� Lot Num: Displays the item Lot Number, for lot controlled items 

� Locator: If the item is Locator controlled, displays the Locator information.

� Ship-To Address: Displays the address of the destination organization.

� Source Org: Displays the organization from which the item is moved.

� Source Subinv: Displays the subinventory from which the item is moved.

� Destination Org: Displays the organization to which the item is moved.

� Destination Subinv: Displays the subinventory to which the item is moved.

� Order Type: Type of order from Oracle Order Management.

2.6.3 Logistics Tab Check Box and Radio Buttons
The fields under the multi-record area of the Logistics tab are as follows:

� Automate order processing steps through (check box): 

Automates order processing steps through selected options for Repair Order 
lines. 
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If this check box is selected, you must also select one of the radio button options 
below this check box, to determine the default processing option for the Repair 
Order line.

� Enter Order (radio button)

� Book Order (radio button)

� Pick Release (radio button)

� Ship Confirm (radio button)

Some of these radio buttons are disabled depending on a variety of factors, 
including the Action Type of the line, the Status, whether the repair item is 
serialized, and the type of serialization.

Comments
The following provides a list of the main conditions that affect the visibility and 
usage of the radio button options on the Logistics tab:

1. For Return lines, you can select only the Enter Order or the Book Order radio 
button.

2. For Ship lines, you can select any of the four radio button options.

3. For Move In and Move Out lines, the Enter Order and Book Order radio 
buttons are disabled.

4. For Move In and Move Out lines, the Pick Release radio button is always 
enabled if the Status is Booked.

5. For Move In and Move Out lines, the Ship Confirm radio button is disabled in 
either of the following cases:

� When the serialized item is serialized at Sales Order Issue.

� For partial shipments.

2.6.4 Logistics Tab Buttons
The buttons on the Logistics tab are the following:

� Update Logistics: Used to update the shipping or receiving information in the 
Depot Repair application. This only updates the information for the current 
line. 

� Trans Details: Displays the Transaction Details window. Service depot managers 
can view the transaction details of the charges created for the customer item 
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and view all attributes of the item as it appears in Install Base. Attributes 
include: Location, Configuration, Owner, Accounts, Contacts, Accounting 
Classification, Organization Assignments, and Extended Attributes. 

This button is disabled for Move In and Move Out lines.

� Receive: Displays the Oracle Receiving window to receive the item and place it 
in a subinventory. 

This button is disabled for a Move Out line, and for a Move In line with the 
status of Received.

� Inspect/Move: Used to perform inspection and moving of items to inventory 
during the receiving process.

This button is disabled for a Move Out line, and for a Move In line with the 
status of Received.

� Ship: Displays the Order Management Shipping Transactions window to ship 
the item to the customer. 

This button is disabled when the Status of the line is Shipped.

� Process: Submits the transaction lines, whose Process Trans check box is 
selected, to Order Management and returns a system-generated Order Number 
to the Order Num field.

2.7 Diagnostics Tab
The Diagnostics tab has the following layout:

� Diagnostic Codes Area

In the Diagnostic Codes area, you enter Diagnostic Codes and perform searches 
for solutions in Oracle Knowledge Management based on the selected 
Diagnostic Codes. You can also search for solutions without specifying any 
Diagnostic Codes. 

� Solutions Area

In the Solutions area, you view matching potential solutions in Oracle 
Knowledge Management, determine which ones that you want to add as charge 
lines to the estimate or as Bills and Routings to the WIP Repair Job or both, and 
indicate the usefulness of the solutions.



Diagnostics Tab

Overview of Using Oracle Depot Repair 2-19

� Service Codes Area

In the Service Codes area, after you perform a solution search in Oracle 
Knowledge Management, linked solutions will be returned with associated 
Service Codes (if any exist). These associated Service Codes will be populated 
automatically in the Service Codes area, if the linked solution Status is Useful. 
When your implementor sets up Service Codes, your implementor associates 
material or labor costs or both to each Service Code. For more information on 
setting up Service Codes, see the Oracle Depot Repair Implementation Guide.

� Diagnostics Tab Button

The Search Solutions button enables you to search for solutions in Oracle 
Knowledge Management.

2.7.1 Diagnostic Codes Area
The Diagnostic Codes area contains the following elements:

� Select (check box): Selects the Diagnostic Code to be included as a parameter in 
the Oracle Knowledge Management search.

� Code: Choose the Diagnostic Code from the list of values. This list includes only 
those Diagnostic Codes whose domains include either the Item or the Item 
Category of the Repair Order Item, as set up in Oracle Inventory.

For more information on setting up Diagnostic Codes, see the Oracle Depot 
Repair Implementation Guide. 

� Name: This read-only field specfies the name of the chosen Diagnostic Code.

Diagnostics Codes Area Buttons
� Select All: Selects all the Diagnostic Codes in the Diagnostic Codes area.

� Deselect All: Deselects all the Diagnostic Codes in the Diagnostic Codes area.

Note: If Oracle Knowledge Management is not installed or if the 
profile option CSD: Enable Knowledge Management is set to No, 
then Oracle Knowledge Management related elements will be 
disabled in the Diagnostics tab.
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2.7.2 Solutions Area
The Solutions area displays the solutions that have been given feedback in Oracle 
Knowledge Management and have been linked to a Repair Order in Oracle Depot 
Repair. 

The Solutions area contains the following elements:

� Number: The Oracle Knowledge Management Solution Number.

� Title: The Oracle Knowledge Management solution title.

� Status: The status indicates the usefulness of the solution. The values for Status 
correspond to the question posed in Oracle Knowledge Management: Is this 
solution useful in resolving your question or problem?

� If the answer was Yes, the Status is Useful.

� If the answer was Maybe, the Status is Possibly useful.

� If the answer was No, and the value of the profile option Knowledge: 
Action for Negative Feedback Solution is Linked Solution as Not Solved, 
the Status is Not useful. If the profile option does not have the value Linked 
Solution as Not Solved, then the solution does not appear in the Solutions 
area.

You may change the Status value by clicking the Status field, selecting a different 
value from the list of values, and then clicking Update Status.

Solutions Area Buttons
� Details: Launches the window in Oracle Knowledge Management that displays 

the solution details. 

� Update Status: In order to update the status of the solution, you must click the 
Status field that you want to change, select a new value from the list of values, 
then click Update Status.

Note: After you have brought back a solution from Oracle 
Knowledge Management, you can only change the status of the 
solution in Oracle Depot Repair. You cannot delete a solution from 
the Solutions area; however you can change the status of a solution 
to "Not useful".
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2.7.3 Service Codes Area
The Service Codes area contains the following elements:

� Applicable (check box): Enables the Service Code and its associated elements to 
be included in the subsequent creation of estimate lines and WIP Repair Jobs.

� Code: The Service Code that is associated to WIP and Task elements, such as 
Bills, Routings, and Task Templates, to assist in the creation of estimate lines 
and WIP Repair Jobs.

This field is filled in either automatically or manually. 

After performing a solution search in Oracle Knowledge Management, linked 
solutions which have associated Service Codes will populate automatically in 
the Service Codes area, if the linked solution Status is Useful. 

You may choose Service Codes manually, whether you have any automatic 
entries or not. 

For manual selection, select from the Code list of values. This list displays those 
Service Codes whose domain includes either the Item or the Item Category of 
the Repair Order Item, as set up in Oracle Inventory. 

For more information on setting up Service Codes, see the Oracle Depot Repair 
Implementation Guide. 

� Name: This read-only field specfies the name of the selected Service Code.

� Solution Number: This read-only field specfies the identifying number of the 
Oracle Knowledge Management Solution associated with the chosen Service 
Code, if any.

2.7.4 Diagnostics Tab Button
The Diagnostics tab contains the following button that lies outside the three main 
tab areas:

� Search Solutions

When you click the Search Solutions button, you initiate a search for solutions 
in Oracle Knowledge Management.

2.8 Repair Estimate Tab
The Repair Estimate tab provides a summarized view of the repair estimate 
transactions needed to complete the repair. You can launch an estimate "worksheet" 
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window that allows changes to charge lines that you entered on the Repair Estimate 
tab.

The Repair Estimate tab performs the following functions:

� It uses Order Management Price Lists to determine the selling price for each 
item selected in the charge line.

� It obtains the Item Cost from the inventory Item Master list.

� It copies in charge lines associated with the applicable Service Codes selected in 
the Diagnostics tab.

� It calculates the profit margin for each of the charge lines as a percentage and 
actual dollar amount.

� It provides a summary of estimated charges, with subtotals for Material, Labor, 
and Expenses charges.

� It provides an estimate cost analysis, which lets you compare your estimated 
margins and profitability based on estimated costs and estimated charges.

Repair Estimate Tab Fields
The Repair Estimate tab fields and functionality include:

� Status: Select a status from the list of values. Estimate statuses in Oracle Depot 
Repair include:

� Accepted: An estimate that the customer has approved.

� Bid: An estimate that is awaiting customer approval.

� Cancelled: A cancelled estimate.

� Drafted: An estimate with information, but not ready to be revealed to the 
customer.

� New: An estimate with no entered information.

� Rejected: An estimate that the customer did not approve.

� Date: Select a date from the Calendar to enter the creation date of the Repair 
Estimate.

Note: The CSD: Enable Estimates profile option, set up during 
implementation, lets your organization specify whether to enable 
or disable the Repair Estimate tab in the Depot Repair Workbench.
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� Reason: Select a Reason Code from the list of values that best describes the 
reason for performing the repair estimate process. This field is enabled when 
the Status is Accepted or Rejected.

� Summary: Enter a free text work summary or problem description that best 
describes the repair diagnosis or symptom of the broken or damaged item. 

� Lead Time: Enter the number of units required to complete the item repair.

� UOM: Select a unit of measure to describe the lead time units required.

Repair Estimate Tab Multi-Record Fields
Fields and functionality in the Repair Estimate multi-record area include:

� Source Type: Displays the source of the estimate charge line. Possible values are 
Manual, Service Code and Solution.

� Billing Category: Displays the categories of Material, Labor, or Expense.

� Item: Displays the selected Item Number from inventory

� Contract Number: Displays the Contract Number that is applicable to the 
estimate charge line.

� Price List: Displays the selected Order Management Price List.

� Qty: Displays the quantity if items for which service is being requested.

� UOM: Displays the unit of measure.

� Pricing Attributes: Enter the appropriate Pricing Attribute flexfield information 
for the Price List.

� Unit Price: Displays the item's selling price from the selected Price List.

� Estimated Charge: Displays the charge after the contract entitlement has been 
applied.

� Override Charge (check box): Select this if you want to change the Estimated 
Charge field.

Note: Items for estimates must be defined in the organization 
specified by the profile option Service: Inventory Validation 
Organization.
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� No Charge (check box): Discounts the charge line amount to zero or no charge.

Summary of Estimated Charges Fields
The Summary of Estimated Charges area displays:

� Material: Displays the subtotal of the estimated material required.

� Labor: Displays the subtotal of the estimated labor required.

� Expenses: Displays the subtotal of the estimated expenses required.

� Total: Displays the combined subtotal of the material, labor, and expenses.

� Currency: Displays the currency for the Repair Order, for example: US dollar.

Repair Estimate Tab Buttons
Buttons on the Repair Estimate tab include:

� Estimate Notes: Enter justification notes that describe the estimated transaction 
line.

� Costs: Launches the Estimated Costs versus Estimated Charges window.

� Line Details: Displays the detailed estimate worksheet.

� Add Lines from Diagnostics: Copies charge lines into the Repair Estimates tab 
from the Service Codes marked as applicable in the Diagnostics tab, and their 
associated Oracle Knowledge Management solutions, if not added already.

� Save Estimate: Records estimate header and charge line details.

Note: This field is only enabled if the profile option CSD: Allow 
Charge Override for Estimates is set to Yes.

When you change the Estimated Charge, any discount associated 
with the contract is ignored.

Note: A Repair Order supports only a single currency. The system 
supports different currencies for different Repair Orders within a 
Service Request.
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About Estimate Charge Line Details Window
On the Estimate Charge Line Details window, you can edit details of charge lines 
that you had entered on the Repair Estimate tab.

In the multi-record area, the Estimate Charge Line Details window displays, as 
read-only fields, most of the charge line fields that appear in the Repair Estimate 
Multi-Record Fields area of the Repair Estimate tab, namely:

� Source Type

� Billing Category

� Item

� Contract Number

� Price List

� Qty

� UOM

� Unit Price

� Estimated Charge

� Override Charge (check box)

� No Charge (check box)

When you select one of the charge lines in the multi-record area, the Estimate Line 
Details region shows more details of the selected charge line.

Of all the fields that appear in the Estimate Line Details region, you can edit or enter 
the following field values.

� Billing Category

� Item

� Resource: Displays the resource type that was selected from the item master. 
This field is enabled when Billing Category = Labor.

Note: You cannot add new charge lines or delete existing charge 
lines using the Estimate Charge Line Details window. To add a new 
charge line or delete an existing charge line, return to the Repair 
Estimate tab.
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� PO Num: Enter the customer or vendor Purchase Order Number to validate the 
acceptance of the repair estimate or customer's approval to proceed with the 
pending repair. This field value is not mandatory.

� Price List

� Pricing Attributes

� Quantity

� UOM

� Quantity

� (Contract Information) Number

� Estimated Charge: You can edit this field if you set the check box Override 
Charge.

� Override Charge (check box): To be able to change this field, the profile option 
CSD: Allow Charge Override for Estimates must be set to Yes.

� No Charge (check box): If No Charge is checked, then Override Charge is 
disabled.

When you update these field values, the application automatically updates any 
associated fields.

The Number field in the Contract Information area of the Estimate Line Details 
region displays the default Repair Order contract. This contract could be the best 
contract, the contract associated at the Service Request level, or the contract selected 
manually from the Coverage window that you can access using the menu option 
path Tools > Coverage.

For more information, see Section 4.4, "Determine Contract and Price List Defaults 
at Repair Order Creation" on page 4-8 and Section 2.12.1, "Coverage Window" on 
page 2-39.

The default Repair Order contract populates the Number field in the Contract 
Information area for each estimate charge line. You can override this default value 
at the estimate line level by entering a different contract by selecting from the list of 
values. 

Note: When you change the Estimated Charge, any discount 
associated with the contract is ignored.
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Other fields include:

� Revision: Displays the item Revision Number if the item is revision-controlled.

� Unit Price: Displays the unit price of the item.

� Extended Price: Multiplies Quantity by Unit Price to display the extended price.

� Item Cost: Displays the inventory cost for the selected item.

� Extended Cost: Multiplies Quantity by Item Cost to display the extended cost. 

� (Contract Information) Description: Displays the Contract name for the selected 
Contract Number.

� Discount: Displays the discounted charges by applying the selected contract.

� Profit Margin: Displays the profit margin as a dollar value, for example: Profit 
Margin = $128.45.

� Profit Margin%: Displays the profit margin as a percentage, for example: Profit 
Margin% = 30%.

Estimate Charge Line Details Check Boxes
Check boxes in the Estimate Line Details region include:

� Override Charge: Select this if you want to edit the charges in the Estimated 
Charge field.

� No Charge: Discounts the charge line amount to zero or no charge.

Estimate Charge Line Details Buttons
Buttons on the Estimate Charge Line Details window include:

� Save: Saves the repair estimate charge lines.

� Close: Closes the Estimate Charge Lines Details window.

2.9 Repair Jobs Tab
Access the Repair Jobs tab from the Depot Repair Workbench. The Repair Jobs tab 
displays details of WIP Repair Jobs pertinent to the Repair Order.

Note: To be able to change this field, you must set the value of the 
profile option CSD: Allow Charge Override for Estimates to Yes.
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The Repair Jobs tab displays:

� Job Name: The system shows the Repair Job name after you have created the 
Repair Job.

� Item: Displays the item for which the Repair Job has been created.

� Organization: Displays the name of the repair organization.

� Created: Displays the job quantity created.

� Completed: Displays the job quantity completed.

� (Allocated) Created: If the Repair Job is created for more than one Repair Order, 
displays the quantity created for this Repair Order.

� (Allocated) Completed: If the Repair Job is created for more than one Repair 
Order, displays the quantity completed for this Repair Order.

� Job Status: Displays the current status of the WIP Repair Job.

� (Routing) Reference: Refers to the routing used for the Repair Job.

You create Routings in BOM. WIP uses Routings to assist the repair process. 
Each routing contains the operations and resource requirements for the Repair 
Job.

� (Routing) Alternate: Refers to the alternate if an alternate routing was used for 
the Repair Job.

� Source Type: Displays Service Code or Manual, depending on how the Repair 
Job was created

� Source Name: If Source Type is Service Code, the Source Name is the name of 
the Service Code. If Source Type is Manual, the Source Name has no value.

Buttons
Buttons on the Repair Jobs tab include:

� Update Job: Updates the Repair Job information in Oracle Depot Repair.

� Create Job: Launches the Submit Repair Jobs window. 

For more information, see "Submit Repair Jobs Window" on page 2-29.

The Create Job button is disabled in the following situations:

– The profile option CSD: Allow Creating WIP Job Without RMA is set to No 
and nothing has yet been received against the Repair Order.
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– Estimate approval is required, and the estimate has not yet been approved.

� View Job: Displays the WIP View Discrete Jobs window in a read-only mode to 
show details of the Repair Job.

� Material Txn: Displays the Oracle Inventory Material Transactions window, 
which lets the service agent issue the broken or damaged items and needed 
material for the WIP Repair Job.

� Complete Job: Displays the Oracle WIP Completion Transactions window, 
which lets the service agent complete the WIP Repair Job.

Submit Repair Jobs Window
On the Submit Repair Jobs window, you can submit one or more WIP Repair Jobs 
for a given Repair Order.

The Submit Repair Jobs window includes:

� Repair Job Parameters Area Fields on page 2-29

� Repair Order Area Fields on page 2-30

� Service Codes, Bills and Routings Area Fields on page 2-31

� Buttons on page 2-32

Repair Job Parameters Area Fields
The Repair Job Parameters area of the Submit Repair Jobs window includes the 
following fields:

� Item: Defaults to the Repair Order Item, but you can change the item.

� Description

� Job Name Prefix 

If the value of the profile option CSD: Use CSD as Job Name Prefix is set to Yes, 
the value in this field appears as CSD, and cannot be updated. 

If the value of the profile option CSD: Use CSD as Job Name Prefix is set to No, 
the value in this field defaults to the value of the profile option CSD: Default Job 
Name Prefix, and can be updated. 

� (Quantity) Repair Order: Displays the number of item units on the Repair 
Order. 

� (Quantity) Received: Displays the number of item units received on the Repair 
Order. 
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 The other fields in the Repair Job Parameters area include:

� (Quantity) Submit: Enter the number of item units that you want to submit for 
the Repair Job. This field is mandatory.

(Quantity) Submit must be greater than 0.

The default for the (Quantity) Submit depends on the value of the profile option 
CSD: Allow Creating WIP Job Without RMA, as follows:

– If the value is Yes, (Quantity) Submit defaults to the Repair Order quantity.

– If the value is No, (Quantity) Submit defaults to the received quantity.

If the Repair Job Item is the same as the Repair Order Item, (Quantity) Submit 
cannot exceed the default value.

If the Repair Job Item is different from the Repair Order Item, (Quantity) Submit 
can exceed the default value.

� Job Status: The job status with which you submit a Repair Job to WIP. Possible 
values are Released and Unreleased. This field is mandatory.

This defaults to the value of the profile option CSD: Default Repair Job Status. 

� Accounting Class: The valuation and variance accounts associated with the 
accounting classes determine which accounts are charged and when. You can 
select any active asset non-standard or non-standard expense class. This field is 
mandatory.

� Start Date: Select the WIP Repair Job start date and time. This field is 
mandatory.

� Complete Date: Select the completion date and time for the WIP Repair Job. 
Defaults to the start date. This field is mandatory.

For more information on WIP-related fields, such as Accounting Class, see the 
Oracle WIP User’s Guide.

Repair Order Area Fields
The Repair Order area contains the following read-only fields, related to the Repair 
Order: 

Note: For a WIP Repair Job to begin or for materials to be issued 
against the job, the Job Status must be Released.
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� Customer

� Number: The Repair Order Number.

� Type: The Repair Type of the Repair Order.

� Status: The status of the Repair Order.

� Promise Date

Service Codes, Bills and Routings Area Fields
The Service Codes, Bills and Routings area is the region where you select which 
method you want to use to create the Repair Job, as indicated by the radio buttons 
at the top of the area:

� Use Service Codes

� Select Bills and Routings

� Do not Specify Bills and Routings

Below the radio buttons, there are two multi-record areas. The availability and use 
of these multi-record areas depends on which radio button option you select. 

If there are any Service Codes associated to the Repair Order, the Use Service Codes 
radio button option will be selected by default in the Submit Repair Jobs window.

In the Submit Repair Jobs window, you must perform the following sequence of 
steps:

a. Select one of the radio buttons.

b. Enter information in one of the multi-record areas, if the area is enabled.

c. Click Submit Jobs.

Use Service Codes
If you select the Use Service Codes radio button, then the associated Service Codes 
and Bills and Routings will be displayed in the multi-record areas, and cannot be 
updated.

Note: You cannot select the Use Service Codes button unless there 
are Service Codes associated in the Diagnostics tab.
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If you deselect the Use Service Codes radio button, the Service Code and Bill and 
Routing information is cleared.

For details of selecting Service Codes, see Section 4.12, "Use the Diagnostics Tab and 
Oracle Knowledge Management" on page 4-33.

For details of setting up Service Codes, see the Oracle Depot Repair Implementation 
Guide.

Select Bills and Routings
If you select the Select Bills and Routings radio button, the first multi-record area is 
not applicable, but the second multi-record area is available for you to fill in 
manually, and you must enter at least one bill or routing.

The fields in the second multi-record area are as follows:

� Bills (Reference)

� Bills (Description)

� Bills (Alternate)

� Routing (Reference)

� Routing (Description)

� Routing (Alternate)

These fields refer to Bills and Routings that are set up in Oracle Inventory and 
Oracle Bills of Material. For more information, refer to the User’s Guides for these 
applications.

Do not Specify Bills and Routings
If you select the Do not Specify Bills and Routings radio button, neither of the 
multi-record areas is applicable. With this option selected, when you submit a 
Repair Job, it is submitted without any Bill or Routing information for creation in 
WIP.

Buttons
The Submit Repair Jobs buttons include:

� Submit Jobs: Submits the Repair Job to WIP for creation.

� Close: Closes the Submit Repair Jobs window.
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2.10 Repair Tasks Tab
You can access the Repair Tasks tab from the Depot Repair Workbench. On the 
Repair Tasks tab, you can create the tasks needed to assist an item repair. This tab is 
enabled only if the Repair Type chosen has been defined during implementation to 
use the repair mode of Task.

The tasks appear in the Repair Tasks table. The fields on the Repair Tasks tab 
dashboard area include:

� Number: Displays the system-assigned Task Number.

� Name: Displays the task name.

� Description: Displays the task description.

� Status: Displays the current task status.

� Priority: Displays the task priority, for example: Critical, High, Medium, or 
Low.

� Actual Start: Displays the task start date.

� Actual End: Displays the task end or completion date.

� Owner: Displays the task owner's name.

The fields on the Repair Tasks tab include:

� Number: Displays the system-assigned Task Number.

� Type: Displays the service depot task type, for example: Callback, Diagnostic, 
General, Repair, or Upgrade.

� Name: Displays the task name.

� Status: Displays the current task status selected from the list of values.

� Priority: Displays the task priority selected from the list of values, for example: 
Critical, High, Medium, or Low.

� Description: A free text field to enter a detailed description of the displayed 
task.

Note: If there are any errors during the process of submitting a 
WIP Repair Job, such as an inactive Service Code, they will appear 
in an Errors window.
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� Publish (check box): If you wish to display the task for the customer to see on 
their Oracle iSupport Web portal, then select the Publish check box.

� Private (check box): Select the Private check box if this is a personal task and 
you do not want other employees to view it. Any resource associated with the 
task, for example an assignee, will have access to the task whether it is marked 
as private or not.

� Owner Type: Displays the owner type selected from the list of values, for 
example: Employee, Group, or Team Resource.

� Owner: Displays the task owner's name selected from the list of values.

� Assignee Type: Displays the assignee type selected from Assignment Manager.

� Assignee: Displays the assignee selected from Assignment Manager.

The fields in the Dates section of the Repair Tasks tab include:

� Planned Start: Displays planned start date.

� Planned End: Displays planned end date. 

� Scheduled Start: Displays scheduled start date. 

� Scheduled End: Displays scheduled end date. 

� Actual Start: Displays actual start date. 

� Actual End: Displays actual end date. 

The fields that appear in the Effort section of the Repair Tasks tab include:

� Estimate Qty: Displays estimated number of units to complete the task.

� Estimate UOM: Displays unit of measure used to describe the estimated effort.

� Actual Qty: Displays actual number of units used to complete the task.

� Actual UOM: Displays unit of measure used to describe the actual effort.

Repair Tasks Tab Buttons
Buttons on the Repair Tasks tab include:

� Assignment Manager icon (next to the Assignee field): Displays the Assignment 
Manager window.

� Use Template: Displays the Create Tasks from Template Group window to 
permit creation of new tasks from previously defined templates.
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� Launch Workflow: Starts the task workflow to reserve the designated resources 
and notify the task owner of task creation.

� Debrief: Displays the Debrief Report window to capture the Material, Labor, 
and Expense billing transactions used to complete the task.

� More: Displays the windows to display and capture additional task details 
including:

� Resources: Defines and displays resource requirements, assignments, and 
scheduling information.

� Dependencies: Specifies ordering and prioritization of multiple tasks.

� References: Permits linking of task to different documents or to other 
pertinent background information.

� Dates: Identifies more dates in addition to the planned dates.

� Contacts: Enables creation and management of multiple contacts who are 
assigned to a task. The system obtains contact information from customer 
information.

� Recurrences: Enables the scheduling of tasks to occur automatically.

� Others: Identifies additional information about the task.

� Audit: Displays an audit history log with the changed dates and the user 
responsibility that initiated the changes.

2.11 Repair Actuals Tab
The Repair Actuals tab provides the data fields required for billing your customer 
for charges incurred during the processing of items in Oracle Depot Repair.

The Repair Actuals tab contains the following elements:

� The Summary of Actual Charges area

� A multi-record area consisting of the charge line fields

� Buttons to allow you to perform the following operations:

� Specify from where to add lines to the Repair Actuals tab

� View further details of the charge lines

� Select and deselect all charge lines

� Book selected charge lines
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Depending on how you choose to add lines to the multi-record area, certain fields 
and buttons may be enabled or disabled. See the Comments at the end of this 
section.

Summary of Actual Charges area
The Summary of Actual Charges area displays a summary of the information which 
appears in greater detail in the multi-record area. 

The Summary of Actual Charges area consists of the following read-only fields:

� Material: Total charge of all the charge lines with the Material billing category.

� Labor: Total charge of all the charge lines with the Labor billing category.

� Expenses: Total charge of all the charge lines with the Expenses billing category.

� Total: Total charge of all the charge lines.

� Currency: Currency of all the charges.

Repair Actuals Tab Multi-Record Area
The multi-record area in the Repair Actuals tab is populated either with data copied 
from other Depot Repair Workbench tabs, or manually.

The multi-record area of the Repair Actuals tab includes the following fields:

� Select (check box): Selects the charge line for booking.

� Source Type: Describes the source of the actual charge line. 

The available values are:

� WIP, Estimate, and Task, for lines copied from other Oracle Depot Repair 
tabs. 

� Manual, if you enter the actual charge line manually in this window. This 
value appears when you start to enter a new charge line. 

� Order Number: Displays the Order Number returned from Oracle Order 
Management, after you click Book Selected. 

� Billing Category*

Note: The fields marked with an asterisk (*) below are available 
for you to enter data if the Source Type field is Estimate or Manual.
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� Item*

� Serial Num*: This field is enabled for items that are serialized at receipt.

� PO Number*

� Contract Number*

� Price List*

� Pricing Attributes*

� Qty*

� UOM*

� Unit Price

� Charge*: You can enter a Charge if you first set the check box Override Charge 
and if the value of the profile option CSD: Allow Charge Override for Actuals is 
set to Yes. See the Comments at the end of this section.

� Override Charge* (check box)

� No Charge* (check box)

Repair Actuals Tab Button area
The button area contains mainly buttons, and one data field, as follows:

Select All button: Selects all the eligible charge lines in the multi-record area.

Deselect All button: Deselects all the eligible charge lines in the multi-record area.

Book Selected button: Books the selected charge lines in the multi-record area.

Line Details button: Shows details of the actual charge line.

Source field: Source of charge lines to copy into the Repair Actuals window. 

� For WIP mode repairs, the options are WIP and Estimate.

� For Task mode repairs, the options are Task and Estimate.

Add button: Click this to copy the charge lines into the Repair Actuals tab from the 
source you selected in the Source field.

Comments
1. The Book Selected button and the Select check box are enabled for all sources.
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2. For lines whose Source Type is WIP, all the fields in the multi-record area except 
Override Charge (if CSD: Allow Charge Override for Actuals is set to Yes) and 
No Charge are disabled. If you check Override Charge, you can enter a new 
Charge.

3. For lines whose Source Type is Task, the Select check box is checked, by default, 
and cannot be deselected. All the other fields in the multi-record area are 
disabled.

4. For lines whose Source Type is Task, only Book Selected and Line Details are 
available to you, as task lines have already been flagged for interfacing to 
Oracle Order Management.

2.12 Depot Repair Workbench Tools Menu 
The Tools Menu of the Depot Repair Workbench provides the following facilities:

� Quick Menu: Launches the Quick Menu.

� Print Estimate: Submits the repair estimate for printing.

� Freeze Estimate: Freezes the repair estimate and prevents updates.

� Capture Serial Numbers: Enables the user to capture multiple Serial Numbers 
for the creation of Repair Orders for serialized items with a quantity greater 
than one.

� Find Customer: Allows user to find customers based on an item in Oracle 
Install Base. This feature is available when you are creating the Service Request 
for the Repair Order.

� Split Repair Order: Allows the user to split a Repair Order. For more 
information, see Section 4.18, "Split a Repair Order" on page 4-73.

� Profile: To view an existing customer profile, select Profile from the Tools menu. 
For proper setup of the Profile window with customizable options, see the 
Oracle TeleService Implementation Guide.

� Send Message: Choose Send Message from the Tools menu to send a workflow 
notification message, and have that message link to the Repair Order selected in 
the Depot Repair Workbench at the time the message was sent. For more 
information, see the Oracle TeleService User Guide.

� View Message History: Choose View Message History from the Tools menu to 
display the Message History window. For more information, see the Oracle 
Support User Guide.
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� Coverage: For details, see Section 2.12.1, "Coverage Window" on page 2-39.

2.12.1 Coverage Window
The Coverage window displays detailed information about the Install Base item 
and Contract entitlements. When you select the Coverage option from the Tools 
menu in the Depot Repair Workbench, active entitlements or all entitlements (based 
on option button selection) applicable to the selected Repair Order appear.

Option Buttons
Option buttons in the Coverage window include:

� View Active Contracts: Displays the active entitlements that are applicable to 
the selected Repair Order.

� View All Contracts: Displays all the entitlements that are applicable to the 
selected Repair Order, including expired ones. This is a useful tool for service 
agents to inform customers about contract coverage expiration and service 
contract renewal opportunities to reinstate item coverage.

Multi-Record Area Region
The fields that appear in the multi-record area region include:

� Default (check box): Permits the service agent to select a contract coverage to 
override the coverage selected at the Service Request level. Select the Default 
check box corresponding to the relevant contract coverage, and click Apply to 
cause this change. The system defaults this coverage to all charge lines 
associated with the selected Repair Order. However, you cannot apply this 
selected default contract to the Task Debrief charge lines. The selected contract 
at the Service Request level applies by default to these charge lines. 

� Contract Num: The item warranty or Service Contract Number.

� Service: The contract name, Warranty, PM, Support Only, and Full Service.

� Description: High-level description of the contract offering. 

� Coverage: The service provider's contract coverage window in days and hours.

� Start Date: The warranty or contract's effective start date.

� End Date: The warranty or contract's effective end date.
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Buttons
Buttons in the Coverage window include:

� View Coverage: Displays the Service Contracts Coverage window that shows 
details of the selected coverage. You can access this window also by 
double-clicking the Coverage (field) value of an entitlement. For more 
information, refer to the online help available from the Service Contracts 
Coverage window.

� Close: Closes the Coverage window.

� Apply: Select the contract entitlement that you want to use as default by using 
the Default check box, and click Apply. This selection overrides the existing 
default contract. This selected contract becomes the default contract for the 
Repair Order. However, note that this contract cannot be applied to the Task 
Debrief charge lines. Instead, the contract selected at the Service Request level 
applies by default to the Debrief charge lines. 

2.13 Depot Repair Workbench Data Menu 
The Data Menu of the Depot Repair Workbench provides the following facilities:

� Section 2.13.1, "Service History Window" on page 2-40

� Section 2.13.2, "Activity Window" on page 2-41

2.13.1 Service History Window
The Service History window displays all the Service Requests and service depot 
Repair Orders that have been logged against an Install Base item. 

A service agent can view a document by clicking the Repair Order or Service 
Request Number links to display the historical document. This functionality 
permits the service provider to review the service history and repair records spread 
over the lifetime of the Install Base item.

The Service History window displays the following information in the multi-record 
areas:

Note: An item must be Install Base trackable in order for this 
functionality to work.
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Service Requests Fields
Service Requests fields include:

� Number: Service Request Number.

� Date Opened: Displays the creation date of the Service Request document.

� Date Closed: Displays the closed date of the Service Request document.

� Type: Displays the Service Request type.

� Status: Displays the current Service Request status.

� Severity: Displays the severity of the Service Request or Repair Order that the 
owner set.

� Urgency: Displays the customer's urgency being weighted on the Service 
Request. 

Repair Orders Fields
Repair Orders fields include:

� Number: Repair Order Number.

� Date Opened: Displays the creation date of the Repair Order document.

� Date Closed: Displays the closed date of the Repair Order document.

� Type: Displays the Service Request type. 

� Status: Displays the current Repair Order status.

� Service Request: Displays the Service Request Number that is linked to the 
Repair Order.

Buttons
Buttons in the Service History window include:

� Close: Closes the Service History window.

2.13.2 Activity Window
The Activity window provides the service depot agent with information about the 
major events and activities that occurred for a Repair Order. The agent can view the 
latest status with each event date and time stamped at the completion of a process 
step.
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The fields that appear in the upper section of the Activity window include:

� Qty Received: RMA quantity that the service depot received.

� Qty Submitted to WIP: Repair Order quantity submitted to the Repair Job.

� Qty Completed in WIP: Repair Job quantity completed in WIP. 

� Qty Shipped: Repair Order quantity shipped against the Sales Order.

The fields that appear in the lower multi-record area include:

� Event: The Repair Order event that the service depot completed.

� Date: The completion date or time stamp of the activity.

� Details: Specific information about a particular activity.

Buttons
Buttons in the Activity window include:

� Close: Closes the Activity window.

2.14 Find Repair Orders for Job Submission Window
The Find Repair Orders for Job Submission window permits you to search for 
Repair Orders against which you want to submit Repair Jobs. Access the Find 
Repair Orders for Job Submission window by double-clicking Submit Repair Jobs 
under Depot Repair in the Navigator window. Double-clicking Submit Repair Jobs 
displays the Organizations window, where you choose the organization that is 
repairing the item or where the item is being repaired.

In the Find Repair Orders for Job Submission window, use the following fields to 
specify your search criteria or view the search results:

� Service Request Area Fields on page 2-43

� Repair Order Area Fields on page 2-43

� Search Buttons on page 2-44

� Results Area Fields on page 2-44

Note: The Qty Submitted to WIP and Qty Completed in WIP 
fields appear only for repairs being processed in WIP repair mode.
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� General Buttons on page 2-45

Service Request Area Fields
You can enter one or more Service Request search parameters in the following 
fields:

� Request Num: Service Request Number.

� Customer: Name of the person or organization.

� Account: Customer account.

� Severity: Service Request severity.

� Urgency: Service Request urgency.

Repair Order Area Fields
You can enter one or more Repair Order search parameters in the following fields:

� Repair Num: Repair Order Number.



Find Repair Orders for Job Submission Window

2-44 Oracle Depot Repair User Guide

� Item: The Repair Order Item.

� Description: The description of the Repair Order Item.

� Serial Num: The Serial Number of the Repair Order Item.

� RMA/Sales Order Num: The RMA/Sales Order Number.

� Repair Type: The Repair Type of the Repair Order.

� Supercession Item: The Item that has been upgraded or changed and used to 
replace another Item.

For more information about supercessions, see the Oracle Field Service User 
Guide.

� Description: The description of the supersession item.

� Internal Order Num: The internal Order Number for a refurbishment generated 
from Spares Management.

� Internal Requisition Num: The internal Requisition Number for a requisition 
generated from Oracle Purchasing.

� Create Date: Creation date of the Repair Order. Optionally, start and end dates 
for a range of creation dates.

� Promise Date: The Promise date of the Repair Order. Optionally start and end 
dates for a range of promise dates.

� Create Date: Creation date of the Repair Order. You can enter a creation date 
range if you want to perform a search based on this attribute.

Search Buttons
The Search buttons, below the Repair Order area, include:

� Find: Searches and returns results based on your entered search criteria. 

� Clear: Clears the fields in which you have entered values to specify your search 
criteria. You can enter new values to perform a new search.

Results Area Fields
The fields in results area are almost completely the same as the search parameter 
fields in the Service Request and Repair Order areas. The main result fields, that 
appear in the non-scrolling area, are:

� Request Num: The Service Request Number for the Repair Order.
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� Repair Number: The Repair Order Number.

� Item: The Repair Order Item.

General Buttons
The General buttons, in and below the Results area, include:

� Select All: Selects all the Repair Orders in the Results area.

� Deselect All: Deselects all the Repair Orders in the Results area.

� OK: Displays the Submit Repair Jobs for Repair Orders window for the selected 
Repair Orders.

� Cancel: Closes the Find Repair Orders for Job Submission window.

2.15 Submit Repair Jobs for Repair Orders Window
On the Submit Repair Jobs for Repair Orders window, you can submit a single WIP 
Repair Job for single or multiple Repair Orders to WIP. 

The Submit Repair Jobs for Repair Orders window includes:

� Repair Job Parameters Area Fields on page 2-29

� Repair Order Area Fields on page 2-30

� Service Codes, Bills and Routings Area Fields on page 2-31

� Buttons on page 2-32

Note: To select multiple, non-contiguous rows from among the 
Search Results, press and hold the Control key, and click each row.

To select a range of rows from among the Search Results, click the 
first row of the range, then press and hold the Shift key, and click 
the final row of the range.
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Repair Jobs Parameters Area Fields
The fields in the Repair Jobs Parameters area include:

� Item: The item Number of the Repair Job. This field is mandatory.

� Description: The item description.

� Job Name Prefix: The job name prefix for the Repair Job. 

If the value of the profile option CSD: Use CSD as Job Name Prefix is set to Yes, 
the value in this field appears as CSD, and cannot be updated. 

If the value of CSD: Use CSD as Job Name Prefix is set to No, the value in this 
field defaults to the value of the profile option CSD: Default Job Name Prefix, 
and can be updated. 

� Job Status: The job status with which you want to submit a Repair Job to WIP. 
Possible values are Released and Unreleased. This field is mandatory.

This defaults to the value of the profile option CSD: Default Repair Job Status. 
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� Accounting Class: The valuation and variance accounts associated with the 
accounting classes determine which accounts are charged and when. You can 
select any active asset non-standard or non-standard expense class. This field is 
mandatory.

� Start Date: Select the WIP Repair Job start date and time. This field is 
mandatory.

� Complete Date: Select the completion date and time for the WIP Repair Job. 
Defaults to the start date. This field is mandatory.

� Total Submit Qty (read-only): Shows the total of the (Quantity) Submit values in 
the lines of the Repair Order Details tab. This is the number of items that you 
want to submit to WIP.

This is the same as the Released quantity for a Repair Order line when you 
selected only one Repair Order for submission to WIP. When you are creating a 
Repair Job for multiple Repair Orders, this field value is the sum of the 
quantities for all the Repair Orders that you are submitting.

For more information on WIP-related fields, such as Accounting Class, see the 
Oracle WIP User’s Guide.

Repair Order Details Tab
The Repair Order line or lines that you selected from among the search results in the 
Find Repair Orders for Job Submission window populate the Repair Order Details 
tab. The fields on the Repair Order Details tab include:

� (Quantity) Repair Order (read-only): Shows the item quantity in a Repair Order.

� (Quantity) Received (read-only): Shows the quantity of items that you received 
against a Repair Order.

� (Quantity) Submit: Quantity of items in a Repair Order that you want to submit 
to WIP for repair.

Bills and Routings Tab
You can optionally specify Bills and Routings to be used on the Repair Job.

The fields on the Bills and Routings tab include two radio buttons:

Note: For a WIP Repair Job to begin or for materials to be issued 
against the job, the Job Status must be Released.
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� Select Bills and Routings

� Do not Specify Bills and Routings

The multi-record area, which is enabled only if you select the Select Bills and 
Routings radio button, consists of the following fields: 

� (Bill) Reference

� (Bill) Description

� (Bill) Alternate 

� (Routing) Reference

� (Routing) Description

� (Routing) Alternate 

Buttons
The buttons include:

� Submit Jobs: Submits the Repair Job or jobs to WIP for creation.

� Close: Closes the Submit Repair Jobs for Repair Orders window.
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3
Oracle Depot Repair Business Scenarios

Business process flows vary with business scenarios. This chapter describes 
working with different service depot repair business scenarios.

For detailed procedures on handling the different processes comprising the business 
flow scenarios discussed here, refer to Chapter 4, "Managing Depot Business 
Processes".

Topics discussed in this chapter include:

� Section 3.1, "Process a Repair and Return" on page 3-1

� Section 3.2, "Process a Loaner, Repair and Return" on page 3-3

� Section 3.3, "Process an Exchange" on page 3-6

� Section 3.4, "Process an Advance Exchange" on page 3-7

� Section 3.5, "Process a Replacement" on page 3-8

� Section 3.6, "Process an Internal Order Refurbishment" on page 3-10

3.1 Process a Repair and Return
The following steps describe in the recommended order how to process a Repair 
and Return scenario. 

For more information, see Repair and Return on page 1-4.

Steps
1. If you have not already created a Service Request, then create a Service Request 

in the Depot Repair Workbench.

For more information, see Section 4.6, "Create a Service Request" on page 4-12.
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2. Create a Repair Order with Repair Type Repair and Return.

If the create process is successful, the application automatically creates two 
charge lines, one with Action Type Return, the other with Action Type Ship. 

For more information, see Section 4.8, "Create a Repair Order in the Depot 
Repair Workbench" on page 4-17.

3. If you have not created and booked the Return line automatically as part of the 
process of creating the Repair Order, then book the Return line.

See Section 4.9, "Create and Book a Return Line Manually" on page 4-25.

4. If you want to diagnose the problem by searching Oracle Knowledge 
Management for solutions to related problems, or if you want to apply Service 
Codes to help in creating estimates and WIP Repair Jobs for the current Repair 
Order, see Section 4.12, "Use the Diagnostics Tab and Oracle Knowledge 
Management" on page 4-33.

5. Receive the item, with or without inspection. 

For more information, see Section 4.14, "Receive a General Item" on page 4-61.

6. The ability to create an estimate is controlled by a profile option. If this is 
enabled, and you want to create an estimate, then estimate the repair charges 
and, if required, obtain the customer’s approval.

For more information, see Section 4.13, "Estimate Repair Charges" on page 4-50.

� If the customer accepts the repair estimate, then proceed to step 7.

� If the customer rejects the repair estimate, then close the Repair Order and 
the Service Request, if appropriate, to end this scenario.

7. Manage the repair process using either WIP or Task repair mode.

The definition of the Repair Type that occurred during setup determines the 
repair mode. Based on this definition, the Repair Jobs tab or Repair Tasks tab is 
available.

For more information, see the following topics:

� Section 4.19, "Manage the Repair Process" on page 4-76

Note: The repair mode associated with the seeded Repair Type 
Repair and Return is WIP.



Process a Loaner, Repair and Return

Oracle Depot Repair Business Scenarios 3-3

� Section 4.20, "Create and Process WIP Repair Jobs" on page 4-76

� Section 4.21, "Create and Process Repair Tasks" on page 4-88

8. If you have not created the Ship line automatically as part of the process of 
creating the Repair Order, then create the Ship line manually.

See Section 4.25, "Create a Ship Line Manually" on page 4-102.

9. Ship the repaired item, and process the Ship line accordingly.

See Section 4.26, "Ship a General Item" on page 4-104.

10. If required, create actual charges for the Repair Order.

See Section 4.28, "Record Billing Data in Repair Actuals" on page 4-111.

11. If required, book the actual charges for the Repair Order.

See Section 4.29, "Book Repair Actuals" on page 4-118.

12. If required, invoice the customer.

See Section 4.30, "Invoice a Customer" on page 4-119.

13. Close the Repair Order.

For more information, see Section 4.31, "Close a Repair Order" on page 4-120.

14. If appropriate, close the Service Request.

For more information, see Section 4.32, "Close a Service Request" on page 4-121.

3.2 Process a Loaner, Repair and Return
The following steps describe in the recommended order how to process a loaner, 
repair and return. 

For more information, see Loaner, Repair and Return on page 1-4.

Steps
1. If you have not already created a Service Request, then create a Service Request 

in the Depot Repair Workbench.

For more information, see Section 4.6, "Create a Service Request" on page 4-12.

2. Create Repair Order with the Loaner, Repair and Return Repair Type.

For more information, see Section 4.8, "Create a Repair Order in the Depot 
Repair Workbench" on page 4-17.
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3. If the create process is successful, the application automatically creates these 
charge lines:

� Ship line for loaner

� Return line for defective item return

� Ship line for repair of defective item

� Return line to track the loaner item return

4. If you have not created the Ship line for the loaner automatically as part of the 
process of creating the Repair Order, then create the Ship line manually.

See Section 4.25, "Create a Ship Line Manually" on page 4-102.

5. Ship the loaner item, and process the Ship line accordingly.

See Section 4.26, "Ship a General Item" on page 4-104.

6. If you have not created and booked the Return line for the defective item 
automatically as part of the process of creating the Repair Order, then book the 
Return line.

See Section 4.9, "Create and Book a Return Line Manually" on page 4-25.

7. If you want to diagnose the problem by searching Oracle Knowledge 
Management for solutions to related problems, or if you want to apply Service 
Codes to help in creating estimates and WIP Repair Jobs for the current Repair 
Order, see Section 4.12, "Use the Diagnostics Tab and Oracle Knowledge 
Management" on page 4-33.

8. Receive the defective item, with or without inspection. 

For more information, see Section 4.14, "Receive a General Item" on page 4-61.

9. The ability to create an estimate is controlled by a profile option. If this is 
enabled, and you want to create an estimate, then estimate the repair charges 
and, if required, obtain the customer’s approval.

For more information, see Section 4.13, "Estimate Repair Charges" on page 4-50.

� If the customer accepts the repair estimate, then proceed to step 10.

� If the customer rejects the repair estimate, then close the Repair Order and 
the Service Request, if appropriate, to end this scenario.

10. Manage the repair process using either WIP or Task repair mode.
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The definition of the Repair Type that occurred during setup determines the 
repair mode. Based on this definition, the Repair Jobs tab or Repair Tasks tab is 
available.

For more information, see the following topics:

� Section 4.19, "Manage the Repair Process" on page 4-76

� Section 4.20, "Create and Process WIP Repair Jobs" on page 4-76

� Section 4.21, "Create and Process Repair Tasks" on page 4-88

11. If you have not created the Ship line for the repaired item automatically as part 
of the process of creating the Repair Order, then create the Ship line manually.

See Section 4.25, "Create a Ship Line Manually" on page 4-102.

12. Ship the repaired item, and process the Ship line accordingly.

See Section 4.26, "Ship a General Item" on page 4-104.

13. If required, create actual charges for the Repair Order.

See Section 4.28, "Record Billing Data in Repair Actuals" on page 4-111.

14. If required, book the actual charges for the Repair Order.

See Section 4.29, "Book Repair Actuals" on page 4-118.

15. If required, invoice the customer.

See Section 4.30, "Invoice a Customer" on page 4-119.

16. When the loaner item is returned, book the Return line for the loaner item.

See Section 4.9, "Create and Book a Return Line Manually" on page 4-25.

17. Receive the returned loaner item, with or without inspection. 

For more information, see Section 4.14, "Receive a General Item" on page 4-61.

18. If additional charges, such as rental charges, are required for the loaner item, 
create actual charges for the Repair Order.

See Section 4.28, "Record Billing Data in Repair Actuals" on page 4-111.

19. If required, book the actual charges for the Repair Order.

Note: The repair mode associated with the seeded Repair Type 
Loaner, Repair and Return is WIP.
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See Section 4.29, "Book Repair Actuals" on page 4-118.

20. If required, invoice the customer.

See Section 4.30, "Invoice a Customer" on page 4-119.

21. Close the Repair Order.

For more information, see Section 4.31, "Close a Repair Order" on page 4-120.

22. If appropriate, close the Service Request.

For more information, see Section 4.32, "Close a Service Request" on page 4-121.

3.3 Process an Exchange
The following steps describe how to process an exchange in which an item is sent to 
the customer after the service depot has received the defective item.

For more information, see Exchange on page 1-4.

Steps
1. If you have not already created a Service Request, then create a Service Request 

in the Depot Repair Workbench.

For more information, see Section 4.6, "Create a Service Request" on page 4-12.

2. Create a Repair Order with Repair Type Exchange.

If the create process is successful, the application automatically creates two 
charge lines, one with Action Type Return, the other with Action Type Ship.

For more information, see Section 4.8, "Create a Repair Order in the Depot 
Repair Workbench" on page 4-17.

3. If you have not created and booked the Return line automatically as part of the 
process of creating the Repair Order, then book the Return line.

See Section 4.9, "Create and Book a Return Line Manually" on page 4-25.

4. Receive the item, with or without inspection. 

For more information, see Section 4.14, "Receive a General Item" on page 4-61.

Note: Processing for the Exchange Repair Type typically does not 
include a repair stage.
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5. If you have not created the Ship line automatically as part of the process of 
creating the Repair Order, then create the Ship line manually.

See Section 4.25, "Create a Ship Line Manually" on page 4-102.

6. Ship the exchange item, and process the Ship line accordingly.

See Section 4.26, "Ship a General Item" on page 4-104.

7. If required, create actual charges for the Repair Order.

See Section 4.28, "Record Billing Data in Repair Actuals" on page 4-111.

8. If required, book the actual charges for the Repair Order.

See Section 4.29, "Book Repair Actuals" on page 4-118.

9. If required, invoice the customer.

See Section 4.30, "Invoice a Customer" on page 4-119.

10. Close the Repair Order.

For more information, see Section 4.31, "Close a Repair Order" on page 4-120.

11. If appropriate, close the Service Request.

For more information, see Section 4.32, "Close a Service Request" on page 4-121.

3.4 Process an Advance Exchange
The following steps describe how to process an advance exchange in which an 
exchange item is sent to a customer before the defective item has been received back 
from the customer for a credit.

For more information, see Advance Exchange on page 1-5.

Steps
1. If you have not already created a Service Request, then create a Service Request 

in the Depot Repair Workbench.

For more information, see Section 4.6, "Create a Service Request" on page 4-12.

2. Create Repair Order with the Advance Exchange Repair Type.

Note: Processing for the Advance Exchange Repair Type typically 
does not include a repair stage.
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For more information, see Section 4.8, "Create a Repair Order in the Depot 
Repair Workbench" on page 4-17.

If the create process is successful, the application automatically creates two 
transaction lines, one with Action Type Ship, the other with Action Type 
Return.

3. If you have not created the Ship line automatically as part of the process of 
creating the Repair Order, then create the Ship line manually.

See Section 4.25, "Create a Ship Line Manually" on page 4-102.

4. Ship the exchange item, and process the Ship line accordingly.

See Section 4.26, "Ship a General Item" on page 4-104.

5. If you have not created and booked the Return line automatically as part of the 
process of creating the Repair Order, then book the Return line.

See Section 4.9, "Create and Book a Return Line Manually" on page 4-25.

6. Receive the item, with or without inspection. 

For more information, see Section 4.14, "Receive a General Item" on page 4-61.

7. If required, create actual charges for the Repair Order.

See Section 4.28, "Record Billing Data in Repair Actuals" on page 4-111.

8. If required, book the actual charges for the Repair Order.

See Section 4.29, "Book Repair Actuals" on page 4-118.

9. If required, invoice the customer.

See Section 4.30, "Invoice a Customer" on page 4-119.

10. Close the Repair Order.

For more information, see Section 4.31, "Close a Repair Order" on page 4-120.

11. If appropriate, close the Service Request.

For more information, see Section 4.32, "Close a Service Request" on page 4-121.

3.5 Process a Replacement
The following steps describe how to process a replacement in which the service 
depot sends a replacement item to the customer.
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For more information, see Replacement on page 1-5.

Steps
1. If you have not already created a Service Request, then create a Service Request 

in the Depot Repair Workbench.

For more information, see Section 4.6, "Create a Service Request" on page 4-12.

2. Create Repair Order with the Replacement Repair Type.

For more information, see Section 4.8, "Create a Repair Order in the Depot 
Repair Workbench" on page 4-17.

If the create process is successful, the application automatically creates one 
transaction line with action type Ship.

3. If you have not created the Ship line automatically as part of the process of 
creating the Repair Order, then create the Ship line manually.

See Section 4.25, "Create a Ship Line Manually" on page 4-102.

4. Ship the exchange item, and process the Ship line accordingly.

See Section 4.26, "Ship a General Item" on page 4-104.

5. If required, create actual charges for the Repair Order.

See Section 4.28, "Record Billing Data in Repair Actuals" on page 4-111.

6. If required, book the actual charges for the Repair Order.

See Section 4.29, "Book Repair Actuals" on page 4-118.

7. If required, invoice the customer.

See Section 4.30, "Invoice a Customer" on page 4-119.

8. Close the Repair Order.

For more information, see Section 4.31, "Close a Repair Order" on page 4-120.

9. If appropriate, close the Service Request.

For more information, see Section 4.32, "Close a Service Request" on page 4-121.

Note: Processing for the Replacement Repair Type typically does 
not include a repair stage.
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3.6 Process an Internal Order Refurbishment
Defective items in a Spares Management warehouse can be sent for repair to a 
Oracle Depot Repair depot, and returned to Spares Management after repair. 

From Spares Management, you identify how many units of each defective item you 
wish to repair. Then you create a Service Request and one or more Repair Orders, 
also within Spares Management, as follows:

� For serialized items, there is one Repair Order for each item instance.

� For non-serialized items, there is one Repair Order for each item.

The type of repair carried out in this situation is called a refurbishment.

From the depot’s perspective, defective items are received via an Internal 
Requisition, and usable or repaired items are shipped via an Internal Order.

The following steps describe how to process a refurbishment for an item or item 
instance, for which a Repair Order has been created in the Spares Management 
module of Oracle Field Service.

Steps
The steps below describe the processing for an individual refurbishment Repair Order.

1. In the Find Repair Orders window, search for the Repair Order created in 
Spares Management.

When the Repair Order appears in the Depot Repair Workbench, certain fields 
are filled in, as follows:

� In the Service Request Information area, the Summary contains a standard 
description, such as "Internal Refurbish repair".

� In the Repair Order Information area, the Repair Type indicates that the 
item is to be refurbished; the value of the Repair Type is provided by the 
profile option CSD: Repair Type Internal Repair Order. 

The Repair Type must have been set up with a Repair Type Ref of 
Refurbishment, and its Internal Order check box must have been set.

For more information on setting up Repair Types, see the Oracle Depot Repair 
Implementation Guide.

Note: Spares Management is a module of Oracle Field Service.
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2. Click the Logistics tab.

The Repair Order has two transaction lines, one with Action Type Move In, the 
other with Action Type Move Out.

The Move In transaction processes the transfer of the defective item from the 
Spares Management location into a depot for repair. 

The Move In transaction is a two-stage process:

a. First, the item is shipped from Spares Management.

b. Then, the item is received into a depot subinventory.

The Move Out transaction is a single-stage process - the item is shipped from 
the depot after it has been repaired.

3. Process the two-stage transfer of the item into a depot.

For more information, see Section 4.17, "Receive an Item for an Internal Order 
Refurbishment" on page 4-66.

4. Perform any required repairs on the item.

For more information, see Section 4.19, "Manage the Repair Process" on 
page 4-76.

5. Process the shipping of the item back to the Spares Management location after 
repair.

For more information, see Section 4.27, "Ship a Refurbished Item" on page 4-108.

6. If appropriate, close the Repair Order.

For more information, see Section 4.31, "Close a Repair Order" on page 4-120.

Note: Because refurbishment Repair Orders are processed as 
internal orders, the Repair Estimate tab, the Repair Actuals tab, and 
the Tools > Coverage option are disabled. 

Note: The Move In and Move Out transactions make use of 
existing Internal Order and Internal Requisition functionality. From 
the depot’s perspective, defective items are shipped via the Internal 
Requisition, and usable or repaired items are shipped via the 
Internal Order. 
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7. If appropriate, close the Service Request.

For more information, see Section 4.32, "Close a Service Request" on page 4-121.
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4
Managing Depot Business Processes

Oracle Depot Repair improves the efficiency of the service depot repair process.

Many different users can be involved in the overall service depot process. These 
users and roles include the call center agent, service technician, shop floor 
technician, shop floor accountant, shop floor production manager, warehouse 
administrator, shipping administrator, receiving administrator, service 
administrator, accounts receivable manager, purchasing manager, HR manager, and 
depot manager.

For example, the call center agent logs the Service Request, the service technician 
diagnoses the broken part, the shop floor technician fixes the item, the shop floor 
accountant keeps track of the repair costs, the shop floor production manager 
schedules the repair jobs, and the depot manager has the overall repair process 
responsibility. Depending on the service organization, a user can have multiple 
roles. For example, the service technician can log the Service Request, and diagnose 
the broken part.

This chapter describes task-based procedures for different processes that a user can 
perform to fulfill responsibilities.

Topics in this chapter include:

� Section 4.1, "View Customer Profile" on page 4-3

� Section 4.2, "View Coverage Information" on page 4-4

� Section 4.3, "View Service History" on page 4-6

� Section 4.4, "Determine Contract and Price List Defaults at Repair Order 
Creation" on page 4-8

� Section 4.5, "Create a Customer Contact" on page 4-9

� Section 4.6, "Create a Service Request" on page 4-12
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� Section 4.7, "Find a Customer for an Install Base Item" on page 4-15

� Section 4.8, "Create a Repair Order in the Depot Repair Workbench" on 
page 4-17

� Section 4.9, "Create and Book a Return Line Manually" on page 4-25

� Section 4.10, "Find Service Requests and Repair Orders" on page 4-29

� Section 4.11, "Create and Maintain Notes" on page 4-31

� Section 4.12, "Use the Diagnostics Tab and Oracle Knowledge Management" on 
page 4-33

� Section 4.13, "Estimate Repair Charges" on page 4-50

� Section 4.14, "Receive a General Item" on page 4-61

� Section 4.15, "Ship Additional Items" on page 4-65

� Section 4.16, "Auto-Receive an Item" on page 4-65

� Section 4.17, "Receive an Item for an Internal Order Refurbishment" on 
page 4-66

� Section 4.18, "Split a Repair Order" on page 4-73

� Section 4.19, "Manage the Repair Process" on page 4-76

� Section 4.20, "Create and Process WIP Repair Jobs" on page 4-76

� Section 4.21, "Create and Process Repair Tasks" on page 4-88

� Section 4.22, "View Activities Related to a Repair Order" on page 4-98

� Section 4.23, "Update Repair Orders Concurrently" on page 4-100

� Section 4.24, "Workflow-Based Messaging" on page 4-101

� Section 4.25, "Create a Ship Line Manually" on page 4-102

� Section 4.26, "Ship a General Item" on page 4-104

� Section 4.27, "Ship a Refurbished Item" on page 4-108

� Section 4.28, "Record Billing Data in Repair Actuals" on page 4-111

� Section 4.29, "Book Repair Actuals" on page 4-118

� Section 4.30, "Invoice a Customer" on page 4-119

� Section 4.31, "Close a Repair Order" on page 4-120

� Section 4.32, "Close a Service Request" on page 4-121
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� Section 4.33, "Create and Process an Internal Party Refurbishment" on 
page 4-122

� Section 4.34, "View Repair Orders in Oracle iSupport" on page 4-123

4.1 View Customer Profile
The customer profile summarizes customer information. A system administrator 
usually sets up the profile entries that appear in the customer profile, which contain 
a set of previously defined verifications. You can configure these verifications, as 
well as the actual range values and value definitions. The verification results appear 
by using the Customer Profile Engine, which is a concurrent program.

The customer profile information appears in the Profile window when you select 
Profile from the Tools menu in the Depot Repair Workbench. Click Refresh in the 
Profile region to view the latest profile information for the customer. This Oracle 
Depot Repair functionality lets service agents verify a customer’s profile 
information, including Open Orders, Booked Orders, Cancelled Orders, Open 
Service Requests, Escalated Service Requests, Active Contracts, Expired Contracts, 
Cancelled Contracts, Open Repair Orders.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
Repair Order records associated with the customer must exist in the database.

Navigation
Depot Repair > Repair Orders > (Find Repair Orders window) New

Steps
1. In the Depot Repair Workbench, select the customer whose profile you want to 

view.

2. Select Profile from the Tools menu. 

The Profile window opens.
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3. Double-click a key indicator in the profile window. 

Oracle Depot Repair shows a summary list of that profile verification. For 
example, double-clicking Open Service Request (a key indicator) displays the 
list showing all open Service Requests for the selected customer type.

This list displays information such as the Service Request Number, incident 
date, problem code and resolution code.

4. Double-click any line in the summary list. 

Oracle Depot Repair displays the appropriate window containing details of the 
selected line.

4.2 View Coverage Information
Items that a warranty or service contract covers and that link to Install Base, 
populate the coverage fields with a list of all entitlements or all active entitlements 
(based on option selection) that apply to the selected Repair Order.
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Oracle Depot Repair permits the service agent to select a contract coverage that can 
be applied to the Sales Order charge lines that Charges created. The selected 
Contract Number automatically defaults on each charge line that is generated from 
the WIP Summary Report only. This option excludes those charge lines that relate to 
any new item upgrades and enhancements. The agent can verify active warranties 
existing for the item. Also, the contract selected as default in the Coverage window 
cannot be applied to charge lines in the Debrief Report. Instead, the contract 
selected at the Service Request level applies by default to the Debrief charge lines.

Oracle Depot Repair also permits the agent to find all contracts including those that 
have already expired. This is a handy tool for service agents to advise customers on 
contract coverage expiry, and service contract renewal offers to reinstate their 
coverage.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You can view coverage information only for an Install Base item referenced on a 
Repair Order.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order referencing the item for which you want to view 

coverage information.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. From the top menu, select Tools > Coverage.
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The Coverage window displays the configuration and entitlements for the 
Install Base item referenced on the Repair Order.

Based on option selection, you can automatically query all contracts or all active 
contracts applicable to the Repair Order. By selecting the Default check box 
beside a contract, you apply this as the default contract to the Repair Order. For 
detailed field descriptions, see Section 2.12.1, "Coverage Window" on page 2-39.

If you select a contract that does not specify a Price List, the application defaults 
the Price List that is set for the default Price List profile option. This happens if 
the Price List currency is the same as the Repair Order currency. If the Price List 
currency is not the same as that of the Repair Order, or if the profile option is 
not set, you can select any Price List from the list.

4.3 View Service History
Service agents can view all the Service Requests and Repair Orders that were 
logged against a service item. The item must be serialized and linked to an Install 
Base Instance value in order for this functionality to work. This valuable 
functionality permits the service provider to review the service history and repair 
records that were recorded over the lifetime of the Install Base item, and is 
especially useful when attempting to troubleshoot and diagnose repair patterns and 
service trends that affect the item.

The following procedures describe how to view a item’s service history. 

Module
Oracle Applications Navigator
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Responsibility
Depot Repair Super User

Prerequisites
You can view the service history of only an Install Base item. Repair Order records 
must exist for the item.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order corresponding to the item, the service history of 

which you want to view.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. From the top menu, select Data >Service History. 

The Service History window lists all the Service Requests and Repair Orders 
previously opened against the Install Base item on a Repair Order.

For detailed field descriptions, see Section 2.13.1, "Service History Window" on 
page 2-40.
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4.4 Determine Contract and Price List Defaults at Repair Order Creation
A service contract has entitlements, for example, discounts, and response time. 
Entitlements are specified for each business process setup for the contract. There are 
cases where a contract can have entitlements that are specified for the Business 
Process of the Service Request, but not for the Depot Repair Business Process. If that 
is the case, Oracle Depot Repair cannot use that contract.

The rest of this section describes how the default contract and Price List are 
evaluated when you create a new Repair Order.

Default Contract
� If there is a contract in the Service Request, it becomes the default contract only 

if the contract is valid for the Business Process associated with the Oracle Depot 
Repair Repair Type in the Repair Order.

� If the contract in the Service Request is not valid for the Business Process 
associated with the Oracle Depot Repair Repair Type or if there is no contract in 
the Service Request, the "best" contract calculated by response time becomes the 
default contract.

Default Price List
1. With Contract

� If there is a contract, get the Business Process Price List of the contract for the 
Repair Type in the Repair Order and derive the currency. 
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� If the contract does not have a Business Process Price List for the Repair Type, 
get the contract (selling) Price List and derive the currency. If there is no Price 
List, then get the default from the profile option CSD: Default Price List.

� If the profile option CSD: Default Price List is not set, get the Repair Type Price 
List and derive the currency.

� If Repair Type Price List is not set, neither the currency nor the Price List is set. 

2. Without Contract

� If no contract is set, get the default Price List from the profile option CSD: 
Default Price List and derive the currency.

� If the profile option CSD: Default Price List is not set, get the Price List from the 
Repair Type setup and derive the currency.

� If the Repair Type Price List is not set, neither the currency nor the Price List is 
set.

4.5 Create a Customer Contact
You can create a new contact for a customer in the Depot Repair Workbench, and 
use this contact while creating your new Service Request.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
The customer whose new contact is being created must have an existing record in 
the database.

Navigation
Depot Repair > Repair Orders

Steps
1. In the Find Repair Orders window, click New to display the Repair Orders 

window.
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The Repair Orders window serves as the Depot Repair Workbench. From the 
Depot Repair Workbench, you can perform all depot processes, end-to-end.

2. In the Depot Repair Workbench, in the Service Request Information area, click 
New Contact. 

The New Customer window opens.

3. In the New Customer window, select the Customer Type: Person or 
Organization. 

Customer Type refers to the type of the contact, and indicates whether or not 
the contact is a person or an organization.

When you select the Person Customer Type, the following fields appear:

� Title: Indicates the contact’s title, such as Miss, Mr., Mrs., and Dr. 

� First, Last, Middle, Suffix: Indicate the First, Last and Middle names of the 
contact, and Suffixes in the name.

� Phone: Indicates the contact’s phone number. You can look up area codes in 
the list of values.
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� Type: Refers to the phone type, such as Work, Home, Cell, or General. Select 
from the list of values.

� Relation: Specifies the contact’s relationship with the customer, such as 
Associate of, Child of, and Benefactor of. Select from the list of values.

� Party: Refers to the name of the customer. Select from the list of values.

� Email: Enter the contact’s e-mail address.

� Create Account: Check box, when selected, creates an account for the new 
contact in your database.

� Bill-to: Refers to the address to which you should send the contact’s bill.

When you have entered the Country in the Address field, the Address 
window appears where you can select the Context Value to choose the 
contact’s Address style, such as North European, Japanese, or South 
American. After you select the Context Value, the Address window 
provides you with fields appropriate to the address style you have chosen. 
Enter the address, and click OK.

� Ship-to: Refers to the address to which you should ship an item for the 
contact.

� Primary: Check boxes that indicate whether the Bill-to and Ship-to 
addresses are the contact’s primary addresses.

If you select the Customer Type Organization, the Title, First, Last, Middle, 
and Suffix fields are replaced with the Organization name field. All the 
other fields remain the same with the exception of an additional field for 
the organization’s URL or Web address.

4. In the New Customer window, click OK. 

A note appears informing you that a Party Number and an Account Number (if 
you selected the Create Account check box) have been created and saved for the 
new contact.

5. In the note, click OK. 

The application returns you to the Depot Repair Workbench.
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4.6 Create a Service Request
Service Requests initiate the actions required to solve a customer problem. A Service 
Request is mandatory for any repair process, and needs to be created before any 
Repair Order can be created in the Oracle Depot Repair module.

On the Depot Repair Workbench, you can log a customer request for assistance. The 
application lets you create Service Requests without having to leave the Depot 
Repair Workbench.

Generally, as you create a Service Request, you know which customer to associate 
with the Service Request. There may be situations where you are only provided 
with identifiers for Install Base items, and the customer information is not provided. 
In this case, you can use an Oracle Depot Repair feature to find and select the 
customer associated with the item.

You can search for existing Service Requests and Repair Orders from the Find 
Repair Orders window.

For more information, see Section 4.10, "Find Service Requests and Repair Orders" 
on page 4-29.

Module
Oracle Applications Navigator

Note: You do not have to create the Service Request explicitly 
before creating the Repair Order. You can enter details for both the 
Service Request and the Repair Order, and create both at the same 
time.

Note: You cannot create a Service Request without a value in the 
Item field if the profile CSD: Require Item For Service Request has 
been set to Yes during implementation. Setting this profile option to 
No lets you create a Service Request without entering a value in the 
Item field. Also, when the profile option is set to No, you can 
specify an Install Base item without specifying an Instance value in 
the Service Request. 
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Responsibility
Depot Repair Super User

Prerequisites
The customer and contact records must exist in the database. Service Requests can 
be logged only for items recorded in inventory.

Navigation
Depot Repair > Repair Orders

Steps
1. In the Find Repair Orders window, click New. 

The Depot Repair Workbench opens. 

In the Service Request Information area in the Depot Repair Workbench, the 
Contact Type, Customer Type, and Opened Date fields default to Relation, 
Organization, and the Current Date respectively.

The Severity and Status fields default to the value of the profile options Service: 
Default Service Request Severity and Service: Default Service Request Status 
respectively.

2. If you need to discover the customer for the Install Base item that will be the 
subject of the Service Request, perform the operations in 

3. Section 4.7, "Find a Customer for an Install Base Item" on page 4-15.

If you select a customer using these operations, the customer-related and the 
item-related fields in the Service Request Information area are automatically 
filled in. The fields can be changed before you save the Service Request.

4. Choose the Contact Type and Customer Type from the lists of values, and use 
lists of values to select the Contact, Customer, Request Type (such as Customer 
Call, Depot Repair, Field Service), Severity, and Status fields. 

You can also enter the date and time in the Opened field.

Note: Contact information is not mandatory for creating a Service 
Request. Selecting a blank contact type in the Contact Type field 
disables all Contact information fields.
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The Bill-To and Ship-To address fields are populated automatically when the 
Customer and Contact Names are entered. The addresses always default to the 
primary Bill-To and Ship-To addresses of the customer. Even if you select a 
primary address for the Install Base instance, the Bill-To and Ship-To address 
fields default only to the primary address of the customer party. Also, the list of 
values for both fields contains addresses for related parties, which can be for 
either persons or for organizations.

For more information, see Section 2.3, "The Service Request Information Area" 
on page 2-5.

5. To validate the item against the Install Base, select the Installed Items Only 
check box.

6. Select the Item that the customer is reporting as defective from the Item list of 
values.

If the item is serialized, the Serial Number appears. After validation, the 
Instance field is automatically populated. For a given customer, the call center 
agent can view all the items in the customer Install Base.

For more information about entering the Item, Instance and Serial Number 
fields, see Section 2.3.3, "Item Information Fields" on page 2-6.

7. Select the name of the person responsible for overseeing the Service Request in 
the Owner field from the list of values.

8. Enter a brief summary of the repair issue in the Summary text field.
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9. Click the Save icon on the toolbar to create the Service Request record. 

The application populates the Request field in the Service Request Information 
area with the Service Request Number. When you click any of the fields in the 
Repair Order Information area, the application populates the Item, Item 
Description, UOM, and Quantity fields from the Service Request Information 
area.

4.7 Find a Customer for an Install Base Item
Sometimes, when you are creating a Service Request, you may know the Item 
Number, or its Serial Number, or its Install Base Instance value, but the customer 
name is unknown or simply not provided.

In these circumstances, you can provide the item information, and search for the 
customers that have the item in their Install Base.
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After you select one of the customers for the item, all the customer-related and 
item-related fields appear in the Service Request Information area of the Depot 
Repair Workbench.

This procedure is only available when you are creating a new Service Request in the 
Depot Repair Workbench.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must be in the process of creating a Service Request.

The items provided as search parameters must be Install Base trackable or serialized 
items.

Navigation
Depot Repair > Repair Orders > New

Steps
1. In the Depot Repair Workbench, from the top menu, select Tools > Find 

Customer.

The Find Customer window opens.

2. Select one or more of the following fields as search parameters:

� Item

� Instance

� Serial Num

� Revision

3. Click Find.

The Results area shows the customers that have the item in their Install Base.

4. Highlight the customer whose data you want to have on the Service Request, 
and click OK.
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5. The Find Customer window closes, and the fields related to the customer and 
the item appear in the Service Request Information area of the Depot Repair 
Workbench.

4.8 Create a Repair Order in the Depot Repair Workbench
The depot business process starts with a Repair Order. Creation of Repair Orders 
occurs only against Service Requests for serviceable items. 

You can create a Repair Order and its associated Service Request directly in the 
Depot Repair Workbench, which automates part of the process. Alternatively, you 
can start the process of creating a Repair Order in another Oracle application. For 
more information, see"Alternative Ways of Creating Repair Orders" on page 4-23.

For repair items that are under revision control, a correct Revision Number is 
mandatory. If your Repair Order Item is serialized, and the quantity to repair is 
greater than 1, you will have specify each of the Serial Numbers of the item to be 
repaired, for Install Base trackable items.

Oracle Depot Repair also lets you add items to a customer’s Install Base from the 
Depot Repair Workbench. This enables the depot to process (Install Base trackable) 
repair items that the customer purchased from outside the service organization. If 
you try to create a Repair Order line without specifying an Instance value for an 
Install Base trackable item, the application will prompt you to add a new item 
instance to the Install Base. This lets you process the repair.

Each Repair Order must have a Repair Type. When you create a Repair Order in 
Oracle Depot Repair, then, depending on the Repair Type, the application 
automatically creates one or more RMA and Sales Order lines. The RMA and Sales 
Order lines appear in the Logistics tab, with action types of Repair and Ship 
respectively. If you choose the Standard Repair Type, no charge lines are created 
automatically; you must create them manually.

You can also choose to create RMA charge lines manually. If you want to create the 
RMA charge line manually, first you must clear the check box Automatically Enter 
and Book RMA, during the creation of the Repair Order. Afterwards, you can create 
the RMA charge line, as described inSection 4.9, "Create and Book a Return Line 
Manually" on page 4-25.

The following procedures describe how to create a Repair Order in the Depot 
Repair Workbench.
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Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
A Service Request record must exist for the broken item in order to create a Repair 
Order for its repair.

Navigation
Depot Repair > Repair Orders

Steps

1. From the Find Repair Orders window, retrieve the pertinent Service Request.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant Service Request, and click OK. 

The Depot Repair Workbench shows the Service Request information.

3. In the Repair Order Information area in the Depot Repair Workbench, confirm 
the information appearing in the table, or enter the appropriate information for 
the defective item.

4. Select the Repair Type from the list of values. 

For more information on Repair Types, see Section 1.2.3, "Repair Type 
Processing" on page 1-4. For descriptions of fields on the Details tab, see 
Section 2.5, "Details Tab" on page 2-9.

Note: You can also proceed to creating a Repair Order 
immediately after creating a Service Request record, without 
having to navigate to the Find Repair Orders window. In this case, 
start at step 3.
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After a charge line is created, you cannot change the currency of the Repair 
Order in the Details tab or select another default contract that has a Price List 
with a different currency. To change the currency of a Repair Order, all the 
charge lines have to be deleted.

5. Optionally, enter the quantity of items to be repaired in the Qty field.

The default quantity is 1. If you specify a Qty that is greater than 1 for a 
serialized item, then you will need to capture the Serial Numbers separately, 
after the Repair Order is created. For details, see step 13.

6. In the Details tab, optonally enter the Promise Date (date and time) for repair 
completion after negotiation with the customer.

7. Optionally, select the name of the person responsible for overseeing the repair 
in the Repair Owner field from the list of values.

8. If you require estimates to be approved before you can proceed with the repair 
of an item, then select the check box Estimate Approval Required, else uncheck 
this check box.

9. If you want the RMA line to be automatically entered and booked when you 
create the Repair Order, then select the check box Automatically Enter and Book 
RMA, else uncheck this check box.

10. Click Save to create the Repair Order.

11. If you have tried to create a Repair Order line without specifying an Instance 
value for an Install Base trackable item, or without specifying a Serial Number 
for a serialized item with a Qty of 1, a message window appears.

In the message window, you can either click Add to IB to add an item instance 
to the Install Base, or you can click Save As Is to create the Repair Order 
without adding to the Install Base.

Note: A Repair Order supports a single currency. Different 
currencies are supported for different Repair Orders within a 
Service Request. The default currency is based on the default 
contract. If no default contract is selected, the default Price List 
determines the currency. If neither defaults are set, the currency 
selection is based on the manually selected Price List in the Details 
tab.
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After the Repair Order is created, the application populates the Repair Number 
fields both in the Details tab, and in the Repair Order Information area, with the 
Repair Order Number.

12. For the case where the Repair Order Item is serialized, and the quantity of the 
item Repair Order Item is greater than 1, continue at step 13.

For all other cases, continue at step 18.

Capture Serial Numbers

13. If your Repair Order contains a serialized item, and the quantity is greater than 
1, when you click Save, a message window appears, which instructs you as 
follows:

Note: If you select Save As Is, the Repair Order is created, but no 
charge lines are created automatically. You will have to create all 
the required charge lines for your Repair Type manually in the 
Logistics tab.
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� The Repair Order created will be a draft Repair Order, that is, its Repair 
Status will be Draft.

� You must enter the Serial Numbers using the Capture Serial Numbers 
option from the Tools Menu.

14. To complete the processing for repairing many individual serialized items, click 
OK in the message window, then, from the top menu, select the options Tools > 
Capture Serial Numbers.

In the Serial Numbers window that appears, your main functions are to select a 
Serial Number for each individual item instance, and to process the Serial 
Numbers. Processing the Serial Numbers creates a separate Repair Order for 
each item instance.

15. Select a Serial Number from the Serial Number list of values for the customer 
account.

You can specify a Serial Number that does not exist yet. In this case, a message 
appears asking if you wish to create the new Serial Number.

16. You can optionally select the check box Add to Order within Service Request. 

If you select this option, then, when the Serial Numbers are processed, each 
RMA line will be added to the same Order Number. 

17. After you have specified the Serial Numbers, click one of the following buttons:

�  Save: This saves the Serial Numbers, but does not process the values into 
separate Repair Orders for each Serial Number.

� Process: This creates a separate Repair Order for each Serial Number, each 
with a status of Open.

� Close: This closes the window without saving or processing the Serial 
Numbers.

Note: For serialized, non-Install Base trackable items, if you enter fewer Serial 
Numbers than the Qty on the Repair Order, Oracle Depot Repair creates as 
many Repair Orders as the Qty number of units. For example, if Qty is 10, and 
you enter 8 Serial Numbers, you get 8 Repair Orders with Serial Numbers 
provided, and 2 without Serial Numbers. You will need to provide the 2 
missing Serial Numbers at time of receipt.

For serialized, Install Base trackable items, if you enter fewer Serial Numbers 
than the Qty on the Repair Order, Oracle Depot Repair creates only as many 
Repair Orders as the number of Serial Numbers you entered. For example, if 
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Qty is 10, and you enter 8 Serial Numbers, you get 8 Repair Orders with Serial 
Numbers provided.

Checking the Logistics Tab

18. Click the Logistics tab.

While not technically part of the creation process, after you have created the 
Repair Order, you should check the Logistics tab to determine the next process 
to perform.

Depending on your choice of Repair Type and whether you set the check box 
Automatically Enter and Book RMA, the Logistics tab generally contains one or 
more Return and Ship lines, each of which has a Status.

19. In certain cases, there are no charge lines in the Logistics tab, such as when one 
of the following has occurred:

� The Repair Type is Standard.

� For a serialized repair item, you selected Save As Is in the Create IB 
Instance window (see step 11).

You must create and book the required charge lines manually.

See Section 4.9, "Create and Book a Return Line Manually" on page 4-25 and 
Section 4.25, "Create a Ship Line Manually" on page 4-102.

20. If your Repair Type involves the return of a defective item, then, in order to 
receive the defective item into inventory, the following conditions must apply:

� There must be a Return line in the Logistics tab.

� The Status of the Return line must be Booked.

To fulfill these conditions, except for the special case where you created the 
Repair Order after creating an order in Oracle Order Management, proceed to 
create and book the Return line, as required.

See Section 4.9, "Create and Book a Return Line Manually" on page 4-25.

Comments
1. After creating the Repair Order record, you can attach additional information to 

the Service Request or Repair Order by clicking the Notes button in the Details 
tab.

For more information, see Section 4.11, "Create and Maintain Notes" on 
page 4-31.
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2. After creating the Repair Order record, you can also search from the Diagnostics 
tab for possible solutions to the problem affecting the repair item. 

In the Diagnostics tab, by selecting Service Codes, either manually or as a result 
of a search performed in Oracle Knowledge Management, you can get the 
information ready to automatically create estimate lines and default Bills and 
Routings for WIP Repair Jobs.

For more information, see Section 4.12, "Use the Diagnostics Tab and Oracle 
Knowledge Management" on page 4-33.

Alternative Ways of Creating Repair Orders
In addition to the method of creating a Repair Order and its associated Service 
Request in the Depot Repair Workbench, which enables you to automatically create 
charge lines associated with the Repair Type, there are two other ways by which 
you can create a Repair Order, as follows:

� Section 4.8.1, "Create a Repair Order Starting From Oracle TeleService" on 
page 4-23

� Section 4.8.2, "Create a Repair Order Starting From Oracle Order Management" 
on page 4-24

4.8.1 Create a Repair Order Starting From Oracle TeleService
The depot agent can view activities performed against a Service Request that was 
initiated in the call center and transferred to the depot for resolution. You can link 
RMAs and Sales Orders generated through the call center to Repair Orders created 
within the Depot Repair Workbench.

This procedure shows an example of creating a Repair Order, where an existing 
Service Request already has RMA and Sales Order lines.

1. Create a Service Request in Oracle TeleService, with a Service Request Type of 
Depot Repair.

2. In the Charges tab of the Service Request, create one or more charge lines with 
typical Depot Repair activities for the items that require repair processing.

A RMA charge line, for example, could include the following values:

� Charge Line Type = Actual

� Business Process = Depot Repair

� Service Activity = Return for Repair
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A Sales order line, for example, could include the following values:

� Charge Line Type = Actual

� Business Process = Depot Repair

� Service Activity = Ship Returned Item

3. Submit the lines for processing.

4. In the Navigator, using the Depot Repair Super User responsibility, navigate the 
path Depot Repair > Repair Orders.

5. In the Find Repair Orders window, enter the Service Request Number you 
created in step 1, and click Find.

6. When the record appears in the Results area, click OK.

A message window informs you that RMA/Sales Order lines not linked to a 
Repair Order were found, and asks if you want to create a Repair Order or 
associate the RMA/sales lines.

7. When you click OK, the Create Repair Order window appears, containing the 
not-yet-linked RMA lines. 

8. Select the lines that you want to become Return (RMA) lines in the Repair 
Order, and click OK.

If there are submitted Sales Order lines in the Service Request, the Link Sales 
Order window appears, containing the not-yet-linked Sales Order lines.

9. Select the lines that you want to become Ship lines in the Repair Order, and 
click OK.

The Repair Order appears in the Depot Repair Workbench, with a Standard 
Repair Type. The Return and Ship lines appear in the Logistics tab, each with 
the Status of Submitted. 

4.8.2 Create a Repair Order Starting From Oracle Order Management
This procedure shows an example of creating a Repair Order, which starts with the 
creation of an order in Oracle Order Management, and includes the operation of 
receiving the repair item into inventory.

1. In Oracle Order Management (if you use the Depot Repair Super User 
responsibility, navigate the path: Order Management > Orders, Returns > Sales 
Orders), create a Sales Order, with the following values:
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Order Information tab:

� Order Type = Mixed

Line Items tab, Main sub-tab:

� Specify the item to be repaired in Ordered Item

� Qty = -1

Line Items tab, Returns sub-tab:

� Specify the Return Reason

Line Items tab, Shipping sub-tab:

� Specify the Warehouse

2. When the order status is Booked, note the Order Number.

3. In Oracle Purchasing (if you use the Depot Repair Super User responsibility, 
navigate the path: Purchasing > Receiving > Receipts), in the Find Expected 
Receipts window, click the Customer tab, and search for the receipt whose RMA 
Number you noted in step 2.

4. In the Receipts window, select Inventory for the Destination Type, select the 
Subinventory.

5. If required, specify the Serial Number or Serial Number range of the item to be 
received.

6. Submit a request to run the program Create SR/RO from OM RMA Lines; 
specify the Organization and Subinventory parameters.

7. When this program finishes, the Repair Order has been created, with a Standard 
Repair Type.

Because the item to be repaired has already been received, the Logistics tab 
contains neither Return nor Ship lines.

8. From the top menu, select Data > Activity, to find summary information in the 
Activity window about the receiving of the item.

4.9 Create and Book a Return Line Manually
 

Terminology: In this section, the terms RMA, RMA line, and 
Return line are used interchangeably.
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When creating a Repair Order, then, for Repair Types that require RMA creation, the 
application automatically generates the Return line based on Repair Type setup. If 
you choose or have to create an RMA manually, then, in the Details tab, clear the 
Automatically Enter and Book RMA check box, before saving the Repair Order.

The main objective of creating and booking an RMA is to create an order in Oracle 
Order Management. When the RMA is fully interfaced with Oracle Order 
Management, an Order Number is associated with the RMA, and appears in the 
Return line.

The following procedures explain how you can create and book an RMA manually, 
after you have created the Repair Order. If the RMA has already been created, you 
can just book the RMA.

For background information on RMA creation, see Section 4.8, "Create a Repair 
Order in the Depot Repair Workbench" on page 4-17.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must have created a Repair Order.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to create or book the RMA.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. Select the Logistics tab in the Depot Repair Workbench.
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If a Return line already exists for the defective item to be returned, but the 
Status is not Booked, then continue at step 10.

Creating a Return Line

4. If you need to create a Return line, click the Action Type field in the next blank 
line, and select Return. 

5. Select the fields for the Return line. 

The main fields that you must select are Action Code, Service Activity, Price 
List, and Return Reason. For serialized items, you must select the Source Serial 
Number.

Item-related fields default to the Repair Order Item. You may edit these as 
required.

Note also the Add to Order field. Oracle Depot Repair lets you place all Return 
(RMA) and Ship lines on the same order.

By default, all Return (RMA) and Ship lines appear on the next-highest Order 
Number created when the lines are transferred to Order Management.

You can also select the specific order for the Return (RMA) or Ship line by 
selecting the Order Number in the Add to Order field before interfacing the 
specified line to Oracle Order Management.

For descriptions of the fields, see Section 2.6, "Logistics Tab" on page 2-11.

If you want to process the Return line directly to the Booked stage, continue at 
step 10.

6. Select the Process Trans check box for the Return line.

7. Select the Automate order processing steps through check box.

8. Select the Enter Order button option.

9. Click Process.

Acknowledge the message in any message window that appears.

The Status of the Return line changes to Entered or Submitted.

Booking a Return Line

10. Select the Process Trans check box for the Return line.

11. Select the Automate order processing steps through check box.

12. Select Book Order radio button option.
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13. Click Process.

Acknowledge the message in any message window that appears.

The Status of the Return line changes to Booked.

Comments
1. During the processing of the Return line, when the Return line is fully 

interfaced with Oracle Order Management, the Order Num field is populated 
with the system-generated RMA Order Number. 

If you have not selected the No Charge check box, the application returns the 
item price to the Price field based on Price List selected.

2. To delete a Return or Ship line, select the Return or Ship line on the Logistics 
tab, and click the Delete icon on the toolbar.
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4.10 Find Service Requests and Repair Orders
On the Find Repair Orders window, you can retrieve Service Requests or Repair 
Orders from the database.

A search in Oracle Depot Repair lets you retrieve Service Requests and Repair 
Orders based on parameters related to a Service Request or Repair Order (Number, 
Customer, Item, or Date Opened). You can use a combination of these parameters to 
restrict your search so as to retrieve only the Service Requests or Repair Orders you 
want.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
The Service Request or Repair Order record that you want to retrieve must exist in 
the database.

Navigation
Depot Repair > Repair Orders

Steps
1. In the Find Repair Orders window, specify the parameters based on whether 

you want to search for the Service Request or Repair Order.

2. The search parameters in the Service Request area include: 

� Request Number

� Status

Note: The Delete icon on the toolbar remains enabled as long as 
the Return or Ship line has not been fully interfaced with Order 
Management. After the order is fully interfaced to Order 
Management, the application disables the Delete icon, and you 
cannot delete the order line.
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� Customer Name

� Customer Account

� Date Opened

� Item

� Serial Number

The search parameters in the Repair Order area include: 

� Repair Number

� RMA / Sales Order Number

� Internal Order Number

� Internal Requisition Number

� Date Opened

� Item

� Serial Number

3. Click Find to find matching Service Requests or Repair Orders based on the 
parameters you have specified.

4. The Results region in the Find Repair Orders window displays the search 
results. 

You can select any of the retrieved Service Requests or Repair Orders, and click 
OK to view its details in the Repair Orders window, generally known as the 
Depot Repair Workbench.
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4.11 Create and Maintain Notes
Notes are used to record and manage the comments that the depot agents and 
technicians generated against various services. Notes in a Service Request help in 
recording the descriptive information about customer repair issues, any progress 
that the agent had done in resolving this issue, and so on. You can enter either 
Service Request or Repair Order notes from the Details tab in the Depot Repair 
Workbench.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User
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Prerequisites
A Repair Order record must exist for an item before you can attach notes to the 
relevant Service Request or Repair Order.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Service Request or Repair Order to which you want to attach a 

note. 

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. In the Results area of the Find Repair Orders window, select the relevant result, 
and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. On the Details tab of the Repair Order window, select Service Request or Depot 
Repair in the Notes area.

4. To open the Notes window, click Notes.

5. In the Type field, select a note type.

6. In the Status field, select a note status.

The choices are: Personal, Internal, and Publish. If you use the Personal status, 
this note would not be viewable to any customer in a customer facing 
application. Employees at the depot can view Internal notes. All employees and 
customers can view Publish notes. You can create additional Status codes. For 
more information, see the Oracle Common Application Components Implementation 
Guide.

7. In the Note field, enter a brief description of the note.

8. To enter more notes, click the More button.

The Detailed Note window opens and holds textual notes up to 32K characters. 

9. After entering notes, click OK.

10. In the main Notes window, to specify more details for the note, specify the 
Related To and Value fields.
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11. Save the note. 

The note appears in the table under the Notes tab on the left. The Summary tab 
displays the notes as text in a chronological or reverse chronological manner. 
You can change the chronological view by clicking the Latest First check box.

12. To search for existing notes, use the Find Notes functionality.

a. Open the Notes main window.

b. Click the flashlight icon on the toolbar to open the Find Notes window. 

c. Enter the fields such as Source, Entered By, and so on.

d. Click Search to display the results.

4.12 Use the Diagnostics Tab and Oracle Knowledge Management
The main purpose of the Diagnostics tab is to enable you to make use of solutions to 
previous problems stored in Oracle Knowledge Management. Oracle Knowledge 
Management is a repository of solution sets that have already been contributed. 
Solutions to previous incidents can guide users to resolve current problems at hand.

However, even if you have not installed Oracle Knowledge Management, you can 
still use the Diagnostics tab to select Service Codes, which enable you to 
automatically create estimate lines and default Bills and Routings for WIP Repair 
Jobs.

This section consists of the following topics:

� Diagnostic Codes and Service Codes

� Using Diagnostic Codes and Service Codes with Oracle Knowledge 
Management

� Using Service Codes in the Repair Order

� Diagnostics Tab Usage Overview

Diagnostic Codes and Service Codes
Depot repairs are generally repetitive in nature and the number of problems and 
resolutions is finite. As such, Oracle Depot Repair provides the ability to associate 
the potential problems with a Diagnostic Code, and to associate the potential 
resolutions with a Service Code. By utilizing Diagnostic Codes and Service Codes, 
users can quickly document repair efforts for customer charges and depot service 
history.
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An example Diagnostic Code is DC100, whose descriptive Name is Engine Oil Light 
On, and a corresponding example Service Code is SC100, with descriptive Name 
Engine Oil Change.

For details of setting up Diagnostic Codes and Service Codes, see the Oracle Depot 
Repair Implementation Guide.

Using Diagnostic Codes and Service Codes with Oracle Knowledge 
Management
The association of Diagnostic Codes to Service Codes is done in Oracle Knowledge 
Management via Solutions. First, during implementation, Service Codes are linked 
to Oracle Knowledge Management Solutions as external objects. Then, during the 
authoring of Solutions in Oracle Knowledge Management, Diagnostic Codes (for 
example, DC100) are included in the title or body of the Solution.

Once a Diagnostic Code is associated to a Service Code and that Service Code is 
linked to an Oracle Knowledge Management Solution, then the repair work to be 
performed has been defined.

For details of associating Diagnostic Codes and Service Codes with Oracle 
Knowledge Management, see the Oracle Depot Repair Implementation Guide.

Using Service Codes in the Repair Order
Oracle Depot Repair enables you to automate Repair Order processing as follows:

� In WIP repair mode, Oracle Depot Repair provides the ability to pre-define 
work using Bills and Routings and any associated material, labor and expense 
charges. The user can retrieve the defined work using Service Codes. The 
Service Code association with Bills and Routings can be used to create material, 
labor and expense estimate lines as well as default routes to WIP Repair Jobs.

� In Task repair mode, Oracle Depot Repair provides the ability to pre-define 
work using Task Templates and Task Parts and any associated material, labor 
and expense charges. The user can retrieve the defined work using Service 
Codes. The Service Code association with Task Templates and Task Parts can be 
used to create material, labor and expense estimate lines.

For details of how Service Codes are used in the Repair Order, see the following:

� Section 4.13.1, "Create a Repair Estimate" on page 4-52.

� Section 4.20.1, "Create a WIP Repair Job for a Single Repair Order" on page 4-77.
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Diagnostics Tab Usage Overview
The interface from Oracle Depot Repair to Oracle Knowledge Management is the 
Diagnostics tab, which is divided into three areas:

� Diagnostic Codes

� Solutions

� Service Codes

Figure 4–1 shows an overview of the standard use of the different areas of the 
Diagnostics tab.
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Figure 4–1 Overview of Standard Diagnostics Tab Usage

4.12.1 Manage Diagnostic Codes in the Diagnostics Tab

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User
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Prerequisites
You must have set up Diagnostic codes and Service Codes in Oracle Depot Repair.

You must have associated the Diagnostic Codes and Service Codes to Solutions in 
Oracle Knowledge Management.

For details of setting up and associating Diagnostic Codes and Service Codes, see 
the Oracle Depot Repair Implementation Guide.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order that you want to process. 

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. If you do not want to provide any Diagnostic Codes as parameters to the search 
in Oracle Knowledge Management, continue at step 7.

4. Enter a Diagnostic Code manually or select a Diagnostic Code from the list of 
values.

The list shows all Diagnostic Codes that have been associated with either the 
Item or the Item Category of the Repair Order Item.

For more information on setting up Diagnostic Codes, see the Oracle Depot 
Repair Implementation Guide.

5. Click the Select check box.

6. Repeat steps 4 to 5 for as many Diagnostic Codes as you want to display.

Note: If you enter an invalid Diagnostic Code, the list of values 
appears, which contains all the valid Diagnostic Codes for your 
Repair Order.
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7. Click Search Solutions.

This launches two windows:

� A Refresh linked Solutions box, with the message: Please press OK after 
searching for Solutions.

� An Oracle Knowledge Management window.

The window that is launched in Oracle Knowledge Management depends on 
the value of the profile option Knowledge: Search to display for integrating 
applications. 

If the value of this profile option is Unified Search, then the window that is 
launched is a Simple Search window; if the value of the profile option is 
Advanced Search, then the window that is launched is the Advanced Solution 
Search Results window.

Continue the search process at the section Searching Oracle Knowledge 
Management.

4.12.2 Search Oracle Knowledge Management
The search in Oracle Knowledge Management is the second stage of the completely 
integrated process which starts in the Diagnostics tab. This section concentrates on 
the Oracle Knowledge Management search itself, and how it provides feedback 
back into the Diagnostics tab.

This procedure follows immediately after you have clicked the Search Solutions 
button in the Diagnostics tab.

Use of the Search Parameters in Oracle Knowledge Management
The parameters passed to Oracle Knowledge Management to search for solutions 
are the following:

� All selected Diagnostic Codes

Note: You may click the Select All or Deselect All as appropriate 
any time before you click Search Solutions.

Only the Diagnostic Codes that are explicitly selected are 
forwarded as search parameters to the Oracle Knowledge 
Management search.
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� Problem Summary

� Repair Order Item

The search for solutions is performed as follows:

� The Diagnostic Codes and Problem Summary are used as search keywords in 
the title and body of the Solutions.

� The Repair Order Item are used to match the specified item with the Related 
Items as set up in the Solutions.

By utilizing the profile option Knowledge: Search results include weighting from 
Product, Platform and Category filters, you can narrow or widen your search 
results.

When the profile option is set to No, the search results contain only Solutions 
matching the specified Product/Platform/Category.

When the profile option is set to Yes, the results can also contain Solutions that do 
not match the Product/Platform/Category specified -- the Solutions that do match 
the Product/Platform/Category are given a boost in the scoring algorithm.

For additional information on how to use Oracle Knowledge Management, please 
refer to the Oracle Knowledge Management User Guide.

Search Result Examples 
Consider the following search parameters:

� Selected Diagnostic Codes = DC01, DC02.

� Problem Summary = Mouse Malfunction.

� Repair Order Item = ITM342.

With the profile option Knowledge: Search results include weighting from Product, 
Platform and category filters set to No, you get the following results:

� All Solutions whose title or body contains DC01, DC02, Mouse, or Malfunction, 
and whose Related Items include ITM342.

Note:  Oracle Depot Repair does not make use of platform and 
category filters in Oracle Knowledge Management.



Use the Diagnostics Tab and Oracle Knowledge Management

4-40 Oracle Depot Repair User Guide

With the profile option Knowledge: Search results include weighting from Product, 
Platform and category filters set to Yes, you get both of the following sets of results, 
with the first set having a higher score:

� All Solutions whose title or body contains DC01, DC02, Mouse, or Malfunction, 
and whose Related Items include ITM342.

� All Solutions whose title or body contains DC01, DC02, Mouse, or Malfunction.

Prerequisites
You must have started the search process by clicking the Search Solutions button in 
the Diagnostics tab.

For details, see Section 4.12.1, "Manage Diagnostic Codes in the Diagnostics Tab" on 
page 4-36.



Use the Diagnostics Tab and Oracle Knowledge Management

Managing Depot Business Processes 4-41

Figure 4–2 Overview of Main Oracle Knowledge Management Search Procedure 

Steps
1. You can optionally add and edit search parameters in the Oracle Knowledge 

Management search window, and then perform an explicit search.

The net objective of the Oracle Knowledge Management search is to specify 
whether a solution is useful or potentially useful for the current repair problem. 
To do this, you must first select a solution in a "search results" window, then 
access the solution details for that solution. 



Use the Diagnostics Tab and Oracle Knowledge Management

4-42 Oracle Depot Repair User Guide

2. If you are in the Simple Search window, click the Title hyperlink of the 
potentially useful solution in the Simple Search Result area. If you are in the 
Solution Advanced Search Results window, click the radio button beside the 
potentially useful solution, and click Full Solution.

In the Solution Details window, there is a section available for you to decide the 
usefulness of the solution. This section is the Feedback section, whose main 
constituent is the question "Is the solution useful in resolving your question or 
problem?"

3. In the Solution details window, scroll down to, and just beyond, the External 
Objects area.

4. If the Feedback section appears, then, you can optionally respond to the 
question "Is the solution useful in resolving your question or problem?", by 
clicking Yes, Maybe, or No.

If you choose one of these options, a confirmation message appears, indicating 
that your feedback was recorded.

5. You may optionally continue in Oracle Knowledge Management, and select 
more Solutions for feedback to Oracle Depot Repair.

6. When you have finished in Oracle Knowledge Management, close the Oracle 
Knowledge Management window.

7. Click OK in the Refresh linked Solutions box.

If you have linked any Solutions from Oracle Knowledge Management to a 
Repair Order, they appear in the Solutions area of the Diagnostics tab. 
Additionally, Service Codes appear in the Service Codes area of the Diagnostics 
tab (if any exist).

Providing Feedback into the Solutions Area of the Diagnostics Tab
In step 4, your response to the question "Is the solution useful in resolving your 
question or problem?" causes the following to occur in the Solutions area of the 
Diagnostics tab:

Note: The Feedback section only appears if the solution has not 
already been linked to the current Repair Order. However, after a 
user explicitly selects an answer to the usefulness question, then the 
next time the Solution Details window appears for that solution, the 
Feedback section does not appear.
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� If you answered Yes, then the solution appears with a Status of Useful.

� If you answered Maybe, the solution appears with a Status of Possibly useful.

� If you answered No, and if the value of the profile option Knowledge: Action 
for Negative Feedback Solution is Link Solution as Not Solved, the solution 
appears with a Status of Not useful.

Providing Feedback into the Service Codes Area of the Diagnostics Tab
If the Useful Solutions returned to the Solutions area have any Service Codes 
associated with them, then those Service Codes will appear in the Service Codes 
area, together with their associated Solution Number and with their Applicable 
check box set.

4.12.3 Manage Solutions in the Diagnostics Tab
The main use of the Solutions area is to change the status of Solutions returned from 
Oracle Knowledge Management searches, in order to influence the Service Code 
information in the Service Codes area.

When you change the Status of a Solution in the Solutions area to Useful, any 
Service Codes associated with that Solution in Oracle Knowledge Management 
appear in the Service Codes area, and are initially marked as Applicable.

Under the following conditions:

� The profile option CSD: Use Tasks from Knowledge Base Solutions is set to Yes

� The Solution in the Solutions area is marked as Useful 
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� The corresponding Solution in Oracle Knowledge Management has one or more 
Task Templates among its Related Objects 

you can retrieve the associated Task Template charge lines into the Repair Estimate 
tab by clicking Add Lines from Diagnostics.

For more details, see Section 4.13.1, "Create a Repair Estimate" on page 4-52.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must have previously performed an Oracle Knowledge Management search for 
the Repair Order, and returned one or more Solutions into the Solutions area (see 
Section 4.12.2, "Search Oracle Knowledge Management" on page 4-38.)

Navigation
Depot Repair > Repair Orders

Steps
1. If you have not already accessed the Repair Order, retrieve the Repair Order 

that you want to process. 

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. Click the right-hand side of the Status field of a solution whose status you want 
to change.

4. Select a different status from the list of values.

This enables the Update Status button.

Note: From the Solutions area, you may also return to Oracle 
Knowledge Management to view the solution details, by clicking 
the Details button.
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5. Click Update Status.

If, in steps 3 and 4, you changed the Status to Useful, existing Service Codes 
associated with the solution will appear in the Service Code area with the 
Applicable check box set on.

Continue at step 6.

6. If, in steps 3 and 4, you "downgraded" the Status from Useful to Possibly useful 
or Not useful, then an Update Solution Status message box appears, presenting 
the following information:

� Service Codes associated with the solution in the Service Codes area will be 
marked as not applicable.

� You may delete the Service Code in the Service Codes area manually.

Click OK in the Update Solution Status message box.

This unsets the Applicable check box for the associated Service Code in the 
Service Codes area.

For details of deleting Service Codes in the Service Codes area, see 
Section 4.12.7, "Delete Service Codes in the Service Codes Area" on page 4-49.

7. Optionally, repeat steps 3 through 6 for each solution whose status you want to 
change.

4.12.4 Manage Service Codes in the Diagnostics Tab
The topics in this section include the following:

� Section 4.12.5, "Select Service Codes Manually in the Service Codes Area" on 
page 4-45

� Section 4.12.6, "Activate and Deactivate Service Codes in the Service Codes 
Area" on page 4-47

� Section 4.12.7, "Delete Service Codes in the Service Codes Area" on page 4-49

4.12.5 Select Service Codes Manually in the Service Codes Area

As part of Oracle Depot Repair implementation, when Service Codes are set up, 

Note: You cannot delete any Solutions from the Solutions area, 
you can only change the status values of the Solutions.
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they are associated with Items, Categories, a combination of Bills and Routings, and 
Task Template Groups.

The main usage of the Service Codes area in the Diagnostics tab is to enable the 
associated elements of the Service Codes to be added to the estimate lines and WIP 
Repair Jobs of the current Repair Order.

The Service Codes area is populated with Service Codes in one or more of the 
following ways:

� Automatically by Useful Solutions (see Section 4.12.2, "Search Oracle 
Knowledge Management" on page 4-38).

� Manually, by selecting Service Codes from the lists of values in the Service 
Codes area - in this case, there is no associated Solution Number.

This section deals with the manual selection of Service Codes in the Service Codes 
area.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must have set up Service Codes in Oracle Depot Repair.

To make use of prior repair knowledge, you must have associated Service Codes to 
Solutions in Oracle Knowledge Management.

For details of setting up and associating Diagnostic Codes and Service Codes, see 
the Oracle Depot Repair Implementation Guide.

Navigation
Depot Repair > Repair Orders

Steps
1. If you have not already accessed the Repair Order, retrieve the Repair Order 

that you want to process. 
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For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. Select a Service Code from the Service Code list of values in the Service Codes 
area.

This list of values that appears shows all the Service Codes that have been 
associated with either the repair Item or the Inventory Category of the repair 
item.

For more information on setting up Service Codes, see the Oracle Depot Repair 
Implementation Guide. 

4. In the Code field, either enter a Service Code, or select a Service Code from the 
list of values.

By default, as each valid Service Code is entered or selected, its Applicable 
check box is set. 

Manually entered Service Codes do not have a Solution Number.

5. Repeat steps 3 to 4 for as many Service Codes as you want to display.

6. Save your changes.

4.12.6 Activate and Deactivate Service Codes in the Service Codes Area
You activate Service Codes in the Service Codes area by marking them as 
applicable.

Activating Service Codes in the Service Codes area enables the following 
subsequent processing options:

� In the Repair Estimate tab, after you have created a repair estimate header, you 
can add lines from the Diagnostics tab associated with the activated Service 
Codes in the Service Codes area. 

Note: If you enter an invalid Service Code, the list of values 
appears, which contains all the valid Service Codes for your Repair 
Order.



Use the Diagnostics Tab and Oracle Knowledge Management

4-48 Oracle Depot Repair User Guide

Charge lines can be added in for WIP mode repairs (if Bills and Routings are 
associated with the Service Codes) and for Task mode repairs (if Task Template 
Groups are associated with the Service Codes).

� In the Repair Jobs tab, you can create a WIP Repair Job with the Bills and 
Routings associated with the activated Service Codes in the Service Codes area.

For more information on setting up Service Codes, see the Oracle Depot Repair 
Implementation Guide. 

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must have previously performed one or more of the following operations for 
the Repair Order:

� Searched Oracle Knowledge Management, and returned one or more Service 
Codes into the Service Codes area (see Section 4.12.2, "Search Oracle Knowledge 
Management" on page 4-38 and Section 4.12.3, "Manage Solutions in the 
Diagnostics Tab" on page 4-43).

� Selected one or more Service Codes manually (see Section 4.12.5, "Select Service 
Codes Manually in the Service Codes Area" on page 4-45).

Navigation
Depot Repair > Repair Orders

Steps
1. If you have not already accessed the Repair Order, retrieve the Repair Order 

that you want to process. 

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. In the Service Codes area, check the Applicable check box for each Service Code 
that you want to activate.
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4. In the Service Codes area, uncheck the Applicable check box for each Service 
Code that you want to deactivate.

5. Save your changes.

4.12.7 Delete Service Codes in the Service Codes Area
You may delete Service Codes from the Service Codes area, whether they are 
marked as applicable or not.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must have previously performed one or more of the following operations for 
the Repair Order:

� Searched Oracle Knowledge Management, and returned one or more Service 
Codes into the Service Codes area (see Section 4.12.2, "Search Oracle Knowledge 
Management" on page 4-38 and Section 4.12.3, "Manage Solutions in the 
Diagnostics Tab" on page 4-43).

� Selected one or more Service Codes manually (see Section 4.12.5, "Select Service 
Codes Manually in the Service Codes Area" on page 4-45).

Navigation
Depot Repair > Repair Orders

Steps
1. If you have not already accessed the Repair Order, retrieve the Repair Order 

that you want to process. 

Note: After the first time that you use Service Codes in a Repair 
Order in either the creation of a repair estimate or the creation of a 
WIP Repair Job, then the selected Service Codes are protected 
against deletion in that Repair Order.
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For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. If you are not already in the Diagnostics tab, click the Diagnostics tab.

3. In the Service Codes area, click the marker field to the left of the Service Code 
that you want to delete. 

4. From the top menu, select Edit > Delete.

5. Optionally, repeat steps 2 through 3 for each Service Code that you want to 
delete.

6. Save your changes.

Comments
If you wish to reinstate Service Codes that you have deleted, then perform one of 
the following operations:

� Change the status of any associated solution in the Solutions area to Useful, as 
described in Section 4.12.3, "Manage Solutions in the Diagnostics Tab" on 
page 4-43. 

� Select and activate Service Codes manually, as described in Section 4.12.5, 
"Select Service Codes Manually in the Service Codes Area" on page 4-45).

4.13 Estimate Repair Charges
Depots can require a repair diagnosis of the customer's returned item in order to 
accurately determine the cost involved in the actual repair, upgrade, or overhaul. 
The depot technician typically performs this by inspecting or performing a 
teardown of the item to determine the required parts and labor for the repair. After 
completing this process, the depot provides a formal quotation to the customer for 
approval before any work is scheduled. During the teardown, the technician can 
identify individual parts, and diagnose for further service requirements using 
typical repair manuals and technical notes for aid.

Note: If you have set up the application to not use the Estimate 
functionality, by setting the profile option CSD: Enable Estimates to 
No, the Repair Estimate tab in the Depot Repair Workbench is not 
available and you cannot create a repair estimate. For more 
information, see the note in Section 2.8, "Repair Estimate Tab" on 
page 2-21.
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Items for Estimates
Items for estimates must be defined in the organization specified by the profile 
option Service: Inventory Validation Organization.

Pricing and Currency
To charge for repair services, a service provider can use standard pricing method 
using Price Lists to determine the fixed repair price. Variable pricing method can 
also be used, which permits the depot to charge the customer for the actual 
material, labor, and other expenses incurred during the repair. When exchanging or 
replacing items, a service provider typically calculates the price of the exchange as 
60% of the new item price, and possession of the customer’s broken item.

In Oracle Depot Repair, a Repair Order supports a single currency. The default 
currency is based on the default contract. If no default contract is selected, the 
default Price List determines the currency. If neither defaults are set, the currency 
selection is based on the Price List manually selected in the Details tab. After a 
charge line is created, you cannot change the currency of the Repair Order in the 
Details tab, or select another default contract that has a Price List of a different 
currency. To change the currency of a Repair Order, all the charge lines, including 
the Logistics lines, have to be deleted.

The Repair Order currency drives the list of Price Lists that you can use for estimate 
charge lines. You cannot select a Price List with a currency that is different from the 
Repair Order currency.

Estimate Lines from Diagnostics
If you have Service Codes marked as applicable in the Diagnostics tab, and these 
Service Codes are associated with Bills, Routings, and Task Template Groups, then 
you can copy the following into the Repair Estimate tab:

� Charge lines associated with the Bills and Routings for WIP mode repairs.

� Charge lines associated with Task Template Groups for Task mode repairs.

When you add in lines for WIP mode repairs through Service Codes, then, typically:

� Bill of Material items are added as Material lines.

� Resources associated to the Operations for BOM Routing are added as Labor 
lines.

When you add in lines for Task mode repairs through Service Codes, then, typically:

� Items specified in Task Parts in Spares Management are added as Material lines.
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� Planned Effort elements for a Task Template are added as Labor lines.

Estimate Cost Analysis
While preparing an estimate, you can also perform estimate cost analysis. Estimate 
cost analysis lets you compare your estimated margins and profitability based on 
estimated costs and estimated charges. The only supported costing method is 
standard costing. The estimate cost analysis is always an aggregate of all estimated 
costs and charges for the Repair Order.

Materials, labor, and expenses comprise the totals for charges or costs. Taxes and 
other fees are not included in cost analysis.

Costing of items differs in WIP and Task mode.

� In WIP mode, Item Cost is used for material, labor, and expense charges; 
however, if a Resource Cost exists, it is used for the Labor charge.

� In Task mode, Item Cost is used for material, labor, and expense charges; 
Resource Cost is not used.

To enable estimate cost analysis, the following conditions must apply:

� The profile option CSD: Enable Costing must be set to Yes.

� Each material, labor, and expense item must have an item cost defined in Oracle 
Inventory.

Estimate Approval
On the Details tab for a Repair Order, you can check or uncheck the Estimate 
Approval Required field. If the check box is set, you must get customer approval for 
the estimate, and record this as a status change in the repair estimate. 

The topics in this section include the following:

� Section 4.13.1, "Create a Repair Estimate" on page 4-52

� Section 4.13.2, "Revise a Repair Estimate" on page 4-58

� Section 4.13.3, "Obtain Customer Approval for a Repair Estimate" on page 4-59

4.13.1 Create a Repair Estimate
The following procedures describe how to prepare a repair charges estimate for the 
customer.
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Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to creating the 
estimate. For more information, see Chapter 3, "Oracle Depot Repair Business 
Scenarios".

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to estimate charges. 

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant record from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. Select the Repair Estimate tab in the Depot Repair Workbench.

4. Optionally enter the Status, Date, Lead Time, and UOM field values. 

For field descriptions, see Section 2.8, "Repair Estimate Tab" on page 2-21.

5. Click Save Estimate to save the estimate header record.

6. You can enter estimate details in one or more of the following ways:

� Manually, by entering individual charge line details in the multi-record 
table area.

For field descriptions, see Section 2.8, "Repair Estimate Tab" on page 2-21.

� If you have previously selected and activated Service Codes in the 
Diagnostics tab, then you can click Add Lines from Diagnostics.
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This adds the charge lines associated with the active Service Codes in the 
Diagnostics tab, that is, the Service Codes marked as applicable.

You can also add Task Template charge lines associated with Solutions if the 
following conditions are true:

a. The profile option CSD: Use Tasks from Knowledge Base Solutions is set to 
Yes.

b. At least one Solution in the Solutions area of the Diagnostics tab is marked 
as Useful, and the corresponding Solution in Oracle Knowledge 
Management has one or more Task Templates among its Related Objects. 

When these conditions are true and you click Add Lines from Diagnostics, 
you retrieve the associated Task Template charge lines into the Repair 
Estimate tab.

After you have clicked Add Lines from Diagnostics, the added lines appear 
in the Repair Estimate tab, and an information window appears which 
records any errors and information about the lines added.

If the lines that you expect to be added do not appear, you should check a 
variety of factors associated with your Repair Order and the data that you 
are trying to add in. See "Checks for Adding Estimate Lines from 
Diagnostics" on page 4-56.

For more information, see Section 4.12.6, "Activate and Deactivate Service 
Codes in the Service Codes Area" on page 4-47.

7. After entering a charge line, click Save Estimate to record the charge line. 

The application populates the Unit Price and Est Charge fields in the table. The 
Summary of Estimated Charges region is also populated. This region is updated 
as you add (or delete) charge lines.

8. Optionally, click Costs to see an estimate cost analysis.

Note: After you have added the lines associated with the active 
Service Codes, the Service Code rows from which you derived the 
estimate lines are disabled in the Service Codes area of the 
Diagnostics tab.
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9. The Estimated Costs versus Estimated Charges window opens and shows the 
estimated Cost, the estimated Charge, the estimated Profit (Charge less Cost), 
and the estimated Profit Margin% by separate Material, Labor, Expense, and 
Total lines.

Click Close to exit the Estimated Costs versus Estimated Charges window.

10. Click Line Details to display the Estimate Charge Details window. 

Enter the detailed charge line values in the table fields. 

For field descriptions, see the topic About Estimate Charge Line Details 
Window.

11. To allow provisioning for overriding the entered charges later, select the 
Override Charges check box.

This is enabled if the profile option CSD: Allow Charge Override for Estimates 
is set to Yes. 

The Override Charges check box lets you override repair charges, in the 
Estimated Charge field, after you have saved it. Discounts associated with the 
contract are not applied if you manually change the Estimated Charge.
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12. Click Save to record the changes.

13. Click Close to close the Estimate Charge Details window, and return to the 
Repair Estimate tab. 

The Totals fields in the lower part of the Repair Estimate tab show charge line 
totals.

14. To delete a charge line, select the relevant charge line on the Repair Estimate 
tab, and click the Delete icon on the toolbar.

Comments
1. You cannot add or delete charge lines in the Estimate Charge Details worksheet. 

You can add or delete charge lines only in the Repair Estimate tab.

2. If you have added estimate lines derived from a Service Code, using Add Lines 
from Diagnostics, then you cannot add the lines again from the same Service 
Code.

Checks for Adding Estimate Lines from Diagnostics
You should ensure that the following conditions are true before you add lines from 
the Diagnostics tab. Failure to satisfy all the conditions results in rows not being 
imported as estimate lines.

(A) General Checks
The following checks apply to all lines:

� You must have at least one active Service Code, that is, a Service Code marked 
as applicable, associated to the Repair Order.
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� The default Price List must be defined and active.

� The Billing Type for the item must be defined.

(B) WIP-Specific Checks
The following checks apply to WIP lines:

� The Service Code must be associated with at least one work entity (bill or 
routing), and each associated work entity must be defined for the organization 
specified by the profile option Service: Inventory Validation Organization.

� Each work entity must have a Bill of Material.

� Each operation sequence must have a Resource.

� Each Resource must have a billing Item.

(C) Task-Specific Checks
The following checks apply to task lines derived through Service Codes and, under 
profile control, directly from Task Templates related to Oracle Knowledge 
Management Solutions.

� Each work entity must have a Task Template Group.

� Each Task Template Group must have a Task Template.

� You must have a product part defined for the Task Templates and the Repair 
Order Item.

� For a task parts definition, you should have a manual or a rollup quantity or 
both.

� If there is a substitute defined for a task part, the task part is not added as an 
estimate line.

� For labor lines only, for Planned Effort, you must have provided a value for the 
profile option CSD: Default Labor Item for Estimate Line from Tasks.

� For labor lines, the Planned Effort Interval and UOM for the Task Template 
must not be null.

Note: You cannot add an estimate line from the same Service 
Code entry on the Diagnostics tab twice.
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(D) Tasks-from-Solutions Checks
In addition to the Task-Specific checks, the following additional checks apply to task 
lines derived directly from Oracle Knowledge Management Solutions:

� The profile option CSD: Use Tasks from Knowledge Base Solutions must be set 
to Yes.

� The Solution in the Solutions area of the Diagnostics tab must have a Status of 
Useful.

� The corresponding Solution in Oracle Knowledge Management must have an 
active Task Template among its Related Objects.

4.13.2 Revise a Repair Estimate
Certain repairs can require service providers to revise repair estimates many times. 
The service agent should verify existing warranties or contracts while quoting and 
revising estimates.

The following procedures describe how to revise the estimated charges for an item 
under repair.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
A repair charges estimate must exist for the broken item.

Note: If you manually override the Estimated Charge, which you 
are allowed to do if the profile option CSD: Allow Charge Override 
for Estimates is set to Yes, then discounts associated with the 
contract are not applied.

Net Discount will always be the Extended Price minus the 
Estimated Charge, not the contract discount.
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Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to revise the estimate.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant record from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. Select the Repair Estimate tab in the Depot Repair Workbench. 

The existing charge lines appear in the multi-record area.

4. Click Line Details. 

The Estimate Charge Line Details window opens.

5. Make the necessary changes to the charge line field values.

For more information, see Section 4.13, "Estimate Repair Charges" on page 4-50.

6. Click Save to record the revised charges.

7. Click Close to close the Estimate Charge Line Details window and return to the 
Repair Estimate tab. 

The charge lines and totals on the Repair Estimate tab reflect the revision made 
to the estimate.

8. To change the repair estimate status, choose an appropriate value from the list 
of values in the Status field.

9. Click Save Estimate to record the changes.

4.13.3 Obtain Customer Approval for a Repair Estimate
If estimate approval is required for a repair estimate, then, after creating the repair 
charges estimate, the service agent seeks the customer’s approval of the estimate.

Upon customer’s approval, the depot receives the defective parts in repair 
subinventory. If the customer rejects the estimate, the Repair Order can be closed, or 
put on hold as appropriate.
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Repair Order estimates can be New, Drafted, Bid, Accepted, Rejected, or Cancelled. 
These statuses indicate whether to start a repair process. Typically, a repair estimate 
must be approved prior to the start of the WIP Repair Job.

The following procedures describe how to record customer approval for a repair 
estimate.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
A Repair Order record with an approved estimate must exist. Also, you must have 
revised the original estimate as appropriate.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order that you want to revise.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant record from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

The Details tab of the Depot Repair Workbench displays the total charges for 
the repair in the Charges area.

3. Make changes to the original estimate charge lines as required. 

For detailed instructions, see Section 4.13.2, "Revise a Repair Estimate" on 
page 4-58.

4. Discuss the revised charges with the customer.

5. In the Repair Estimate tab, update the estimate Status to Estimate Accepted or 
Estimate Rejected.
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6. Click the Save icon on the toolbar to save the updated status. 

The Repair Order is revised with the new charges and customer approval 
information.

7. On the Details tab, create or consult notes as required.

For detailed instructions, see Section 4.11, "Create and Maintain Notes" on 
page 4-31.

8. Click Update RO Status to display the Update Status window. 

In the Update Status window, you can update the Repair Order status 
depending on customer acceptance or rejection of the estimate. The Repair 
Order status can be Open, on Hold, or Closed.

9. Optionally, from the top menu, click Tools > Freeze Estimate to freeze the 
estimate.

After the estimate is frozen, you cannot change the estimate.

4.14 Receive a General Item
The term "general item" indicates an item that is not being refurbished.

Depot technicians can receive hand carried (walk-in) items for repair, or receive 
serviceable items against RMAs. Oracle Depot Repair provides flexible options 
when receiving and shipping items from and to customers and vendors.

Inspection
You can also inspect items during the receiving process, which allows for more 
accurate repair estimates as a result of inspection. Inspection of items is possible 
only if the routing on the RMA order is either Standard Receipt or Inspection 
Required.

The procedure for receiving an item with inspection is more extensive than the 
procedure for receiving an item without inspection

The following is an overview of the procedure for receiving an item without 
inspection:

� Receive the item on the RMA order into a subinventory.

The following is an overview of the procedure for receiving an item with inspection:

� Receive the item on the RMA order into a receiving location.
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� Inspect the item, then accept or reject it.

� Move the item into a subinventory.

The following procedures describe how to receive a general item (except for internal 
order refurbishment items - for details of those procedures, see Section 4.17, 
"Receive an Item for an Internal Order Refurbishment" on page 4-66.)

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to receiving the 
general item. For more information, see Chapter 3, "Oracle Depot Repair Business 
Scenarios".

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to receive the general item.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. Select the Logistics tab in the Depot Repair Workbench. 

If the RMA (Return) line was not created and booked automatically for the 
Repair Order, then create an RMA order manually.

For detailed instructions, see Section 4.9, "Create and Book a Return Line 
Manually" on page 4-25.

4. Click Receive to open the Find Expected Receipts window.
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5. In the Customer tab in the Find Expected Receipts window, enter the RMA 
Number, and click Find.

If the RMA is found, the application displays the Receipt Header and Receipts 
windows.

6. Confirm the Received By field of the Receipt Header window, that is, the person 
receiving the RMA.

7. Confirm the Receipt Date, and click the Save icon on the toolbar to obtain the 
system-generated Receipt Number.

8. Close the Receipt Header window.

If you want to receive an item without inspection, continue at step 9.

If you want to receive an item with inspection, continue at step 16.

Receiving an Item Without Inspection

Note: For Direct Delivery Routings, you must receive an item without 
inspection. Inspection is optional if your routing is Standard Delivery or 
Inspection Required.

However, for Inspection Required Routings, Oracle recommends that you 
perform the steps starting at step 16.

9. In the Receipts window, in the Lines tab, select the check box located beside the 
Qty field to confirm quantity.

10. For the Destination Type, select Inventory.

11. Scroll the horizontal bar to reveal the Subinventory field, and select a 
Subinventory location in this field from the list of values.

If the general item is a serialized item, the Lot-Serial button on the Receipts 
window is enabled.

a. Click Lot-Serial to display the Serial Number window.

b. Enter the received Serial Number, and click OK. 

You can manually enter a Serial Number even if the number does not 
appear in the list of values

12. Click the Save icon on the toolbar.

13. Close the Receipts window to return to the Depot Repair Workbench.

14. In the Logistics tab, click Update Logistics.
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The status of the RMA (Return) line changes to Received.

15. Optionally, you can see item reception details in the Activity window. From the 
top menu, select Data > Activity to open up the Activity window.

This completes the procedures for receiving an item without inspection.

Receiving an Item With Inspection

Note: For Inspection Required Routings, Oracle recommends that you perform 
the inspection steps that follow.

16. In the Receipts window, in the Lines tab, select the check box located beside the 
Qty field to confirm quantity.

17. For the Destination Type, select Receiving.

18. Select a Location.

19. Click the Save icon on the toolbar.

20. Close the Receipts window.

21. Back in the Logistics tab of the Depot Repair Workbench, click Inspect/Move.

22. In the Customer tab in the Find Receiving Transactions window, enter the RMA 
Number, and click Find.

The Receiving Transactions window appears.

23. If there is more than one line, select the lien you want to inspect.

24.  Click Inspect.

25. In the Inspection Details window, select the Status (values are either Accept or 
Reject).

26. Click OK.

This closes the Inspection Details window.

The Destination Type of the item shows as Inspect.

27. Click the Save icon on the toolbar.

28. Close the Receipt Transactions window.

29. Back in the Logistics tab of the Depot Repair Workbench, click Inspect/Move.

30. In the Customer tab in the Find Receiving Transactions window, enter the RMA 
Number, and click Find.
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The Receiving Transactions window appears, with the Destination Type of the 
item showing as Inventory.

31. Scroll the horizontal bar to reveal the Subinventory field, and select a 
Subinventory location in this field from the list of values.

32. If the general item is a serialized item, the Lot-Serial button on the Receiving 
Transactions window is enabled.

a. Click Lot-Serial to display the Serial Number window.

b. Enter the received Serial Number, and click OK. 

You can manually enter a Serial Number even if the number does not 
appear in the list of values

33. Click the Save icon on the toolbar.

34. Close the Receiving Transactions window to return to the Depot Repair 
Workbench.

35. In the Logistics tab, click Update Logistics.

The status of the RMA (Return) line changes to Received.

36. Optionally, you can see item reception details in the Activity window. From the 
top menu, select Data > Activity to open up the Activity window.

This completes the procedures for receiving an item with inspection.

4.15 Ship Additional Items
On the Logistics tab, Oracle Depot Repair verifies that the item quantity on the 
Repair Order matches the RMA quantity on Logistics tab. This implies that it is not 
possible to ship additional items or quantities of items against the same Repair 
Order. To ship additional items or quantities of items, you must create a new Repair 
Order with the additional item or quantity.

4.16 Auto-Receive an Item
When you receive an item into a subinventory, you generally have to perform a 
number of operations in several different windows (for example, find a receipt, edit 
one or more receipt fields). 
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Under certain conditions, you can receive an item directly from the Logistics tab, 
without having to navigate through extra windows. The operation of receiving an 
item directly from the Logistics tab is called auto-receive.

The conditions under which you can auto-receive an item are as follows:

� The item must be serialized.

� The Locator Control for the item must be No Control.

� The quantity on the RMA (Return) line is 1.

� The Receipt Routing must not be Inspection Required.

� You must enter the Source Serial Num and Subinv fields on the RMA (Return) 
line.

When all these conditions apply, and you click the Receive button on the Logistics 
tab, an alert message appears that informs you that the item is eligible for 
auto-receive.

If you accept the option to auto-receive the item, the auto-receive operation is 
performed.

4.17 Receive an Item for an Internal Order Refurbishment
When a Repair Order has been created in the Planner’s Desktop of Spares 
Management, or an equivalent external agency, and the item or items are to be sent 
to an Oracle Depot Repair depot for processing, this type of repair is called an 
internal order refurbishment.

If you do not select a subinventory for the item, the subinventory is derived from 
the picking rule defined in the profile option CSD: Default Pick Release Rule for 
Sales Orders.

Note: After the successful completion of the auto-receive 
operation, the Status of the RMA (Return) line is Booked. After you 
click Update Logistics, the Status changes to Received.

Note: This is not the same as an internal party refurbishment, 
where the items to be refurbished belong to an internal party. For 
more information, see Section 4.33, "Create and Process an Internal 
Party Refurbishment" on page 4-122.



Receive an Item for an Internal Order Refurbishment

Managing Depot Business Processes 4-67

In Oracle Depot Repair, the Repair Order for each item or item instance to be 
refurbished contains two transactions, with action types Move In and Move Out. 
This section describes the Move In transaction.

The Move In transaction has two components:

a. First, the shipment stage, where the item is shipped from a source 
organization, such as Spares Management.

b. Then, the receiving stage, where the item is received into a depot 
subinventory.

In the shipment stage, if you do not select a subinventory for the item, the 
subinventory is derived from the picking rule defined in the profile option CSD: 
Default Pick Release Rule for Sales Orders.

The shipment stage includes a Pick Release process, and then either a manual Ship 
process or an automatic Ship Confirm process. When both Pick Release and Ship 
Confirm processes can be performed automatically, that is, without any manual 
Serial Number entry required, you can select whether to perform both processes 
separately one after the other, or in sequence automatically. 

Inspection
During the receiving stage, you can also inspect the items to be refurbished, which 
allows for more accurate repair estimates as a result of inspection. Inspection of 
items is possible only if the routing on the requisition order is either Standard 
Receipt or Inspection Required.

The procedure for receiving an item with inspection is more extensive than the 
procedure for receiving an item without inspection.

The following is an overview of the procedure for receiving an item without 
inspection:

� Receive the item on the requisition order into a subinventory.

The following is an overview of the procedure for receiving an item with inspection:

� Receive the item on the requisition order into a receiving location.

� Inspect the item, then accept or reject it.

� Move the item into a subinventory.

Module
Oracle Applications Navigator
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Responsibility
Depot Repair Super User

Prerequisites
The Service Request and the associated refurbishment Repair Order or orders must 
have been created in the Planner’s Desktop of the Spares Management module of 
Oracle Field Service.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to receive the item for 

refurbishment.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

3. Click the Logistics tab.

4. Click any field of the Move In line to make that line current.

The Status of the Move In line should be Booked.

Note: It is possible to create demand for refurbishment using a 
module other than Oracle Field Service and to pass this demand to 
Oracle Depot Repair.

The module must be able to create Internal Requisitions and 
associate them to Internal Sales Orders. However, Oracle 
recommends using the out-of-the-box integration to Oracle Field 
Service.
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Shipping the Item to be Refurbished from Spares Management

Pick Release

5. Click the Process Trans check box for the Move In line.

6. Click the Automate order processing steps through check box.

7. Select the Pick Release radio button.

8. Click Process.

The Status of the Move In line generally changes to Released.

However, for a serialized item that has Serial Control which is either Predefined 
or At Receipt, the resulting Status depends on whether you are performing the 
Pick Release processing for the first time or the second time. 

a. The first time, you must enter a Serial Number, navigating through the Find 
Move Order Lines window that appears automatically, to the Transact 
Move Orders window.

For details of the Find Move Order Lines window and the Transact Move 
Orders window, see the Oracle Inventory User’s Guide.

When you return from the Transact Move Orders window, the Status of the 
Move In line remains as Booked. 

b. The second time you perform the Pick Release process (steps 5 through 8), 
you do not have to enter any further data, and the Status changes to 
Released.

To see the Serial Number that you entered during the first-time Pick Release 
processing in the (Source) Serial Num field on the Logistics tab, click Update 
Logistics, after you complete the second-time Pick Release processing.

9. Optionally, from the top menu, select Data > Activity to see the details of the 
item shipment in the Activity window.

Note: The following description assumes that you select the 
automatic Pick Release option when processing the Move In line. 

Even if you select Ship Confirm as your first choice for processing 
the Move In line, the application automatically processes the Pick 
Release stage first, then the Ship Confirm stage.
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If there has been a mismatch between the Serial Number in the Move In line 
and the Serial Number you entered in the Transact Move Orders window, an 
alert message line appears in the Activity window, recording the two Serial 
Numbers. You must explicitly select Data > Activity to display the alert 
message.

This completes the Pick Release processing.

Manual Ship or Ship Confirm

10. For the case of a serialized refurbished item, whose Serial Control is At Sales 
Order Issue, the Ship Confirm button is disabled. In this situation, click Ship 
and enter the item’s Serial Number in Oracle Shipping Execution windows. For 
details of these windows, see the Oracle Shipping Execution User’s Guide.

When you return to the Logistics tab, click Update Logistics. The Status changes 
to Shipped.

This completes the manual ship processing for these special Move In lines.

Continue at step 16.

11. For all other cases, click the Process Trans check box for the Move In line.

12. Click the Automate order processing steps through check box.

13. Select the Ship Confirm radio button.

14. Click Process.

When processing the Ship Confirm stage, you should wait until the concurrent 
program Interface Trip Stop has completed successfully before you click Update 
Logistics, to see the changed value of the Status.

You can monitor the progress of the program by selecting Requests from the 
View menu on the toolbar, and selecting appropriate search criteria.

15. Click Update Logistics. 

The purpose of this is to update the Status on the Move In line, so that it reflects 
in Oracle Depot Repair the results of the procedures executed in other Oracle 
applications when you clicked Process.

After the background concurrent process Interface Trip Stop has completed 
successfully, the Status changes to Shipped.

Starting the Process of Receiving the Item to be Refurbished

16. Click any field of the Move In line to make that line current.
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17. Click Receive to open the Find Expected Receipts window.

18. In the Supplier and Internal tab in the Find Expected Receipts window, enter 
the Requisition from the Requisition Num of the Move In line, and click Find. 

If the requisition is found, the application displays the Receipt Header and 
Receipts windows.

19. Confirm the Received By field of the Receipt Header window, that is, the person 
receiving the requisition.

20. Confirm the Receipt Date, and click the Save icon on the toolbar to obtain the 
system-generated Receipt Number.

21. Close the Receipt Header window.

If you want to receive an item without inspection, continue at step 22.

If you want to receive an item with inspection, continue at step 29.

Receiving the Item to be Refurbished Without Inspection

22. In the Receipts window, in the Lines tab, select the check box located beside the 
Qty field to confirm quantity.

23. In the Destination Type field, select Inventory.

24. Scroll the horizontal bar to reveal the Subinventory field, and select a 
Subinventory location in this field from the list of values.

If the item is a serialized item, the Lot-Serial button on the Receipts window is 
enabled.

a. Click Lot-Serial to display the Serial Number window.

b. Enter the received Serial Number, and click OK. 

You can manually enter a serial number even if the number does not appear 
in the list of values.

25. Click the Save icon on the toolbar to save the receipt record.

26. Close the Receipts window to return to the Depot Repair Workbench.

27. Click Update Logistics.

The Status of the Move In line changes to Received.

28. Optionally, from the top menu, select Data > Activity to see the details of the 
reception of the item in the Activity window.

This completes the process of receiving an item without inspection.
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Receiving the Item to be Refurbished With Inspection

29. In the Receipts window, in the Lines tab, select the check box located beside the 
Qty field to confirm quantity.

30. For the Destination Type, select Receiving.

31. Select a Location.

32. Click the Save icon on the toolbar.

33. Close the Receipts window.

34. Back in the Logistics tab of the Depot Repair Workbench, click Inspect/Move.

35. In the Supplier and Internal tab in the Find Expected Receipts window, enter 
the Requisition from the Requisition Num of the Move In line, and click Find.

The Receiving Transactions window appears.

36.  Click Inspect.

37. In the Inspection Details window, select the Status (values are either Accept or 
Reject).

38. Click OK.

This closes the Inspection Details window.

The Destination Type of the item shows as Inspect.

39. Click the Save icon on the toolbar.

40. Close the Receipt Transactions window.

41. Back in the Logistics tab of the Depot Repair Workbench, click Inspect/Move.

42. In the Supplier and Internal tab in the Find Expected Receipts window, enter 
the Requisition from the Requisition Num of the Move In line, and click Find.

The Receiving Transactions window appears, with the Destination Type of the 
item showing as Inventory.

43. Scroll the horizontal bar to reveal the Subinventory field, and select a 
Subinventory location in this field from the list of values.

44. If the item is a serialized item, the Lot-Serial button on the Receiving 
Transactions window is enabled.

a. Click Lot-Serial to display the Serial Number window.

b. Enter the received Serial Number, and click OK. 
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You can manually enter a Serial Number even if the number does not 
appear in the list of values.

45. Click the Save icon on the toolbar.

46. Close the Receiving Transactions window to return to the Depot Repair 
Workbench.

47. In the Logistics tab, click Update Logistics.

The status of the Move In line changes to Received.

48. Optionally, from the top menu, select Data > Activity to see the details of the 
reception of the item in the Activity window.

This completes the procedures for receiving an item with inspection.

4.18 Split a Repair Order
Often as a result of an inspection carried out during the receiving of an item, you 
may decide to repair some but not all of the defective units.

Under certain conditions (see the Prerequisites that follow in this section), Oracle 
Depot Repair allows you to split a Repair Order, but not necessarily just because of 
an inspection.

Repair Type Change Options
One of the prerequisite conditions is that the original Repair Type must have a 
Repair Type Ref value of either Standard or Repair and Return. You can change the 
Repair Type on the new Repair Order, so long as the final Repair Type also has a 
Repair Type Ref value of either Standard or Repair and Return.

For details of setting up Repair Types, see the Oracle Depot Repair Implementation 
Guide.

Splitting Options
When you choose to split a Repair Order, you have the following options:

Note: The explicit condition specifies the Repair Type Ref 
attribute of the allowable Repair Types. The seeded Repair Types 
Standard and Return and Repair have the same Repair Type Ref 
values as their Repair Type names. 
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� You can split into two separate Repair Orders, as for example when splitting 10 
units into two lines of 8 and 2 units

� You can split into multiple Repair Orders, each with a quantity of 1.

When you choose to split the Repair Order into two separate Repair Orders, you 
can also decide whether to copy attachments from the original Repair Order to the 
new Repair Order.

When you split into multiple lines, each with a quantity of 1, all attachments on the 
original Repair Order, if any exist, are automatically copied to each new Repair 
Order.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
The Repair Order Item must be serialized.

The item must not be Install Base trackable.

All quantities must be received.

For WIP mode, all jobs must be completed, that is, no partial completions are 
allowed.

The Repair Order status must be Open.

The Repair Type Ref of the Repair Type must be Standard or Repair and Return.

No Ship lines have been interfaced to Oracle Order Management.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order that you want to split.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.
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2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

3. From the top menu, select Tools > Split Repair Order.

The Split Repair Order window appears.

Your splitting options are indicated by the two radio buttons:

� Split into 2 lines

� Split into lines with quantity of 1

Split into 2 Lines

Under the Split into 2 lines option, there is a table showing the following fields:

� Original Repair Order Quantity (enabled)

� Original Repair Order Repair Type

� New Repair Order Quantity

� New Repair Order Repair Type (enabled)

There is also a check box under the Split into 2 lines option, enabling you to 
copy attachments from the original Repair Order to the new Repair Order.

If there are no attachments to the original Repair Order, the check box is 
disabled.

Split into Lines with a Quantity of 1

Under the Split into lines with a quantity of 1 option, a message indicates that 
any attachments to the original order will be automatically copied to the new 
order.

4. Select one of the radio buttons.

5. If you selected Split into lines with a quantity of 1, you have no further choices. 
Continue at step 7.

6. If you selected Split into 2 lines: 

a. Enter the Original Repair Order Quantity, that is, the new quantity that you 
wish to have on the original Repair Order after splitting.

The New Repair Order Quantity is automatically calculated after you enter 
the Original Repair Order Quantity.

b. Select the New Repair Order Repair Type.
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You can only select a Repair Type whose Repair Type Ref was set up as 
Standard or Repair and Return. 

c. Optionally, select the check box Copy attachments from original Repair 
Order to new Repair Order.

7. Click OK.

4.19 Manage the Repair Process
Oracle Depot Repair lets service organizations manage repair by using either Oracle 
WIP or Task Manager, a module in Oracle Common Application Components. 

WIP mode is recommended for use when the repair jobs require series of sequential 
steps, and materials management. Task mode is recommended for use when the 
repairs require minimal steps that are not necessarily completed in sequence.

The WIP or Task modes are associated to the Repair Types during implementation. 
Though a service organization can have different Repair Types associated with 
different repair modes, it is recommended that a service organization select only 
one repair mode for all Repair Types to enhance usability.

The topics in this section include the following:

� Section 4.20, "Create and Process WIP Repair Jobs" on page 4-76

� Section 4.21, "Create and Process Repair Tasks" on page 4-88

4.20 Create and Process WIP Repair Jobs
The topics in this section include the following:

� Section 4.20.1, "Create a WIP Repair Job for a Single Repair Order" on page 4-77

� Section 4.20.2, "Process a WIP Repair Job for a Single Repair Order" on 
page 4-81

� Section 4.20.3, "Create a WIP Repair Job Across Multiple Repair Orders" on 
page 4-82

� Section 4.20.4, "Process a WIP Repair Job Across Multiple Repair Orders" on 
page 4-85
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4.20.1 Create a WIP Repair Job for a Single Repair Order
The Shop Floor Technician can create a non-standard WIP Repair Job from the 
Depot Repair Workbench. You select the organization for the WIP Repair Job, and 
the items for the WIP Repair Job must be defined in that organization. 

Multiple jobs can be created for each Repair Order. You can release WIP Repair Jobs 
on to the shop floor. You must provide the WIP Accounting Class through which 
costs are posted to Oracle General Ledger.

Depot agents can view WIP Discrete Jobs window in a read-only mode to verify the 
status and additional details of the WIP Repair Job.

The following procedures describe how to create a WIP Repair Job for a single 
Repair Order. 

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to creating the 
WIP Repair Job for the Repair Orders. For more information, see Chapter 3, "Oracle 
Depot Repair Business Scenarios".

Navigation
Depot Repair > Repair Orders

Note: You may need to create a Repair Job without an RMA in 
case of remanufacture or refurbishment on items that your 
organization already owns, or if your organization took ownership 
or possession of an item through a field service agent rather than 
against an RMA.

Oracle Depot Repair provides you with a profile option, CSD: 
Allow Creating WIP Job Without RMA, which enables you to create 
a WIP Repair Job without an RMA. Refer to Oracle Depot Repair 
Implementation Guide for details.
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Steps
1. Retrieve the Repair Order for which you want to create a WIP Repair Job.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant record from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. In the Depot Repair Workbench, select the Repair Jobs tab, and click Create Job 
to display the Organizations window.

4. Select the relevant repair organization, and click OK. 

The Submit Repair Jobs window opens. 
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5. If the WIP Repair Job item is different from the Repair Order Item, select the 
relevant WIP item from the list of values in the Item field.

6. Select the Released Job Status from the list of values.

7. Select an Accounting Class from the list of values, for example, Rework.

8. Enter the number of items that you want to submit in the (Quantity) Submit 
field.

9. Select the Start Date and Complete Date for the WIP Repair Job.

10. In the Service Codes, Bills and Routings area, select one of the three radio 
buttons:

� Use Service Codes

� Select Bills and Routings

� Do not Specify Bills and Routings

a. If you select Use Service Codes, the following occurs:

– Bills and Routings associated with the active Service Codes, that is, the 
Service Codes marked as applicable, in the Diagnostics tab are attached 
to the WIP Repair Job.

– Read-only summary information about the Service Codes, Bills, and 
Routings is displayed in the Service Codes, Bills and Routings area.

b. If you select Select Bills and Routings, enter appropriate Bill and Routing 
data in the Bill and Routing sections.

Note: The default value for this field is taken from the profile 
option CSD: Default Repair Job Status. 

You may submit a WIP Repair Job with a Job Status of Unreleased. 
You will be able to change the status later using Oracle Work In 
Process transactions.

Note: After you have added the Bills and Routings associated 
with the active Service Codes, the Service Code rows from which 
you derived the Bills and Routings are disabled in the Service 
Codes area of the Diagnostics tab.
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c. If you select Do not Specify Bills and Routings, you are choosing not to 
provide any Bill and Routing information for the WIP Repair Job.

11. Click Submit Job to submit the job in a released status to WIP.

12. To make sure that the program completes successfully, monitor the requests by 
choosing View > Requests.

13. Close Repair Jobs window to return to the Depot Repair Workbench.

14. Click Update Job. 

The new job appears on the Repair Jobs tab.

15. To view the job, select the job record on the Repair Jobs tab, and click View Job.

To process the WIP Repair Job, see Section 4.20.2, "Process a WIP Repair Job for 
a Single Repair Order" on page 4-81. 

See Also
Section 4.20.3, "Create a WIP Repair Job Across Multiple Repair Orders" on 
page 4-82.

Multiple WIP Repair Jobs and Partial Quantities for a Single Repair Order
Oracle Depot Repair lets you create multiple WIP Repair Jobs for a single Repair 
Order and supports the creation of multiple WIP Repair Jobs with partial quantities 
per RMA.

WIP Repair Job Item Same As Repair Order Item
If the item selected for the WIP Repair Job is the same as the one in the Repair 
Order, then for each WIP Repair Job submission, the submit quantity cannot be 
greater than the quantity received. A submit quantity less than the quantity 
received implies that you can create multiple WIP Repair Jobs against a single 
Repair Order, with each WIP Repair Job handling part of the RMA quantity. 

For example, consider that the item on the Repair Order is A, and the quantity of 
item A is 5. When you submit WIP Repair Jobs for item A, the maximum number of 
units of A that can be submitted in a WIP Repair Job is 5, and the minimum is 1.

WIP Repair Job Item Different From Repair Order Item
If the item selected for a WIP Repair Job is different from the one on the Repair 
Order, the submit quantity restriction does not apply, and you can submit the WIP 
Repair Job for any quantity. The application validates this quantity with the 
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quantity received in the Repair Order line. In this case, the quantity to be submitted 
to WIP must be at least 1.

4.20.2 Process a WIP Repair Job for a Single Repair Order
The following procedures describe how to process a repair WIP Repair Job that 
contains a single Repair Order.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to processing the 
WIP Repair Job for the Repair Order. For more information, see Chapter 3, "Oracle 
Depot Repair Business Scenarios".

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to process the WIP Repair Job. 

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant record from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. In the Depot Repair Workbench, select the Repair Jobs tab.

4. Click Material Txn to display the Material Transaction window.

5. Issue the item and the material required to process the WIP Repair Job.

For details, see Issuing and Returning Specific Components in the Oracle Work 
In Process User’s Guide.
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6. Complete the item repair using a recommended repair procedure.

7. When the repair is complete, click Complete Job in the Repair Jobs tab.

The Completion Transaction Find window opens.

Enter the completion details, such as quantity completed and completion 
subinventory, for the WIP Repair Job.

For details, see Completing and Returning Assemblies in the Oracle Work In 
Process User’s Guide.

8. In the Repair Jobs tab of the Depot Repair Workbench, click Update Job to 
update the Repair Order activity information. 

Post-Processing
1. To see information about the WIP Repair Job activity, from the top menu, select 

Data > Activity. 

For more information, see Section 4.22, "View Activities Related to a Repair 
Order" on page 4-98.

2. After you have processed a WIP Repair Job, if invoicing is required, you must 
move the data to Repair Actuals. 

For more information, see Section 4.28, "Record Billing Data in Repair Actuals" 
on page 4-111.

4.20.3 Create a WIP Repair Job Across Multiple Repair Orders
Oracle Depot Repair lets service organizations automatically create a single WIP 
Repair Job against multiple Repair Orders for identical items.

You search for WIP Repair Jobs issued for items that have already been received 
into the repair organization. You can perform the search against the Item Code, or 
attributes that pertain to the linked Service Request. 

You perform this operation in two stages:

a. First, you search for the Repair Orders, in the Find Repair Orders for Job 
Submission window.

b. Then, you determine how many units to submit for repair for each Repair 
Order, and submit the WIP Repair Job, in the Submit Repair Jobs for Repair 
Orders window.
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The Find Repair Orders for Job Submission window incorporates a multi-select 
feature to let you select any or all Repair Order lines that appear in the search 
results.

In the Submit Repair Jobs for Repair Orders window, you can specify the quantity 
of the item to submit for each Repair Order, and optionally, select Bills and 
Routings.

The following procedures describe how to create a WIP Repair Job for multiple 
Repair Orders relating to the same item. 

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to creating the 
WIP Repair Job for the Repair Orders. For more information, see Chapter 3, "Oracle 
Depot Repair Business Scenarios".

Navigation
Depot Repair > Submit Repair Jobs...Organizations window

Steps
1. Select the relevant Repair Organization from the list of values. 

Find Repair Orders for Job Submission Window

The Find Repair Orders for Job Submission window opens.

For descriptions of all the fields, see Section 2.14, "Find Repair Orders for Job 
Submission Window" on page 2-42.

2. Enter one or more search criteria by using one or more of the following fields:

� (Service Request) Request Num

� (Service Request) Customer

� (Service Request) Account

� (Service Request) Severity or Urgency
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� (Repair Order) Item

� (Repair Order) Promise Date or Date Range

� (Repair Order) Create Date or Date Range

This is a sample list of the search parameters.

For descriptions of all the fields, see Section 2.14, "Find Repair Orders for Job 
Submission Window" on page 2-42.

3. Click Find to start the query. 

The search results appear in the Results area of the Find Repair Orders for Job 
Submission window.

4. Select the relevant Repair Order or combination of Repair Orders.

� To select all the rows, click Select All.

� To select multiple, non-contiguous rows from among the search results, 
press and hold the Control key, and click each row.

� To select a complete range of rows from among the search results, click the 
first row of the range, then press and hold the Shift key, and click the final 
row of the range.

� To deselect all rows, click Deselect All.

5. After you select the relevant rows, click OK.

Submit Repair Jobs for Repair Orders Window

The Submit Repair Jobs for Repair Orders window opens. 

The selected rows populate the Repair Order Information area in the window, 
and the Total Quantity Submitted for repair automatically appears. 

For field descriptions, see Section 2.15, "Submit Repair Jobs for Repair Orders 
Window" on page 2-45.

6. In the Job Status field, select Released from the list of values. 

You may submit a WIP Repair Job with a Job Status of Unreleased. You will be 
able to change the status later using Oracle Work In Process transactions.

7. Select an Accounting Class from the list of values, for example, Rework. 

Your organization determined these values during implementation of Oracle 
Depot Repair.

8. Select WIP Start and Complete Dates.
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9. In any line of the Repair Order Details tab, you can optionally change the 
number of units to submit in the (Quantity) Submit field.

10. You can optionally click the Bills and Routings tab, and select one of the radio 
buttons:

� Select Bills and Routings

� Do not Specify Bills and Routings

If you choose Select Bills and Routings, then you must select at least one Bill or 
Routing.

11. Click Submit Jobs to submit the job in a released status to WIP.

12. To verify that the program completes successfully, monitor the requests by 
choosing View > Requests from the toolbar.

13. Close the Submit Repair Jobs for Repair Orders window and return to the 
Navigator.

Update Job for Each Repair Order

14. Retrieve these Repair Orders by using the Find Repair Orders window.

15. In the Depot Repair Workbench, select each Repair Order, and click Update Job. 
The new job appears on the Repair Jobs tab.

For more information, see Section 4.23, "Update Repair Orders Concurrently" 
on page 4-100.

Comments
After you have created and submitted a WIP Repair Job for identical items across 
multiple Repair Orders, you can process the WIP Repair Job.

For more information, see Section 4.20.4, "Process a WIP Repair Job Across Multiple 
Repair Orders" on page 4-85.

See Also
Section 4.20.1, "Create a WIP Repair Job for a Single Repair Order" on page 4-77

4.20.4 Process a WIP Repair Job Across Multiple Repair Orders
The following procedures describe how to process a WIP Repair Job containing 
multiple Repair Orders. Processing a WIP Repair Job across multiple Repair Orders 
involves the following areas:
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� Find Discrete Jobs Window on page 4-86

� Material Transactions Window on page 4-86

� Completion Transactions Window on page 4-87

� WIP Jobs and Schedules Window on page 4-87

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to processing the 
WIP Repair Job for the Repair Orders. For more information, see Chapter 3, "Oracle 
Depot Repair Business Scenarios".

Navigation
WIP > Discrete > Discrete Jobs...Find Discrete Jobs window

Steps
Find Discrete Jobs Window

1. Enter the WIP Repair Job Number, and click the Find button.

The Discrete Jobs window opens.

2. Confirm that the Repair Job is in Released status.

3. Click the Routing Tab and select the Completion Subinventory from the list of 
values.

4. If the item is under Locator control, enter the Locator value.

5. Save your work.

6. Close the Discrete Jobs window to return to the navigator.

Material Transactions Window

7. Navigate to WIP > Material Transactions > WIP Material Transactions.

The Material Transactions window opens.
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8. Select the Specific Component option if the material to be issued is not defined 
as a material requirement for the job.

9. Enter the WIP Job Number, and click the Continue button.

The WIP Component Issue window opens.

10. In the Components Issue window, enter the Items to be repaired.

If you did not select the Specific Component option, and the material you want 
to issue is not defined as a material requirement for the job, you might not be 
able to issue the item.

11. Select the present Subinventory location of the items.

12. If the items are Locator controlled, enter Locator information.

13. Enter the Quantity to be repaired.

14. If the items are under Serial or Lot control, enter Serial or Lot information.

15. Enter the material needed to assist the repair.

16. Click Done. 

This issues the material and closes the window.

17. Close the Material Transactions window to return to the Navigator.

Completion Transactions Window

18. After completing the repair, navigate to WIP > Material Transactions > 
Completion Transactions.

The Completion Transactions window opens.

19. Enter the WIP Repair Job Number, and click the Continue button.

20. Enter the completed quantity and the completion subinventory if you did not 
enter this information previously.

21. If the items are Locator, Serial, or Lot controlled, and you entered such 
information previously, enter these values.

22. Click Done to perform the completion transaction and return to the Depot 
Repair Navigator window.

WIP Jobs and Schedules Window

23.  Navigate to WIP > Discrete > WIP Value Summary.

The WIP Jobs and Schedules window opens.
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24. Enter the WIP Repair Job Number, and click Find.

The WIP Jobs and Schedules window opens.

25. Enter the From Period and To Period information.

26. Click Value Summary.

The WIP Value Summary window opens.

4.21 Create and Process Repair Tasks
Tasks consist of work assignments that detail the actions required of company 
personnel.

The Repair Tasks tab in the Depot Repair Workbench provides a solution for repair 
establishments that use simple, standard business processes without requirements 
for WIP-based processes. The Tasks module is accessed (Repair Tasks tab is enabled 
or disabled) depending on the Repair Type selected in the Depot Repair Workbench 
Details tab.

In the Repair Tasks tab, you can create, update, assign, and view previous tasks 
assigned to a Repair Order. Tasks assigned previously appear in the table in the 
upper part of the tab, while details of the selected task appear in the fields below it. 
You can create a task directly from the Repair Tasks tab by entering all the relevant 
information, or by using a template.

Repair Task Debrief
On the Repair Tasks tab, you can click the Debrief button to display Material, Labor, 
and Expense forms. You can debrief a job with actual Material, Labor, and Expense 
repair charges.

For repair jobs that you have managed using Tasks, the Debrief provides the actual 
charges incurred during the repair that would be invoiced to a customer. If both 
estimate and debrief exists for a repair that you have managed using Tasks, the 
customer is invoiced based on charges that appear in the debrief.

The topics in this section include the following:

� Section 4.21.1, "Create a Repair Task Manually" on page 4-89

� Section 4.21.2, "Create a Repair Task Using a Task Template" on page 4-91

� Section 4.21.3, "Enter and Update Task Details" on page 4-94

� Section 4.21.4, "Prepare the Repair Tasks Debrief" on page 4-96
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4.21.1 Create a Repair Task Manually
The following procedures describe how to create a repair task manually.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to creating the 
repair tasks for the Repair Order. For more information, see Chapter 3, "Oracle 
Depot Repair Business Scenarios".

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to create repair tasks.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant record from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. In the Depot Repair Workbench, click the Repair Tasks tab. 

If tasks have already been defined for the Repair Order, the table lists the tasks. 
If more than one task appears, selecting a different task displays the 
corresponding detail in the lower fields on the tab.
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4. Enter the task information in the required fields by selecting from the list of 
values. 

For field descriptions, see Section 2.10, "Repair Tasks Tab" on page 2-33.

5. Enter the values in the Assignee and Owner fields (or change them) by selecting 
from the list of values. 

You can also change these field values from the Assignment Manager. To access 
the Assignment Manager, click the Assignment Manager button next to the 
fields. For additional information about the Assignment Manager, see Oracle 
Common Application Components User’s Guide.

6. Choose the Planned Start and End Dates.

7. Click the Save icon to save the task record.

A system-generated Task Number populates the Num field.
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8. To manually launch workflow, select the task from the table, and click Launch 
Workflow. 

Based on the task, the workflow runs. The designated resources are reserved, 
and the workflow notifies the task owner of task creation through email.

9. To add or update task details, click More. 

The Task Details window opens.

For more information, see Section 4.21.3, "Enter and Update Task Details" on 
page 4-94.

4.21.2 Create a Repair Task Using a Task Template
The following procedures describe how to create a repair task using a Task 
Template.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to creating the 
repair tasks for the Repair Order. For more information, see Chapter 3, "Oracle 
Depot Repair Business Scenarios".

Before you create a task from a Task Template, a template design must exist.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to create repair tasks.

Note: The Launch Workflow button is available only if resources 
have been assigned to the selected task.
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For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant record from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. In the Depot Repair Workbench, select the Repair Tasks tab. 

If tasks have already been defined for the Repair Order, the table lists the tasks. 
If more than one task appears, selecting a different task displays the 
corresponding detail in the lower fields on the tab.

4. On the Repair Tasks tab, click Use Template. 

The Create Tasks from Template Group window opens.

5. In the Template Group field, select the Template Group based on the task which 
is to be created. 

Values in the Source Document, Source Name, Owner Type and Owner fields 
are default values. You can change these values.
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6. Click Create Tasks. 

The Repair Tasks tab opens and displays a new task line that shows a 
system-generated Task Number in the Num field.

7. To manually launch workflow, click Launch Workflow. 

Based on the task, the workflow runs. The designated resources are reserved, 
and the workflow notifies the task owner of task creation through email.

Note: The Launch Workflow button is available only if a resource 
has been assigned to a selected task.
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8. Click More to open the Task Details window to enter details such as resource 
assignments, dependencies, references, and contacts.

For more information, see Section 4.21.3, "Enter and Update Task Details" on 
page 4-94.

4.21.3 Enter and Update Task Details
After a task record is created, you can update task information and task details. The 
following procedures describe how to update task information and to add task 
details.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
Task records that you want to update or add details to must exist in the database.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to update task details.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant record from the Results area of the Find Repair Orders 
window, and click OK. 

3. The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

4. In the Depot Repair Workbench, select the Repair Tasks tab. 

If tasks have already been defined for the Repair Order, the table lists the tasks. 
If more than one task appears, selecting a different task displays the 
corresponding detail in the lower section of the window.
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5. To update task information, make the necessary changes to the field values, and 
click the Save icon. 

For field descriptions, see the Section 2.10, "Repair Tasks Tab" on page 2-33.

6. To specify task details, select the task for which you want to update details, and 
click More. 

The Task Details window opens. The Task Details window comprises the 
following tabs:

� Resources: Assign personnel information to a task. This tab defines resource 
requirements, assignments, and scheduling information.

� Dependencies: Determine the order of tasks. Oracle Depot Repair, however, 
does not enforce task dependencies.

� References: Link the task to different documents or tasks with pertinent 
background information.

� Dates: Identify more dates in addition to the planned dates, the scheduled 
dates, and the actual dates. You can track task progress by entering dates 
after task milestones such as task creation, resource reservation, or task 
completion.

� Contacts: Create and manage multiple contacts assigned to a task. Contact 
information is obtained from customer information. To enter this 
information, you must identify a customer in the main task window.

� Recurrences: Schedule tasks so as to occur automatically. Examples of 
intervals include daily, weekly, monthly, or yearly occurrences. To schedule 
recurring tasks, you must either specify a start date and the number of tasks 
to create, or the end date. The task dates are populated as the planned start 
and end dates. 

� Others: Identify additional information about the task, and select different 
configurations for each task. Setting flags customizes each task according to 
business needs.

� Audit: Track each update to a task. The tab documents and dates the history 
of task change, and provides a trail from the original task through to the 
current task status.
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7. Enter the field values on the different tabs as required. 

For detailed instructions, refer to the Task Manager topic in Oracle Common 
Application Components User’s Guide.

8. Click OK to save your work and return to the Repair Tasks tab in the Depot 
Repair Workbench.

4.21.4 Prepare the Repair Tasks Debrief
On the Repair Tasks tab, you can click the Debrief button to display the Debrief 
Report, with Material, Labor, and Expense tabs. You can debrief a job with actual 
Material, Labor, and Expense repair charges.

For repair jobs that you have managed using Tasks, the Debrief provides the actual 
charges incurred during the repair that would be invoiced to a customer. If both 
estimate and debrief exists for a repair that you have managed using Tasks, the 
customer is invoiced based on charges that appear in the debrief.

Note: The Debrief Report form does not let you apply contracts 
per charge line. If you are using the Debrief Report form to 
generate charges, the system automatically applies the contract at 
the Service Request level to the charge line.



Create and Process Repair Tasks

Managing Depot Business Processes 4-97

The following procedures describe how to create the Debrief. This procedure is 
applicable only to repair processes that you have managed by using Tasks.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to creating the 
repair tasks for the Repair Order. For more information, see Chapter 3, "Oracle 
Depot Repair Business Scenarios".

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to update task details.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant record from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. In the Depot Repair Workbench, select the Repair Tasks tab. 

If tasks have already been defined for the Repair Order, the table lists the tasks. 
If more than one task appears, selecting a different task displays the 
corresponding detail in the lower section of the window.

4. Select the task for which you want to create the report, and click Debrief. 

The Debrief Report window shows the selected task details populated in the 
fields at the upper part of the window. The lower half of the window comprises 
the Material, Expense, and Labor tabs.
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5. Select the Material tab to enter required details of material transactions of the 
repair task.

6. Select the Expense tab to enter required details of other expenses of the repair 
task.

7. Select the Labor tab to enter required labor transaction details of the repair task.

8. Click Update to save the details.

For detailed instructions and discussion on buttons and check boxes accessible 
from the Debrief Report window, refer to Oracle Field Service User Guide.

4.22 View Activities Related to a Repair Order
The Activity window displays a real-time view of events and activities that 
surround a Repair Order. This permits the depot agents and planners to know the 
exact status of each Repair Order line. 
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The following procedures describe how to view the activities that have elapsed at 
the depot in association with a Repair Order.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
None

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to view the elapsed depot 

activities.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. From the top menu, select Data > Activity. 

The Activity window displays the quantity received, quantity submitted to 
WIP, quantity completed in WIP, and quantity shipped. It also displays 
individual events, event dates, quantity, and other details. For detailed field 
descriptions, see the Section 2.13.2, "Activity Window" on page 2-41.

Note: The fields, Quantity Submitted to WIP and Quantity 
Completed in WIP, appear only for repairs processed in WIP mode. 
However, when quantities are submitted in WIP mode across 
Repair Orders, these Quantity fields do not contain valid values.
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4. If the Activity window does not display the updated information that you 
expect, you may need to run the appropriate information update program:

� Click the Logistics tab, then click Update Logistics.

� Click the Repair Jobs tab, then click Update Job.

For more information, see Section 4.23, "Update Repair Orders Concurrently" 
on page 4-100.

4.23 Update Repair Orders Concurrently
The following concurrent programs update all the open Repair Orders at the same 
time:

� Depot Repair Job (WIP) Update

� Depot Repair Receipt Update

� Depot Repair Shipment Update

To access these programs, from the Depot Repair Navigator, navigate to:

Depot Repair > Other > Run Requests.

Note: The programs triggered by the Update Logistics and 
Update Job buttons update the activity information only for the 
Repair Order currently selected in the Depot Repair Workbench.
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The Submit a New Request window opens. In the Submit a New Request window, 
you can choose to submit a single request. When you submit a single request, the 
Submit Request window opens. In the Name field, select the program that you want 
to run. Choices include Depot Repair Receipt Update, Depot Repair Job (WIP) 
Update, or Depot Repair Shipment Update. You also specify to update quantity 
received, quantity submitted to or completed in WIP, and quantity shipped 
respectively, for all open Repair Orders.

In the remaining fields, you can schedule the program to run at times or intervals of 
your choice, choose whom to notify on completion, and choose whether to print or 
save the reports. For more information, refer to the online help available from these 
windows.

The Depot Repair Receipt Update concurrent program picks only the receiving lines 
that are delivered to a subinventory. This is to support business scenarios that 
involve quantity correction of goods received at the dock.

For example, during the inspection of goods received at a dock, you can correct or 
return some quantity of the goods delivered. This could be because not as many 
items were sent as the customer said they would, or the customer returned more 
than expected, such as, goods that were too damaged to qualify for a refund, or 
goods that your organization did not sell. Items are not considered as received until 
they pass the inspection, and are delivered to a subinventory. Only at this point 
does the Depot Repair Receipt Update concurrent program stamp the received 
quantity and show the change in the received quantity.

4.24 Workflow-Based Messaging
At a high level, the Workflow-based Messaging functionality provides the ability to 
send a workflow notification message, and have that message link to the Repair 
Order selected in the Depot Repair Workbench at the time the message was sent. 
Messages can be of various types, from information-only to those that request 
actions or approvals from others. When the message recipient responds to the 
message linked to the specified Repair Order, that response is captured in the 
Repair Order's message history. A message can be sent to one or many recipients, 
and can be sent to group lists. Messages sent to multiple recipients can only be 
informational messages.

In Oracle Depot Repair, messages are tied to a Repair Order, and are sent from the 
Repair Orders form.
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For more information on message types, sending, receiving, and viewing messages, 
and user procedures, see the Oracle TeleService User Guide and Oracle TeleService 
Implementation Guide.

4.25 Create a Ship Line Manually
The following procedures describe how to create a Ship line manually.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User
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Prerequisites
You must complete all steps in the relevant business scenario prior to creating a ship 
line manually. For more information, see Chapter 3, "Oracle Depot Repair Business 
Scenarios".

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to create the Ship line manually.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. Select the Logistics tab in the Depot Repair Workbench.

4. In the Action Type field, select Ship.

5. Select the fields for the Ship line.

The main fields that you must select are Action Code, Service Activity, and 
Price List.

Note also the Add to Order field. Oracle Depot Repair lets you place all Return 
(RMA) and Ship lines on the same order.

By default, all Return (RMA) and Ship lines appear on the next-highest Order 
Number created when the lines are transferred to Order Management.

You can also select the specific order for the Return (RMA) or Ship line by 
selecting the Order Number in the Add to Order field before interfacing the 
specified line to Order Management.

For field descriptions, see Section 2.6, "Logistics Tab" on page 2-11.

6. Click the Save icon on the toolbar to save the record.

The Ship line is created with the Status of Entered.
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4.26 Ship a General Item
The term "general item" indicates an item that is not being refurbished.

Depending on the business scenario, an item being shipped might be repaired. 
Shipments can include repaired, replacement, loaner, or exchange items.

If you do not select a subinventory for the item, the subinventory is derived from 
the picking rule defined in the profile option CSD: Default Pick Release Rule for 
Sales Orders.

The Ship line that corresponds to the shipment goes through several stages of 
processing, and at each stage the Status is updated. The Status values that it passes 
through are Entered, Submitted, Booked, Released, and Shipped.

You may go through each processing stage one stage at a time, or process several 
stages in sequence automatically.

Enter Order (Submit to Oracle Order Management)
After a Ship line is created, its first Status is Entered. 

When you submit the line to Oracle Order Management, and it is successfully 
interfaced, it gets an Order Number returned from Oracle Order Management, and 
its Status changes to Submitted.

After the Ship line has been interfaced with Oracle Order Management, it cannot be 
deleted.

Book Order
In this stage, the line must be booked in Oracle Order Management. The main effect 
of this in Oracle Depot Repair is that the Status of the line changes to Booked.

Pick Release
During the Pick Release processing, the application reserves the exact items to ship.

The Status of the Ship line at the end of the Pick Release stage changes to Released.

[For serialized items whose Serial Control is either Predefined or At Receipt, you 
are required to perform the Pick Release processing twice:

� The first time, you must enter the Serial Number in a separate Oracle Inventory 
window, but the Status of the Ship line remains as Booked.

� The second time, you automatically upgrade the Ship line Status to Released.]
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Ship Confirm
At the end of the Ship Confirm stage, the item has been shipped and the Status of 
the line changes to Shipped.

Automatic Processing of a Ship Line
The standard way to process a Ship line for a general item is as follows:

1. Decide the stage you want to reach.

2. Click the Automate Order Processing steps through check box.

3. Select the radio button which corresponds to the stage you want to reach:

– Enter Order

– Book Order

– Pick Release

– Ship Confirm

4. Click Process.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to shipping the 
general item. For more information, see Chapter 3, "Oracle Depot Repair Business 
Scenarios".

Navigation
Depot Repair > Repair Orders

Note: You can optionally process the last stage, that is, with the 
Ship line in the Released status, by clicking the Ship button, and 
then entering data in Oracle Shipping Execution windows. For 
details of these windows, see the Oracle Shipping Execution User’s 
Guide.
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Steps
1. Retrieve the Repair Order for the item that you want to ship.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant order from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. Select the Logistics tab of the Depot Repair Workbench.

4. Click any field of the Ship line to make that line current.

5. Click the Process Trans check box.

6. Select the Automate Order Processing Steps Through check box.

7. Select one of the following radio buttons:

� Enter Order

� Book Order

� Pick Release

� Ship Confirm

8. For the special case where you have chosen Ship Confirm, for a serialized item 
whose Serial Control is At Sales Order Issue, enter the Source Serial Number.

9. Click Process.

Depending on how many stages you have chosen to perform, a variety of 
procedures are performed.

In all cases, acknowledge the message in any message window that appears.

Enter Order

If, at step 7, you chose Enter Order, the Status changes to Submitted.

Book Order

If, at step 7, you chose Book Order, the Status changes to Booked.

Pick Release

If, at step 7, you chose Pick Release, the Status generally changes to Released.



Ship a General Item

Managing Depot Business Processes 4-107

Pick Release for Items with Serial Control Predefined or At Receipt

For a serialized item that has Serial Control which is either Predefined or At 
Receipt, the resulting Status depends on whether you are performing the Pick 
Release processing for the first time or the second time. 

a. The first time, you must enter a Serial Number, navigating through the Find 
Move Order Lines window that appears automatically, to the Transact 
Move Orders window.

For details of the Find Move Order Lines window and the Transact Move 
Orders window, see the Oracle Inventory User’s Guide.

When you return from the Transact Move Orders window, the Status of the 
Ship line remains as Booked.

Repeat the Pick Release processing (steps 5 through 9).

b. The second time you perform the Pick Release process, you do not have to 
enter any further data, and the Status changes to Released.

10. To see the Serial Number that you entered during the first-time Pick Release 
processing in the (Source) Serial Num field on the Logistics tab, click Update 
Logistics, after you complete the second-time Pick Release process.

11. To check if there has been a mismatch between the Serial Number in the Ship 
line and the Serial Number you entered in the Transact Move Orders window, 
select Data > Activity to display the Activity window. If a mismatch occurred, 
an alert message in the Activity window records the two Serial Numbers.

When the Status of the Ship line is Released, the Pick Release stage is complete.

Ship Confirm

When processing the Ship Confirm stage, you should wait until the concurrent 
program Interface Trip Stop has completed successfully before you click Update 
Logistics, to see the changed value of the Status.

12. You can monitor the progress of the program by selecting Requests from the 
View menu on the toolbar, and selecting appropriate search criteria.

13. Click Update Logistics. 

The purpose of this is to update the Status on the Ship line, so that it reflects in 
Oracle Depot Repair the results of the procedures executed in other Oracle 
applications when you clicked Process.

If, at step 7, you chose Ship Confirm, and the background concurrent process 
Interface Trip Stop completes successfully, the Status changes to Shipped.
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14. When the transaction is completed, you can optionally view the shipping 
information in the Activity window, by selecting Data > Activity from the top 
menu.

4.27 Ship a Refurbished Item
In Oracle Depot Repair, after a refurbished item has been received from the Spares 
Management warehouse and repaired, it is ready to be shipped back to Spares 
Management.

If you do not select a subinventory for the item, the subinventory is derived from 
the picking rule defined in the profile option CSD: Default Pick Release Rule for 
Sales Orders.

You must process the item through the Pick Release and a Ship stages. These stages 
are similar to the Pick Release and Ship Confirm stages for shipping a general item.

Where both options are allowed (that is, where the equivalent radio buttons are 
both enabled), you can either perform the two stages one at a time, or process both 
stages in sequence automatically.

For serialized items whose Serial Control is either Predefined or At Receipt, you are 
required to perform the Pick Release processing twice., as for general items. For 
more information, seeSection 4.26, "Ship a General Item" on page 4-104.

Manual Ship Processing for Items with Serial Control At Sales Order 
Issue
The only difference in the processing of a refurbishment item and a general item 
occurs in the final, Ship stage, and then only for the case of a serialized refurbished 
item, whose Serial Control is At Sales Order Issue.

To ship this type of item, you must use the manual method of clicking Ship and 
entering the Serial Number using Oracle Shipping Execution windows; you cannot 
use the automatic method of choosing Ship Confirm and clicking Process.

Note: Spares Management is a module of Oracle Field Service.

Note: You must also use the manual method for partial 
shipments.
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The following procedures describe the Move Out transaction, that processes the 
shipment of the refurbished item back to Spares Management.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
The Service Request and the associated refurbishment Repair Order or orders must 
have been created in the Spares Management module of Oracle Field Service.

The item must have been received and repaired.

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for which you want to ship the refurbished item.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

3. Click the Logistics tab.

4. Click any field of the Move Out line to make that line current.

The Status of the Move Out line should be Booked.

Note: The following description assumes that you select the 
automatic Pick Release option when processing the Move Out line. 

Even if you select Ship Confirm as your first choice for processing 
the Move Out line, the application automatically processes the Pick 
Release stage first, then the Ship Confirm stage.
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Pick Release 

5. Click the Process Trans check box for the Move Out line.

6. Click the Automate order processing steps through check box.

7. Select the Pick Release radio button.

8. Click Process.

The Status of the Move Out line generally changes to Released.

Pick Release for Items with Serial Control Predefined or At Receipt

For a serialized item that has Serial Control which is either Predefined or At 
Receipt, the resulting Status depends on whether you are performing the Pick 
Release processing for the first time or the second time. 

a. The first time, you must enter a Serial Number, navigating through the Find 
Move Order Lines window that appears automatically, to the Transact 
Move Orders window.

For details of the Find Move Order Lines window and the Transact Move 
Orders window, see the Oracle Inventory User’s Guide.

When you return from the Transact Move Orders window, the Status of the 
Move Out line remains as Booked. 

b. The second time you perform the Pick Release process (steps 5 through 8), 
you do not have to enter any further data, and the Status changes to 
Released.

9. To see the Serial Number that you entered during the first-time Pick Release 
processing in the (Source) Serial Num field on the Logistics tab, click Update 
Logistics, after you complete the second-time Pick Release process.

10. To check if there has been a mismatch between the Serial Number in the Move 
Out line and the Serial Number you entered in the Transact Move Orders 
window, select Data > Activity to display the Activity window. If a mismatch 
occurred, an alert message in the Activity window records the two Serial 
Numbers.

When the Status of the Move Out line is Released, the Pick Release stage is 
complete.

Manual Ship or Ship Confirm

11. For the case of a serialized refurbished item, whose Serial Control is At Sales 
Order Issue, or for partial shipments, the Ship Confirm button is disabled. In 
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these situations, click Ship and enter the item’s Serial Number in Oracle 
Shipping Execution windows. For details of these windows, see the Oracle 
Shipping Execution User’s Guide.

When you return to the Logistics tab, click Update Logistics. The Status changes 
to Shipped.

This completes the manual ship processing for these special Move Out lines.

12. For all other cases, click the Process Trans check box for the Move Out line.

13. Click the Automate order processing steps through check box.

14. Select the Ship Confirm radio button.

15. Click Process.

When processing the Ship Confirm stage, you should wait until the concurrent 
program Interface Trip Stop has completed successfully before you click Update 
Logistics, to see the changed value of the Status.

You can monitor the progress of the program by selecting Requests from the 
View menu on the toolbar, and selecting appropriate search criteria.

16. Click Update Logistics. 

The purpose of this is to update the Status on the Move Out line, so that it 
reflects in Oracle Depot Repair the results of the procedures executed in other 
Oracle applications when you clicked Process.

After the background concurrent process Interface Trip Stop has completed 
successfully, the Status changes to Shipped.

17. Optionally, from the top menu, select Data > Activity to see the details of the 
Move Out transaction in the Activity window.

4.28 Record Billing Data in Repair Actuals
When you have completed the repair and have determined the final billing for 
materials, labor, and expenses that you want to bill your customer, you need to put 
the billing amounts in Repair Actuals. Sources of billing amounts in Repair Actuals 
can include the estimate, WIP Summary, Task Debrief, or manual entries.
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When you record the billing entries in Repair Actuals, the system creates charge 
lines in the Repair Actuals area. In turn, the system can transfer the billing data to 
other modules for invoicing.

Topics that guide you through adding data into your Repair Actuals tab include:

� Section 4.28.1, "Add WIP Summary to Repair Actuals" on page 4-113

� Section 4.28.2, "Add Task Debrief to Repair Actuals" on page 4-115

� Section 4.28.3, "Add Estimate to Repair Actuals" on page 4-116

� Section 4.28.4, "Create Manual Charges in Repair Actuals" on page 4-117

Note: For WIP mode jobs, although it is not prohibited to create 
actuals from both WIP and Estimate sources, generally you will 
copy in from either WIP or Estimate sources. 

Similarly, for Task mode jobs, although you can copy in lines from 
both Task and Estimate sources, generally you will copy in from 
either Task or Estimate sources. 

Note: The Debrief Report form does not let you apply contracts 
per charge line. If you are using Debrief Report form to generate 
charges, the system automatically applies the contract at the Service 
Request level to the charge line.
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4.28.1 Add WIP Summary to Repair Actuals
If your Repair Order is in WIP mode, you can add the WIP Summary as a source for 
your Repair Actuals.

When you add from the WIP Summary to your Repair Actuals, the system adds all 
material, labor, and expense lines from the WIP Summary into the Repair Actuals.

Generally, when adding in lines from WIP Repair Jobs:

� Material Transactions are added as Material lines.

� Resources Transactions are added as Labor lines.

After you add WIP Summary lines into the Repair Actuals, you can:

� View the WIP Job Name in the Source column of the Repair Actuals tab to see 
the source of the added lines.

� Update the WIP Summary-sourced lines in Repair Actuals but not delete them. 
The updates you can perform are limited: under profile option control, you can 
either set No Charge for a charge line or you can override the charge.

� View each line’s details to let you view more information about the line, 
indicate whether or not to override charges, or indicate to make no changes.

Note: Before you can add WIP Summary data into the Repair 
Actuals, you must define a billing inventory item for all the BOM 
Resources that are associated with a WIP Repair Job. This 
requirement lets Depot Repair add the WIP Summary lines into 
Repair Actuals as material, labor, and expense items. For more 
information, see the Oracle Depot Repair Implementation Guide.

Note: If you manually override the charge, then discounts 
associated with the contract are not applied.
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� Manually create additional charge lines. You can manually create charge lines 
before and after you add lines from the WIP Summary.

Upon importing the WIP Summary lines to the Repair Actuals, the system creates 
charge lines for each line.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must be processing a Repair Order.

Navigation
Repair Actuals tab

Steps
1. In the Source field, click the right-hand end of the field, then click the ellipsis 

(...) button.

A window opens and displays the possible sources from which you can add 
data to Repair Actuals. 

For a WIP mode repair, the options are WIP and Estimate.

For a Task mode repair, the options are Task and Estimate.

2. Select a Source and click OK.

3. Click Add.

Important! After you have imported at least one line from a WIP 
Repair Job into the Repair Actuals, you cannot import any 
additional lines from that job.

Additionally, lines will not be imported from WIP Repair Jobs 
shared across Repair Orders.
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The system automatically populates rows and fields on the Repair Actuals tab 
from the source that you selected. An information window appears which 
records any errors and information about the lines added

The Source field shows the Source Name. You should review each line on the 
Repair Actuals tab to:

– Determine if any lines require overrides.

– Determine if any lines should be at no charge.

4. (Not available for lines imported from Task Debrief.)

If the profile option CSD: Allow Charge Override for Actuals is set to Yes, you 
override an amount on a line, as follows:

a. Select Override Charge.

b. In the Charge column, enter a new amount.

5. (Not available for lines imported from Task Debrief.)

To change a line to No Charge, select the No Charge check box.

6. Click Save to record the changes.

4.28.1.1 View Line Details
On the Repair Actuals tab, you can view additional information about a charge 
line’s details. Additional details include costing and charge information. You can 
access a charge line’s details by selecting a charge line and clicking the Line Details 
button. An expanded window shows the detailed information. 

4.28.2 Add Task Debrief to Repair Actuals
If your Repair Order is in Task mode, you can import the Task Debrief as a source 
for your Repair Actuals.

When you import from the Task Debrief to your Repair Actuals, the system imports 
all material, labor, and expense lines from the Task Debrief into the Repair Actuals.

Note: The Debrief Report form does not let you apply contracts 
per charge line. If you are using the Debrief Report form to 
generate charges, the system automatically applies the contract at 
the Service Request level to the charge line.
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After you import Task Debrief lines into the Repair Actuals, you can:

� View the Task Number in the Source column of the Repair Actuals tab to see the 
source of the imported line.

� Add additional Task Debrief lines to the Repair Actuals.

� Manually create additional charge lines. You can manually create charge lines 
before and after you add lines from the Task Debrief.

Upon importing the Task Debrief lines to the Repair Actuals, the system creates 
charge lines for each line.

For general procedural information on how to add Task Debrief data to the Repair 
Actuals, see the Steps section in Section 4.28.1, "Add WIP Summary to Repair 
Actuals" on page 4-113.

4.28.3 Add Estimate to Repair Actuals
If your repair includes an estimate, you can use the Repair Estimate as a source for 
your Repair Actuals. 

When you import from the Repair Estimate to your Repair Actuals, the system 
imports all lines from the Repair Estimate into the Repair Actuals.

After you import Repair Estimate lines into the Repair Actuals, you can:

� Update, add, or delete the Repair Estimate-sourced lines in Repair Actuals.

� View each line’s details to let you view more information about the line, 
indicate whether or not to override charges, or indicate to make no changes.

� Manually create additional charge lines. You can manually create charge lines 
before and after you add lines from the Estimate.

Upon importing the Repair Estimate lines to the Repair Actuals, the system creates 
a charge line for each estimate line.

Important! You cannot update lines whose Source is Task.

Note: If you manually override the charge, then discounts 
associated with the contract are not applied.
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For procedural information on how to add Estimate data to the Repair Actuals, see 
the Steps in Section 4.28.1, "Add WIP Summary to Repair Actuals" on page 4-113.

4.28.4 Create Manual Charges in Repair Actuals
In addition to adding billing data from other sources--such as the WIP Summary, 
Task Debrief, or Estimate--you can:

� Manually create entries in Repair Actuals. 

� Update or delete the manual charge lines in Repair Actuals.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must be processing a Repair Order.

Navigation
Repair Actuals tab

Steps
1. To manually create a new charge line on the Repair Actuals line, select the new 

row on which you are adding a charge line.

The Source Type field automatically indicates Manual.

2. Enter or select the Billing Category, Item, Price List, Qty, UOM, Pricing 
Attributes fields, and optionally, the PO Num field.

Important! After you have imported any estimate lines into 
Repair Actuals, any changes made to those source estimate lines are 
not automatically forwarded to the corresponding Repair Actuals 
lines. To take advantage of the new estimate changes, you must 
delete the corresponding Repair Actuals lines, and then re-import 
the changed source estimate lines.
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3. Optionally, complete the Contract Number field.

4. If the profile option CSD: Allow Charge Override for Actuals is set to Yes, you 
override an amount on one line, as follows:

a. Select Override Charge.

b. In the Charge column, enter a new amount.

5. To change a line to No Charge, select the No Charge check box.

6. Click Save to record the changes.

4.29 Book Repair Actuals
After you have recorded your billing data in Repair Actuals, from one or more 
sources, and possibly entered charge lines manually in Repair Actuals, you can 
book selected charge lines. 

The following procedures describe how to book selected Repair Actuals charge 
lines.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must be processing a Repair Order.

You must have charge lines in Repair Actuals, either manually entered or added in 
from a Source of Estimate, WIP, or Task.

Navigation
Repair Actuals tab

Note: If you manually override the charge, then discounts 
associated with the contract are not applied.
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Steps
1. Select either individual charge lines or click Select All if you want to book all 

the charge lines in the Repair Actuals tab.

2. Click Book Selected.

Comments
For lines whose Source is Task, the items used in the Debrief Report decrement 
inventory only after the Field Service concurrent program CSF: Update Debrief 
Lines is submitted. This concurrent program updates the Quantity On Hand (QOH) 
in the inventory.

4.30 Invoice a Customer

The following procedures describe how to invoice a customer.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to invoicing the 
customer. For more information, see Chapter 3, "Oracle Depot Repair Business 
Scenarios".

Navigation
Accounts Receivable

Note: Tax, Shipping, and Freight charges are not calculated within 
Oracle Depot Repair, but are calculated in Order Management 
when orders transfer to Order Management. For this reason, the 
charge totals in the estimate lines and lines from Task Debrief may 
be different from the value charged on the invoice.
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Steps
1. Invoice the customer by using normal business procedures. 

For more information, see the Oracle Receivables User Guide.

After the invoice cycle is completed, you can view the Invoice Number and 
Invoice Date for a particular charge line on the Others tab of the Charges 
window. The Charges window is accessible from the Details tab of the Depot 
Repair Workbench. 

4.31 Close a Repair Order
The following tasks describe how to close a Repair Order.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to closing the 
Repair Order. For more information, see Chapter 3, "Oracle Depot Repair Business 
Scenarios".

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Repair Order for the item that you want to ship.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.

2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. Confirm that the quantity on the Repair Order is complete.
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4. Consult or create notes if necessary. 

For detailed instructions, see Section 4.11, "Create and Maintain Notes" on 
page 4-31.

5. In the Details tab of the Depot Repair Workbench, click Update Status. 

The Update Status window opens. In the Update Status window, you can 
update the Repair Order status. The Repair Order can remain Open, be on 
Hold, or Closed.

6. Select Close by selecting the option button, and click OK to close the Repair 
Order line.

You can select a Reason Code from the list of values, and enter additional 
details supporting the status update.

7. Click the Save icon on the toolbar to save the record.

4.32 Close a Service Request
The following procedures describe how to close a Service Request.

Module
Oracle Applications Navigator

Responsibility
Depot Repair Super User

Prerequisites
You must complete all steps in the relevant business scenario prior to closing the 
Service Request. For more information, see Chapter 3, "Oracle Depot Repair 
Business Scenarios".

Navigation
Depot Repair > Repair Orders

Steps
1. Retrieve the Service Request that you want to close.

For more information, see Section 4.10, "Find Service Requests and Repair 
Orders" on page 4-29.
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2. Select the relevant result from the Results area of the Find Repair Orders 
window, and click OK. 

The Depot Repair Workbench shows the selected Service Request and Repair 
Order details.

3. In the Service Request Information area of the Depot Repair Workbench, change 
the status of the Service Request to Closed by selecting from the list of values. 

4. Enter the date closed.

5. If required, create notes stating the reason for the Service Request closure.

For detailed instructions, see Section 4.11, "Create and Maintain Notes" on 
page 4-31.

6. Click the Save icon to close the Service Request.

4.33 Create and Process an Internal Party Refurbishment
In Oracle Depot Repair, you can create and process items that need to be 
refurbished that belong to an internal party. In these cases, the items to be 
refurbished do not move from an external location, such as a Spares Management 
warehouse, they remain in the internal party location.

Create the Service Request
You must first create a Service Request, and explicitly choose an internal party for 
your customer.

An internal party is defined as a customer set up in at least one of the following 
ways:

� The customer is the Party Name set up in the Install Base Install Parameters.

� The customer is set up in Oracle Order Management with a classification type 
of Internal.

For more information on setting up internal parties, see the Oracle Depot Repair 
Implementation Guide.

Note: Spares Management is a module of Oracle Field Service.
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Create the Repair Order
When you create the Repair Order, you must select a Repair Type that has been set 
up with a Repair Type Ref of Refurbishment, and whose Internal Order check box 
has not been set.

For more information on setting up Repair Types, see the Oracle Depot Repair 
Implementation Guide.

Process the Repair Order
After the Repair Order has been created, the Logistics, Estimates, and Repair 
Actuals tabs are disabled, as is the tools option menu Tools > Coverage.

The main operations that you perform on internal party refurbishment items are 
repairs to be carried out through WIP Repair Jobs or Tasks.

The only special considerations that apply to the internal party items to be 
refurbished are as follows:

� For serialized items, that are Install Base trackable, the lists of values for Serial 
Num and Instance show all item instances owned by the internal party, and 
whose Oracle Install Base usage is In-Inventory.

� For serialized items, that are not Install Base trackable, the lists of values for 
Serial Num and Instance show all item instances whose Oracle Install Base 
usage is In-Inventory.

4.34 View Repair Orders in Oracle iSupport
Oracle Depot Repair customers can now search for their Repair Orders through a 
self-service user interface in Oracle iSupport.

Oracle iSupport authenticates the user and displays only the Repair Orders for 
accounts which the user is authorized to view. For each Repair Order, summary and 
detail information, including Repair Order status, can be displayed.

The procedure to view Repair Orders in Oracle iSupport is as follows:

1. Login to Oracle iSupport.

2. Click the Accounts tab.

3. Select the Repair Orders menu item.

The Repair Order Summary page appears.

4. Click the Repair Order Number hyperlink for a Repair Order.
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The Repair Order Details page appears.

You can also use the Saved Searches function in Oracle iSupport to assist 
subsequent searches.

For more information, see the Oracle iSupport User Guide.
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